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Preface 

This book is about every-day business. This book is 
also about an important tool for every-day business, the 
Macintosh computer. The authors, who are in business 
themselves, provide illustrations of daily business 
activities which you can perform with the help of the 
Mac. Hopefully, you'll not only learn useful tips for 
using your Mac more efficiently, but you'll also learn 
some useful tips for how to run your business more 
efficiently, too. 

Th e Macintosh is at the forefront of the evolution of 
computers as tools which anyone can u se, as simple as 
any other "tool" in the office or workshop. The 
Macintosh's relatively low price (as revolutionary as the 
$999 Ford automobile in 1913) and quick learning time 
make the computer more accessible than ever before. 
Capabilities which were once available only to the staff 
of large, well-equipped corporations are now within the 
grasp of small business owners and private individuals 
who are in the "business" of living in today's urban, 
industrial environment. 

For instance, each of us maintains our own lists of 
things to do and schedule of apppointments. The 
Macintosh (and appropriate software) makes the 
accomplishment of these tasks quick and easy. Managers 
responsible for scheduling people and projects, chief 
financial officers who prepare financial reports for the 
monthly board meetings, and public relation 
departments which produce annual reports and other 
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MAC AT WORK Preface 

announcements will all find the Macintosh immediately 
helpful in accomplishing business goals in record time. 
And, if you are a small business owner wearing all 
these hats on any given day, the Mac will become your 
number one support staff. 

Because the more mundane side of daily business 
tasks are accomplished by the Mac, you will find you 
have more time to be creative with your business. Many 
of the software applications - project planning, 
spreadsheeting with its "what-if" calculations, and 
drawing and diagramming programs, for example - can 
be used as real thinking tools that can help you help 
your business grow. 

This book is especially aimed at the newcomer to 
the Macintosh. It could not have been written even one 
year earlier- before the revolution introduced by 
Apple's 32-bit family of computers. Until now, 
computers performed what seemed to be a limited 
number of functions, each with a different difficult set 
of instructions to learn. The new technology of the 
Macintosh not only brings presentation-quality graphics 
capabilities into the office at a very low cost, it makes 
learning how to use a computer as simple as opening a 
file folder. Now anyone can use a computer. Because we 
don't have to spend so much time showing you how to 
use your Mac, we've been able to give you some 
direction for what you can do with the it. 

Not only does this new tool make the process of 
using a computer a lot simpler for everyone, it 
introduces for the first time the ability to assemble a 
complete business document into a single, coherent file. 
In other words, now you can copy a financial table and 
a bar ch art directly into the text of your report, instead 
of printing each element of your report out piece by_ 
piece. Also for the first time, using a Macintosh and a 
LaserWriter printer, you can produce two- or three
column pages of text and graphics that are of almost 
typeset quality. 

x 
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This is not a book about "computers." If you are 
looking for information about the bits, bytes, and 
computer jargon side of life, you will probably find 
other books more informative. If you are looking for the 
lastest, "hottest" news on the Macintosh and its 
software products, you should look to current issues of 
magazines, such as MacWorld. On the other hand, if you 
are wondering how a Macintosh computer can help 
around the office, you will benefit by the practical 
examples, quotes and anecdotes you'll find here. 

The first part of this book shows simple, practical 
examples of creating the most common ''building 
blocks" of daily business: memos, letters, reports, 
project plans, forms, lists of clients and products, and 
charts and graphs showing the financial condition of the 
company. The tools used in these examples include 
software packages available from Apple for the 
Macintosh as well as packages from another leading 
manufacturer of Mac business software, Microsoft. Even 
if you don't have the particular software packages used 
in the examples, you can still benefit from reading these 
sections; they are written in general terms which are 
intended to illustrate techniques and short-cuts for 
accomplishing the end goal, namely, the production of 
the document being discussed. The last chapter in the 
first section shows how to hook your Macintosh up to 
the phone lines and communicate with another 
computer, or get access to information services such as 
CompuServe and Dow ]ones News Retrieval. 

The second part of the book presents examples 
which combine text and graphics into a single file to 
create a complete document: a set of presentation 
materials, a report, a business proposal. These chapters 
include practical tips and anecdotes about how to 
address your audience in these reports, as well as how 
to assemble them using a Macintosh. 

We hope that this book will help you make a 
Macintosh as essential to your business as it is to ours! 

January 1985 
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Invoice 

Introduction 

In any business-related endeavor, the tangible 
"evidence" of work is a piece of paper- an invoice, a 
sales report, a plan, an agenda, a list of clients, a 
contract, a script, a memo announcing the company 
picnic. Some of the earliest examples of the written 
word are inventory lists or bills of lading recording the 
exchange of animals and grains. Today our daily drill is 
no more or less important than the work done 
thousands of years ago with cuttlefish ink on 
papyrus - only the tools have ch anged. 

The first typewrite1~ invented in 1868 by Carlos 
Glidden and Christopher Latham Sholes was the 
beginning of a "revolution" in office procedures. It made 
the daily paper products of any business clearly 
readable and much faster to produce than by hand
written lettering. Nevertheless, at the time there were 
those who asked silly questions like "What is it good 
for?", while others were afraid they would never be able 
to learn how to use it. 

Less than ten years ago the first personal 
computers invited similar responses. As recently as one 
year ago we got an excellent deal on a "second hand" 
computer which we bought from a business owner who 
had never taken it out of its box. He said he didn't have 
time to read all the manuals about it, and the help he 
needed from a consultant would have cost more than 
the machine itself! If you fear finding yourself in the 
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same dilemma as this entrepreneur then you ought to 
know that microcomputers like the Macintosh are in the 
forefront of the drive to make computers as simple to 
use as any other "tool" in the office: a typewriter, a 
calculator, or a copy machine. 

As with most revolutionary inventions, the product 
- a personal computer - was invented decades before 
the demand for it was felt among the populace. Even 
now you might be wondering exactly what a computer 
can do for you . Perhaps the best way to approach this 
question is to ask: What tasks are you now doing by 
hand that involve writing, totalling or sorting? 

Do you keep a list of names and addresses of 
friends, customers and business associates? Do you 
ever send out a series of letters to these people? Do 
you track your monthly income and expenses? Do you 
project these figures into the future? Do you plan 
projects - if you have a certain number of steps to . 
perform, in a certain sequence, do you know when you 
will be finished? Do you wish you had a reference 
library at your fingertips where you could look up the 
history of printing, the latest headlines, or the next 
flight to Tucson? 

Daily Business Applications 
This book presents practical examples of business 

documents which can be produced using an Apple 
Macintosh computer. With this tool, you are now able to 
produce all the essential documents for any business, 
including some which previously required the outside 
services of a typesetter and a graphic artist. 

For instance, here is a typical scenario of what 
happens during the day in the offices of TAG 
Corporation, the fictional marketing company which 
appears in many examples in this book. 

J.B. Morless, the president, needs to make a 
presentation to the board tomorrow. He begins by 
examining printouts of TAG's latest financial statements, 
including: 
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== Letters 

Projections 

How to Use This Book 

Introduction 

• Year-to-date income & expenses 
• Balance sheet as of latest quarter 
• Current project plans 
Based on this information, he needs to prepare: 
• Next year's budget projections 
• Charts & graphs for the presentation 
One of the outcomes of this particular board 

meeting will be the preparation of materials to support 
an application to the bank for a commercial loan, 
including: 

• Business Proposal 
• Resumes 
Meanw hile, the head of operations is busy 

reviewing TAG's current procedures, including: 
• Production and inventory controls 
• Business forms 
• Flow-of-work analysis 
Of course, all this important work is supported by 

the tireless efforts of the adminstrative assistant, who 
deals w ith the endless flow of: 

• Correspondence 
• Invoices 
• Mailing Lists 
• Newsletters 
All of these key employees work w ith a Macintosh 

at their side. 

Each chapter in this book begins w ith a description 
of the d ocuments produced in that chapter, and a list of 
the software tools used. You need not read the w hole 
book &om beginning to end in order to get the 
information needed for you r particular interests. 

The instructions given in this book generally begin 
w ith "Open a New File". Most of the time we w ill 
assume that you h ave already used the tools enough to 
know how to make basic entries and correct your own 
errors. (An overview of basic Macintosh operations is 
given later in this Introduction .) 
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We will generally be discussing the contents of your 
business files, rather than the process of installing new 
software or editing files to correct errors and such. It's a 
good idea to look over the manufacturer's manuals on 
these products before trying the exercises shown here. 

If you are teaching yourself how to use these 
products, it may take a little longer to learn the basics 
than it would if you had an experienced friend looking 
over your sh oulder as you go along. One formula is to 
expect to learn a product fully in as many hours as you 
expect to use it each week. We hope this book will 
serve as a "friend" in giving you time-saving tips which 
you might not discover as quickly on your own. 

After reading this introduction, you can jump right 
into whichever chapter addresses your immediate needs. 
What kind of document or file are you trying to 
produce today? 

Equipment Requirements 

This book will be useful to you whether you ow n a 
Macintosh with 128K of random access memory (RAM) 
and one 31/2-inch disk drive, a FatMac with 512K RAM 
and two 31/.i-inch disk drives, or a Macintosh XL with a 
hard disk. In any case, you will be able to use all the 
basic tools described in this book. Generally, the larger 
the memory (RAM) in your machine, the faster most 
most programs will run. The larger your disk storage 
capabilities, the larger your documents or files can be. 
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Software Packages 

Chart 

MacProject 

Introduction 

If your business is very large, you have probably 
invested in a LaserWriter or letter quality printer. The 
major difference between printers is the appearance of 
the letters on the printed page. 

A A A 
lmageWriter LaserWriter typesetter 

With these output possibilities, high-quality 
documents which once required professional production 
assistance can be produced by anyone with a 
Macintosh! 

It would be impossible and impractical to try to 
demonstrate every single product available for the 
Macintosh in this book. The appendix includes a list of 
business application software available for the Macintosh 
as of January 1985. We have selected some of the most 
popular products to illustrate the examples in this book. 

The first part of the book describes how to use 
each of the major types of tools required for full 
business operation, including: 

• Charting - Microsoft's Chart lets you create pie 
charts, bar charts, line graphs and area graphs from 
tables of entered numbers. In addition, MacDraw and 
MacPaint are available for creating flowcharts and 
organization charts, or for enhancing the charts created 
by other programs. 

• Project Planning - MacProject is one of the most 
powerful tools on the market for creating complete 
project schedules, including PERT charts, Gantt charts, 
cost projections and project summaries. 
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MacPaint MacDraw 

Multiplan 

~ 
MacWrite Word 

File 

Mac Terminal 

Introduction 

• Drawing- In addition to creating your own 
works of art, you can use MacPaint and MacDraw to 
create business graphics or to enhance files created by 
other programs. In particular, you'll see how useful 
these programs are for creating business forms such as 
purchase orders and invoices. 

• Calculating - With Microsoft's Multiplan you can 
create "spreadsheets" with columns and rows of text 
and numerical entries which will automatically calculate 
new values whenever you change any number. 

• Word Processing - With a word processing 
package you can type, edit and format text easily. In 
this book we'll see how MacWrite and Microsoft's Word 
can help you produce any business document. 

• Filing- Microsoft's File is a simple database 
program which you can use to create lists of clients,, 
lists of products or any other "file" of information. 

• Communicating - With MacTerminal and a 
modern, you have access to many information networks 
such as CompuServe and Dow Jones News/Retieval. You can 
also dial up other computers and share information. You 
can even send your text directly to your typesetter for 
production. The second part of the book describes how 
to assemble whole documents which are composed of 
parts created by different tools. For example, a business 
plan may be composed of text, tables and charts. With 
the Apple Macintosh, you can combine all these 
elements into one document easily. 

Basic Macintosh Operations 

Whether or not you have used any other computer, 
the Macintosh introduces a new technology which adds 
a mouse as a means for operating the machine, in 
addition to the normal keyboard. The mouse is a palrn
sized object which, when moved around on your desk, 
causes a pointer to move around on the screen. 
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--
The mouse is used to move a pointer around on the screen 

Once you are pointing at an object on the 
screen - a. word, a menu, a square, etc. - one or two 
clicks on the mouse will tell the computer what to do 
next. For example, to open a new fil e, you simply point 
at the tool you wish to use and click the mouse twice. 

Double-click the mouse while pointing at a tool icon to open a 
new file 

Use the mouse to point at a word along the top 
line of the screen, then hold down the mouse bu tton . A 
pop-down menu will appear, showing you the options 
available. Sometimes menu options are shown in grey, 
which means that those particular options are not 
available with the current screen selections. 
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Clear 
Duplicate 
Selec t All 

Introduction 

Hold down the mouse while pointing at a word along the top 
line or the screen to see a pop-down menu 

To select an option on the menu, hold down the 
mouse button as you drag the mou se pointer down the 
menu. When you are positioned over the option you 
wish to select, simply release the mouse button. 

In some programs, like MacPaint, MacDraw and 
MacProject, you can select objects on the screen by 
positioning the mou se pointer over them, then holding 
down the mouse button while you drag the mouse to a 
n ew position on the screen, then release the mouse 
button . Small balck squares will appear around the 
object and you can use them to move or re-size the 
object. 

Use the mouse to point at an object on the screen, then hold 
down the mouse button as you drag the object to a new location 

10 
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Cle or 
Duplico te 
Select Rll 

The Oral Tradition 

Introduction 

Every program used in this book has a pop-down 
Edit menu which lets you Cut, Copy and Paste from 
one part of the file to another. For example, to delete 
this paragraph from here and move it to follow the next 
paragraph, you would drag the mouse down the lines 
of this paragraph, then use the Edit menu's Cut option. 

-The paragraph disappears from the screen, and is 
saved in the Clipboard. Next, you would click the 
mouse at the location in the text to which you wish to 
move the paragraph, and use the Edit menu to Paste 
the paragraph from the clipboard. The paragraph will 
appear in the new location. The same paragraph will 
still remain on the clipboard, until it is replaced by new 
text which you Cut or Copy through the Edit menu. 

The instructions in this book will assu me that you 
are familiar with these basic features of the Macintosh. 

One feature which distinguishes the Macintosh 
technology from all others which have preceded it is 
the ability to cut and paste from one type of program 
to another. For example, you can create a logo using 
MacPaint or MacDraw, then paste the logo into any 
text file. 

Most of us think of computers as machines which 
replace people. It is true that compu ters can perform 
certain functions which were previously done manually, 
and therefore they reduce the number of person-hours 
required for many tasks. On the other hand, it is also 
true that computers bring people together in a certain 
way. 

From the beginning, information about computers 
and how to operate them has been passed along orally. 
In the past, when computers were difficult to learn, 
only one or two people in a large office would have the 
time and interest to actually read the manual which 
explained how the computer works. Everyone else in 
the office would go to these in-house experts when they 
had a question or a problem, and most problems could 
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be solved in a · few minutes this way. An oral tradition 
began developing among computer users. 

With a Macintosh , many programs are so easy to 
learn that you don't need to read every page of the 
manual, but there is still one question which every 
Macintosh owner needs to ask regularly, namely: 
"What's new?" This is the kind of question most of us 
are not accustomed to asking. After all, what major 
improvement is likely to make us buy a new 
screwdriver, or replace our portable television? 
Computers are quite different from these other tools in 
two important ways: new things are coming out for 
them every day, and you don't have to replace your 
wh ole machine in order to enjoy the latest 
improvements. You ought to ask this question every 
time you go into your local computer store, and have it 
in mind whenever you are skimming through a 
computer magazine. Here are some variations on this 
question: 

"What new time-saving tricks have you learned 
about the Macintosh and its programs?" You can learn a 
lot from others who use Macintoshes, and they may be 
able to learn something from you . It's easy to miss 
things in the manual, especially if the program is so 
easy that you don't read the manual completely. 
Furthermore, you may discover some tricks which are 
not even mentioned in the manual. This is the kind of 
information which is often exchanged at Macintosh 
Users' Group meetings. There may be a Macintosh 
Users' Group in your area. You'll find that a few hours 
each month at these meetings can greatly increase your 
productivity. 

"Is there a newer version of any of my current 
programs?" Many manufacturers let you get updates on 
their software for free once you've purchased one copy. 
It's usually worth getting the newer versions, which 
should be able to handle all the files you created with 
the older versions and offer you new or improved 
functions. Unfortunately, you probably won't get a 
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personal letter in the mail letting you know when a new 
version comes out, so you have to keep asking this 
question. 

''What new programs are out now for applications 
which were not available before?" Maybe there's a task 
you still perform manually because when you bought 
your Mac no programs existed that could do that 
particular job. Keep asking! You'll be surprised at the 
new software which is announced every day. 

Besides your own office mates, your local computer 
dealer, magazines, and people you meet at Macintosh 
Users' Group meetings, there's another good source of 
information about your computer and what people are 
doing with it: local and national information networks 
which you can dial up using your phone lines and your 
Macintosh with MacTerminal and a modem. 

Finally, we hope that you will find this book a 
good source of helpful information. Remember, you 
need not read each chapter, only those which interest 
you. Happy computing! 

13 
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Chapter 
1 Charts 

Whether your purpose is to clarify, simplify, 
stimulate, captivate, emphasize, summarize, persuade, 
or simply explain, there is no doubt that graphics add 
clarity. As an "information society'~ we are handling 
more information than ever before, and the need for 
clear communication is stronger than ever. With all the 
incredible special effects that have become standard fare 
on television, most audiences find the average business 
presentation mundane and boring. 

There's no question that information presented 
visually is more easily understood and remembered 
than information presented verbally or in tables. 
Perhaps you have directly experienced the finding that 
meetings which include graphics are 28% shorter than 
meetings held without graphics. From the pages of Time 
magazine to your local 6 O'Clock News, complex 
relationships are easily conveyed with the use of 
graphics. 

If you have ever tried to read a financial report 
which showed three columns and twenty rows of 
numbers - three years' income and expense figures, for 
example - you will appreciate some of the tips in this 
chapter about making the important points more visual 
through charts. The quality of business operations, 
whether large or small, can be substantially improved 
with graphics. Not only do graphics enhance your 
communication with others, but graphics can make the 
information you handle in your business clearer to you. 
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Charts 

Unlike columns and rows of information, charts give 
immediate visual impressions - you can easily see 
sudden changes in a series of numbers or seasonal 
variations over time. 

On the other hand, if you have ever tried to draw 
a pie chart with seven categories - using a pen, a 
protractor, and a calculator to convert numbers to 
percentages and percentages to degrees - then you 
know why so few "in-house" financial reports have 
included graphic illustrations. Until now, charts and 
graphs have required a lot of time and patience to 
produce, even if you had all the tools of a professional 
graphic artist. 

Perhaps your company is one of the few whose 
business relies on presentation graphics enough to 
purchase them from a professional graphic artist. Or 
maybe you use graphics enough that you have saved 
graphics expenses by hiring a full-time artist and 
supplying all the tools they need: a drafting table, a set 
of Rapidograph™ pens, rulers, protractors, compasses, 
templates, plenty of glue and correcting fluid ... Given 
enough advance notice, your in-house artist has 
probably managed to meet most of your demands - w ith 
a two-week delivery cycle! 

Meanwhile, executives are finding that they are not 
enjoying the full benefits of computerization because of 
the form in which most data is delivered: pages of 
columns and rows of figures printed on wide paper 
without arrows or bold printing to highlight the bottom 
line. As long as computer graphics systems were priced 
from $50,000 to over $300,000, few could justify the 
investment - even though computer graphics can cut 
the cost of producing slides and charts by as much as 
80%. (One company we talked to claimed that they 
were producing graphics on the Macintosh for less than 
ten dollars which would have cost over fifty dollars 
from an outside graphic artist!) 

Now, with the Macintosh and a charting program 
like Microsoft's Chart, you don't have to be an artist or 
spend a fortune to create clear, accurate charts and 
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The Right Chart 

1985 Toy Sales 
Largest Calogori93 Million$ 

Board G.mes 212 
Sports 253 

Robotics 587 
Computer Games 630 

other 1639 

Charts 

graphs in a fraction of the time it would take to create 
the same chart using traditional graphics techniques. 
This chapter will show you how to create pie charts, bar 
charts, line graphs, and area graphs, as well as give you 
some tips on deciding which chart will best illustrate 
your point. 

So you're not a graphic artist and you've never 
drawn a chart before. You know what the facts are, and 
you want to use graphics to help illustrate your 
particular points of emphasis. Graphics improve 
communication in every department. What kind of chart 
will you use in this afternoon's presentation? The type 
of chart you choose depends both on the type of 
information and on the point you wish to make. 

For example, to illustrate last year's sales by product 
category, you would enter the figures for each category 
in a two-column table. 

Using a charting program like Microsoft's Chart, 
you can view the results graphically and instantly as a 
pie chart, a bar chart, or a line graph with a few clicks 
of the mouse button. With a charting program, it's 
much more fun to be fickle than it was with the old 
ruler-and-pencil techniques. No matter how mundane 
the information you're passing on may seem, you'll be 
surprised to see how effective your presentation can be 
with graphics. 

There's a chart type for almost every kind of 
information. The following examples will talk about 
charting using Microsoft's Chart. Even if you don't own 
that particular program, you can read through the next 
sections and still learn some important points about 
charting in general. We've found it takes practice for 
many of us to be able to see numbers and their 
statistical, logical, and meaningful relationship to each 
other in graphic terms. Once this graphic sense is 
developed, however, a new "tool for thinking" is in 
your hands. 
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In the Chart program, the Gallery menu allows you 
to see what variety of charts are available to you. If you 
have Chart running on your Macintosh now, take a 
moment and look through the Gallery menu to see 
what's there (or take a look the menu shown here). 

The following bar chart, for example, draws 
attention to the fact that the largest sales category is 
"other"; while this may not be an interesting item of 
information unless we know of what the "other" 
category consists, there is plenty of useful information 
revealed in the chart. We are drawn to review the 
numbers along the X axis (the horizontal axis). Now we 
can see that the category "computer games" earned over 
$800 million last year. So, we can see the total sales 
amounts of each category, as well as which categories 
are larger than others and by how much. 

Largest 
Categories 

1985 Toy Sales 

C=~u::: ;::&?&F;;.;,'''li;'·t 
SP<ll"l> 

Soard Game' 
.i:=:::+-~--<~-+--+-~--<~-+--

0 m a~ ~ 1~ 1m ~o~o 1~ 

Million$ 

Bar Chart shows each category's level of sa les in dollars 

On the other hand, a pie chart of the same data 
focuses our attention on a category which we barely 
noticed in the bar chart: the robotics category is 
exploded away from the rest of the pieces. The caption 
tells us why: robotics are expected to be the fastest
growing category in 1986. Suddenly its 17% share seems 
much more significant than it did in the bar chart, 
where it was lost as a "middle range" category. 
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1985 Toy Sales 

47~ 

Robotic toys are e1pected to be the fastest growing 
category in 1986 led by the QP Doll series of 

programmable robots. 

Exploded Pie Chart highlights one category 

• Board Games 

~ Sport.s 

[) c~urG.JMs 

0 Otller 

Charts 

As you can see, both charts "illustrate" the facts in 
this case. There is, however, a distinct difference 
between the two in how our attention is focused. You 
can see now why it's important to know what point you 
wish to make. 

Pie Charts 

Pie charts are the best selection for graphs that 
show percentages of the "whole pie". Usually a 
maximum of six or seven slices allows the labels and 
shading to be clearly visible. If your pie has any slices 
which are too thin for the shading to be clear, a 
horizontal bar chart is a good alternative. 

You can label the pie slices with percentage figures 
or dollar amounts, or show the labels in a legend at the 
side of the pie. You. can give one category emphasis by 
"exploding" it out from the rest of the pie. With Chart, 
these are simple selections under the Pie option of the 
Gallery menu. 
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4 

fj 
5 6 

c 

OK Cancel 

Menu of Pie Chart Options 

By nature, pie charts capture values at a fixed point 
in time - to compare percentage distribution changes 
over time, a different pie chart must be drawn for each 
time period. Each type of chart has it's own "gallery" of 
variations within each type. One of the really handy 
things abou t Chart is that you can create your own 
individual chart design. To copy a design from one 
ch art to another, check Format Only in the dialog box 
under the Open command on the File menu. Chart 
will load only the format into the Macintosh's memory, 
and the current data is unaffected. Thus, Chart offers 
you a virtually unlimited selection of chart formats to 
choose from. 

Horizontal Bar Charts 

Horizontal bar charts are especially useful for 
comparing values of different categories during one time 
period. The same information could be displayed 
vertically, but by convention we tend to associate vertical 
bars with comparisons over several time periods. 
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Bar Chart Gallery 

5 5 7 

=·~ 
OK Cancel 

Menu of Horizontal Bar Chart Options 

Horizontal bar ch arts are especially useful when 
the names for each category (i.e., the entries down the 
first column of the data table) are more than one word 
long. 

Vertica l Column Charts 

Vertical column charts are similar to horizontal bar 
charts in their format and purpose. One difference is 

I 

Million$ 

1985 Toy Sales 

1600 
1600 
1400 
1200 
1000 
600 
600 
400 
200 

• 1965 Toy Seles 

t'.il 1966 Projections 

0...-~:.£.CJ.--

Doard Games Sport,, Robotics 

Largest Categories 

Vertical Columns compare different time periods 
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that it is easier to see comparisons over several time 
periods with vertical columns. In general, vertical 
column charts are used more often than horizontal bar 
charts. In fact, the term bar chart brings a picture of 
vertical columns to most people's minds. 

Because columns or bars must be wide enough to 
show shading, the number of time periods you can 
show on one chart is limited. Information about many 
time periods becomes a candidate for a line graph. 

Line Graphs 

Line graphs, like vertical column charts, show 
values over time. However, line graphs are best for 
showing trends over time rather than for comparing a 
few values over a limited time period. With a line graph 
the number of time periods shown can be nearly 
limitless, making line graphs superior to bar charts for 
showing long-term trends with seasonal variations. 

Tag Corp. Sales History 
(Million$) 

~~:! -- --- . ----~ - --- ------------· 
~= - - ~:~~ -·- ·--·--·- ·- -· :~ 1 . . - -- ---

1976 1977 1978 1979 1980 1981 1982 1983 198• 1985 

Line Graphs can show many time periods 

Also, with line graphs the number of categories 
shown is limited only by the number of different ways 
in which you can draw a line. Because of this last 

24 



MAC AT WORK Charts 

consideration, line graphs can benefit more than the 
other graph types by color printing (an option not yet 
available through the Macintosh). 

Area Graphs 

Area graphs are often used in place of line graphs 
to represent volumes . For example, while a line graph 
shows the changing average price of a stock during an 
active period, an area graph might show the changing 
volume of shares traded w_eekly. 

Area Chart Gallery 

4 

• 
OK Cancel 

Menu of Area Graph Options 

An area graph, or surface ch art, emphasizes the 
size of, rather than the changes in, total amounts. It is 
most appropriate for illustrating data which changes 
gradually over time, rather than illustrating data with 
sharp rises and falls. 

Let's see what an area chart can do to illustrate this 
paragraph, excerpted from TAG Corporation's third 
quarter financial report for 1985: 

D1G Corporation's after-tax operating income was between 
$235 and $300 million in the first two quarters of 1984 prior 
to the acquisition of Moore & Moore. Since then quarterly 
income from 'L4.G's traditional business has declined steadily 
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$ Millions 

200 

100 

0 

Charts 

to a level just over $100 million in the third quarter of 1985. 
With quarterly income ranging between $140 and $240 
million, Moore & Moore has more than doubled TAG 's after
tax operating income during the first three quarters of 1985. 

Acquisition Helps Stability 

1st Qtr 2nd Qtr 3rd Qtr 4th Qtr 1st Qtr 2nd Qtr 3rd Qtr 

Scatter Diagrams 
Finally, scatter diagrams are available on the 

Gallery menu of Microsoft Chart, but they are more 
often used in statistical analysis than in daily business. 

Scatter Chart Gallery 

3 

• 5 

• OK 

4 

•• 
~'---o•

o,p o • • 

Cancel 

Scatter Diagram plots individual points between two scales 
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They can be used to plot an individual's test scores, for 
example, along two scales such as technical skill level 
and management skill level. 

Combination Graphs 

When a single chart is not enough, select a 
Combination graph from the Gallery menu. The 
Combination graph gallery offers four ways of combining 
two sets of data on one set of axes: a column chart 
overlaid with a line chart using the same scale (on the 
Y axis), a column chart overlaid with a line chart using 
a different scale, two line charts with two different 
scales, or an area chart overlaid with a column chart. 
You can combine other types of charts by adding an 
overlay chart to your main chart. Simply choose 
Overlay Chart Type from the Chart menu. Combination 
charts help dramatize your presentation by contrasting 
information. 

TAG Corp. Acquires 
Moore It Moore 

•Shares 
Thousands 
40 

Price per Share 

30 

25 

20 

15 

10 

5 

1 3 5 7 9 II 13 15 17 19 21 23 25 27 29 31 33 

Week 

16 

14 

12 

10 

6 tZl Number or Shares rr .. ded 

4 ·•- Price per Share 

Combination Chart shows relationship between two different data 
series 
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Creating a Chart 

Charts 

In general, the best graphs are those with the 
fewest elements. Whenever possible, consolidate months 
into quarters, quarters into years, years into decades. 
Consolidate minor categories into "Other". Use multiple 
charts if necessary, rather than try to show everything at 
once. Remember that graphics should bring clarity, not 
confusion. lf the graphic doesn't make the point more 
obvious, e ither you're using the wrong chart fo rmat or 
the point shouldn't be made! 

The next few paragraphs will outline the basic 
steps in creating a chart using the Chart program. 
Options on formatting charts are explained later in this 
chapter and in chapter 9. 

After you open a new file, the first step is to enter 
the data you wish to graph. Each group of data is called 
a data series . For example, the income for our catagories 
for 1985 is one series, the income for each category in 
1986 is a second series, and so on . Both series can be 
plotted to show a comparison of each category from 
year to year. Choose the type of data you'll be working 

D 1985 Toy Sales 
Order: 11 I 
~ Plot Series 

largest Categories 

Boord Gomes : 
Sports : 

Robotics ~ 
Computer Garnes ! 

other l 

I 

Million$ 1 rnHf 

Table of last year 's sa les by category entered in Chart 
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with from the Data menu. If you choose Sequence or 
Dates, Chart will automatically enter the numbers or 
dates down the first column of the data table in the 
increments you indicate. If you choose Text or Numbers 
as the data type, you can enter the categories in the 
first column yourself. After selecting the data type, 
you can enter the labels of the categories and their 
related values. 

Sequence Date Text Number 

1 Jan 1986 Garnes 17 

2 Feb 1986 Sports 23 

3 Mar 1986 Robotics 31 

When you enter all your information, be sure to 
check Plot Series in the data box - you'll see the data 
graphed automatically. Choose the type of graph you 
wish to use from the Gallery menu. Now your chart is 
ready to be fine tuned, saved to disk, or printed out. 
More charting tips are given later in this chapter and 
through out the book. 

Label formats 

• • 
• 

• 
Net Sole~ 

• 

The axis labels which appear on the ch art are taken 
• from your entries in the Data menu dialog box. You can 
• change the text of these labels, as well as the type 
• styles, through the Format menu . 

In order to accomplish this, you must first select 
the text label on the chart itself - simply by pointing 
and clicking the mouse over the label to be formatted. 

Then select the Format menu's Text option . The 
dialog box lets you define the format of the label. 
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Chart Sizes 

Charts 

Te Ht 

font font Size Automatic Show 
® Geneua D I ta lic @Small [8l TeHt D Ke~J 
Q New York OBold Q Medium l'8l Size OHufuP 
O Chicago 0 Large 

Attached To Orientat ion Horizontal Uertical 
O Unattached ® Horizontal Alignment Al ignment 
®Chart Title 0 Uertical 0 Left @ Top 
O Category AHis @Center 0 Center 
O Llalue AHis Q Aight 0 Bottom 
O Series or Da ta Point 

Series Number: 
11 

Point Number: I OK Cancel 

Text styles and formats available in Chart 

While the label is still selected, you can use the 
Format menu's Patterns option to frame the label in a 
border. 

Remember, you can choose to load Format Only 
from the Open command on the File menu. Once 
you've perfected one chart and its label formats, you can 
use this option for all subsequent ch arts in the same set 
and thereby save formatting time. 

One way of adjusting the final printed size of the 
chart is through the File menu's Page Setup submenu. 
Set the page to print Tall, and the chart will 

Poper: @ US letter 

0 US legal 

Orientation: ® To ll 

Poge Header: 

0 A4 l etter 

0 International Fanfold 

0 Toll Adjusted O Wide 

r--~~~~~~~~~~~~~ 

Page Footer: 
~~~~~~~~~~~~~~ 

l eft Margin: ~ 
Top Margin: ~ 

Printing options 
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Net Sal es 

I• •001 ~ •• 111~ 
1981 1982 1983 198< 1985 . . . 

Using MacDraw 

Charts 

automatically be sized to print about 51/2 inches wide in 
the middle of an 81/2 X 11 inch piece of paper. 

Set the page to print Wide, and the chart will print 
out sideways on a page, 11 inches wide (including 
margins). 

If these two options still don't meet your needs, 
you can use the Chart menu to Select entire chart. The 
chart will then be framed with sizing squares just like 
those in MacPaint and MacDraw. You can change the 
size of the chart directly on the screen by p ointing at 
one of these squares and holding the mouse button as 
you drag it in the direction of the desired size . 

<00 Net Sales 

200 

100 

19S1 1982 1983 19$4 19$S 

...illi 

Enlarge the chart size by selecting the chart and dragging to the 
desired size 

You can use this last option to enlarge the area of a 
chart if the labels do not fit properly along the axes, for 
example. You must use this option with caution, 
however, wh en making your charts smaller: some labels 
may be truncated or extended to two lines. 

Because you can copy a chart created with Chart into a 
MacDraw or MacPaint file, you can enhance any chart 
with the shadings and other special effects available 
through the paint program . This cap ability is relatively 
new - revolutionary in some views! 
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In the annals of graphic anecdotes, there is a story 
of a courtroom contestant who wanted to illustrate the 
misuse of certain funds through a combination bar 
chart/line graph . As this story goes, he was using some 
"antiquated" computer technology where he had no 
control over the final appearance of his ch art. He 
therefore devised an intricate series of steps to "trick" 
his program into printing the chart exactly as he wanted 
it, including running the same piece of paper through 
his printer several times. With a Macintosh, the same 
task could have been accomplished in less than half 
the time! 

$Millions 
400 

300 

200 

100 

0 

l/--\Gi NET SALES -----
1981 1982 1983 1984 1985 

A chart enhanced through MacDraw and printed out on a 
LaserWriter 

Copying Data from Multiplan 
You can enter information to be graphed into Chart 

directly from a Mu/tip/an spreadsheet file. The process 
may seem cumbersome at first, but the advantage is that 
you can "link" a spreadsheet to a chart - every time 
you change the data in your spreadsheet the chart will 
change also. Every time you open the Chart fi le that has 
been linked, it looks for the Multiplan file. If the 
spreadsheet file is not on the same disk as the chart 
file, you will be prompted to insert the appropriate disk. 
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The basic steps to copy Multiplan data into a Chart 
file are, first, to open your Multiplan file and select the 
portion of the spreadsheet you wish to graph. Use the 
Copy command to place the selected contents into the 
clipboard. Quit Multiplan and open a Chart file . Choose 
the type of series from the Data menu and then choose 
Paste or Paste and Link from the Edit menu to copy the 
data from the clipboard into the data series box. Paste 
does not permanently link the Multiplan file to the 
chart; Paste and Link does . In other words, every time 
you open a Chart file, the program will look for any 
linked Multiplan file and copy the latest data from it. 

Chart follows certain rules when pasting data from 
Multiplan. If you are pasting more rows than columns or 
the same number of rows and columns, data will be 
copied column by column. If you are pasting more 
columns than rows, the data will be copied row by row. 
Each row or column becomes a new data series. 

We've found this process to be slow and 
awkward-if, however, you will be changing your 
source data frequently in a spreadsheet, you will find 
this method helpful. Or you may find this method 
desirable when charting a long series of numbers into a 
line graph -five years of stock prices, for example. 
Experiment with it, and refer carefully to the Chart 
manual if you run into problems. Given the drawbacks 
of this technique, and the suggestion that the best 
graphics are those with the fewest elements, you may 
find it easiest to build each chart directly through the 
Chart program, rather than going through the steps 
outlined here for copying data from Multiplan, especially 
if you wish to copy figures from more than one part of 
a spreadsheet into the Chart program. 

The appendix lists other charting aids available for 
the Macintosh, including Mesa Graphics' Tekalike, which 
lets you paste graphics from mainframe computers to 
MacWrite and MacPaint. 
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We hope this chapter has given you some good 
ideas about how to start thinking graphically. Take a 
look at the information you handle in everyday business 
and you will surely find good cause and purpose for 
graphic communication. 
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Chapter 
2 Projects 

~ 
Mac Project 

-

How long will it take to build a solar home in the 
mountains of Virginia? How will the local Junior League 
chapter go about raising funds for the new children's 
wing of the hospital? How soon will customers find 
Software System Associates' newest game on the 
shelves of the local computer store? How late can a 
particular activity be started without affecting the final 
completion date of a project? 

Questions like these have often worried those who 
are responsible for making anything happen on 
schedule. Of course, we've all worked on projects with 
deadlines. Sometimes the que$tion is not "When will it 
happen?" but "How many items on our list of things-to
do can we accomplish in time?" or "Is this project 
feasible at all, given the time frame and current 
resources?" A planning tool like MacProject can help 
answer questions like these. MacProject is a 
comprehensive network-based planning tool, 
incorporating all the features of the PERT chart 
(Program Evaluation and Review Technique) or the 
similar CPM chart (Critical Path Method), plus the 
timeline features of the Gantt chart. 

PERT charts were originally developed in the 1950's 
to help coordinate the development of the Polaris 
missile. The PERT chart shows a series of events with 
estimated completion times for each task plus all the 
interdependencies between the tasks. With a PERT chart 
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the planner can ask "what if" questions such as "If a 
certain event is completed by a certain date, how soon 
can the next event be completed? How soon can the 
project be completed?" 

CPM charts were developed independently but at 
about the same time as PERT. CPM charts are useful in 
determining trade-offs between cost and scheduling for 
a given project (i.e., How will the total project cost 
change if the schedule is changed?). 

While PERT charts clearly show relationships 
between tasks, Gantt charts, showing tasks across a 
timeline, are highly effective for displaying concurrent 
time and resource usage and for showing clear start and 
finish times for each task. MacProject creates Gantt 
charts for you, by task or by resource. 

While some project managers still work with a 
calendar in one hand and a whip in the other, others 
have found that they can throw the whip away by 
involving the project team in the plans and gaining 
consensus about the schedule. MacProject helps set 
calendar dates for each step in a project and even 
displays the cash flow of the project over time, as well 
as producing clear, graphic presentations of the plan for 
review by the team leaders. 

Scenario: You just got a promotion. As head of the 
Retail Development Division of The Activity Group 
(TAG) Corporation, your first priority is to orchestrate 
your staff of ten in designing and opening the first store 
in a p lanned series of ToyTech Shops. What do you do 
now? 

Option 1: Relax. You know what you're doing. How 
else did you land this promotion? Get out your note 
pad and write down wh at tasks need to be done. Put a 
name next to each task. Then issue a memo to everyone 
letting them know what tasks they have been assigned 
and when it's due. Your project plan here is a simple 
one. 
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Option 2. Be realistic. You're lucky to be where you 
are, and you don't know everything there is to know -
yet. Take a stroll around the office and find out who 
your new crew is. Find out what their skills are and 
what they've been doing. Then go back to your desk 
and make a list of your staff. Next to each name, list the 
tasks that will make the best use of that person's skills. 
Then call a staff meeting to discuss responsibilities. This 
kind of project planning involves your staff, but there's 
no way to ensure that you have included all the 
necessary tasks and their dependencies, or estimated 
the project's completion date. 

Option 3. Calm down. Sit down with MacProject 
and sketch out your plan. While planning a project with 
pencil and paper is better than no plan at all, the real 
relationships between tasks can be hard to see. Task A 
may have to be completed before Task C begins, a 
simple enough relationship,but Task B, while it might be 
able to be started after Task A, must be completed 
before Task Z. With a package like MacProject you can 
simply sit down and sketch out the tasks, letting 
MacProject perform the job of keeping all the 
relationships straight. The rest of this chapter will help 
you go through the steps of planning a project. 

The prerequisite for using planning tools like 
MacProject is simple enough. The project must be 
broken down into a series of sequential, dependent 
steps. You can make this list on paper, as in Option 1, 
or you can begin by making this list directly through 
MacProject, as in Option 3. 

Option 2, on the other hand, begins with making a 
list of people, rather than a list of steps. Although 
Option 2 may be the most practical approach for you as 
a new division head, it does not meet the first 
requirement for an effective project plan: to break the 
project into a series of steps. If you are accustomed to 
simply giving assignments to people, you will need to 
develop the discipline of first listing all the tasks 
sequentially when planning with MacProject. Then you 
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can enter information about each task or step, including 
duration, resource assignments, costs, and so on. 

0 Resource 
@ Earliest Start 

® Duration 
O Resource 
0 Earliest Finish 

G 
O Latest Start 
O FiHecl Cost 
O Resource 

O Latest Finish 
O FiHed Income 
O Resource 

OK 

( Cancel ] 

Elements of Task D efinition as viewed in MacProject: Task 
Description, Duration, Resources Assigned, Resource Cost, Fixed 
Cost/ Income, Earlies! Start Date, Latest Finish Date 

The heart of the project plan is a diagram which 
shows the activities required to accomplish a goal. Each 
task is shown in a rectagular box. Review points, or 
milestones, are shown in boxes with rounded corners. 
Tasks which are connected by lines are dependent on 
each other; i.e. , before any new activity can begin, all 
preceding activities on which it is dependent must be 
completed. This type of chart is commonly called a 
PERT Chart, or a Schedule Chart in MacProject. 
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One of the advantages of working with project 
planning tools is that these programs will calculate the 
completion date of the project for you. In MacProject, 
the earliest possible start date for each task is shown 
above the top left corner of each task box. This date is 
calculated based on two things: the duration that you 
assign to each task (shown above the top right corner of 
each task box) and the calendar of working days that 
you define through the Chart menu. If you forget to set 
up your own calendar for a project, then it will be 
automatically scheduled according to MacProject's own 
assumptions: 5 days a week 8 hours a day. 

To create a project plan with MacProject, you need 
to create a Schedule, or PERT, Chart. To do so, open a 
new MacProject file and create the first task description 
by positioning the cursor near the left of the screen and 
dragging the mouse down and to the right. You'll see a 
box grow as you do. When you release the mouse 
button, the box will show a date at the top left corner 
and a blinking cursor inside the box. 

Type the task description. It's a good idea to begin 
all projects with a task called "Start" (or similar) from 
which all other tasks will branch. 

To create additional task boxes, you have two 
options. You can position the cursor inside the task box 
and drag the mouse to a free area on the screen, 
anywhere to the right of the first box. When you release 
the mouse button, a new box - exactly the same size as 
the first - will appear. Again, a blinking cursor appears 
inside the box and you can type the task description. 
You can build the entire schedule chart this way. This is 
a good method to use if you know in advance all the 
tasks in the project and how they fit together. 

The second method is best if you want to use 
MacProject as you "brainstorm" the project- i.e., if you 
don't know in advance what all the tasks are or how 
they fit together. To create each new task by this 
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method, simply position the cursor in any empty area 
on the screen and drag the mou se (just as you did to 
create the first task box), or select a task box and use 
the Duplicate option of the Edit menu to create boxes of 
the same size. You can move task boxes by clicking on 
the border of the box and dragging it to another 
location. By this method, you can create tasks all over 
the screen. 

Remember, dependent tasks must be positioned to 
the right of those tasks on which they depend. To draw 
a line wh ich shows wh ich tasks depend on each other, 
position the cursor inside a task box and drag the 
mouse into the task box which must follow the first. A 
line will appear connecting the two. 

Specify the time scale you want to use by selecting 
the Duration Scale option of the Dates menu. You can 
define project tasks in terms of minutes, hours, days, 
weeks, or months. The setting you select here will apply 
to all tasks in the project. 

To set the duration for each task, select the task by 
clicking on it, and set the duration for that task by 
selecting the Show Task Info option of the Task menu. 

0 Tosk Info 

Weeks Resources 

111 

Define 
Conc•pt 

Pl•asant Vall•y Sit• 
D•v• lopm•nt Plan 

I /8 1 / 15 I 
., ............... .!J! ................ !!J 
i D•fin• Display i 

Propos•d ' and Storag• 11------.---------< 
Inventory ~ Space Needs ~ 

il ............... ci ............... I /22 4 2/19 4 

Request Research/ Fin 
Proposals from 

Space 
Designers 

1 /8 I I 1 5 8 

D•v• lop Pilot 
Accountin9 

Syst•m 

The Task Info Dialog Box 
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Enter the duration and assigned resources in the Task 
Info dialog box. Press TAB to go to the next resource in 
the dialog box, press RETURN to go to the next task 
box on the Schedule Chart. 

You may save time by drawing all the task boxes 
first, filling in only the task desciption as you go along, 
then using the Task menu to Show Task Info and enter 
durations and resources for each task in the project. 

Finally, once you have set the calendar and task 
durations for the project, you can view the project's 
scheduled dates for each task. Use the Display Dates 
option of the Dates menu to select which dates you 
want to see on the Schedule Chart: early start, late 
start, early finish, and/or late finish . 

Note that you can also display the assigned 
resources or the duration of each task. The rule here is 
that only one item of information can be displayed at 
each corner of each task. 

Based on the information entered in the Schedule 
Chart, a simple menu selection will create Gantt-type 
ch arts of the activities across a time line: MacProject's 
Task and Resource Timelines. Any changes made to the 
Schedule Chart will be automatically reflected in the 
Timeline charts - you cannot make changes to these 
directly. 

Based on the project start date, the time estimated 
per task, and the calendar of work days, MacProject will 
calculate the projected completion date of the project. In 
scheduling tasks, MacProject knows that an activity 
cannot begin until all activities on which it is dependent 
h ave been completed. Following this rule, the program 
calculates each task's earliest start date, latest start date, 
earliest completion date and latest completion date. You 
can "override" MacProject's calculated dates by entering 
your own "earliest start" or "latest completion" dates for 
some tasks. 

For example, look at the ToyTech Store plan with 
the start date for each task as calculated by MacProject. 
You can enter these dates manually if you wish, and 
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override automatic scheduling. For example, if you want 
to order a certain toy before the wholesale price goes up 
in October, set the late finish date to be September 30. 

set start oate:I ._ 0_1_1_1 s_1_e_s __ 0_9_:o_o~ 
Set Clear [ Cancel ) 

Entering earliest start/late finish dates 

The Schedule Chart may be printed out and 
distributed to the major participants in the project for 
review and input to the next version of the project plan, 
with new resource assignments, revised task durations, 
and detailed costing . 

If the earliest completion date is the same as the 
latest completion date for an activity - i.e ., if there is no 
"slack" - then the activity is considered "critical" to the 
timely completion of the whole project. If any activities 
which are critical are delayed, then the entire project 

\" 

Schedule with Critical Path in bold 
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will be delayed by the same amount of time. Such 
activities fall on the "critical path" of the project, which 
is automatically displayed in boldface lettering and lines. 

Non-critical tasks are those which have some slack 
in the schedule - i.e., tasks for which the earliest 
completion date is different from the latest completion 
date. Tasks which do not fa ll on the critical path may be 
delayed to some extent without affecting the rest of the 
scheduled dates . 

A milestone is a task w hich has no duration, no 
resources, and no costs associated with it. For example, 
a review point in a project might be entered as a 
milestone. To identify a task as a milestone, select the 
task (click the mouse with the pointer at the task 
border) and then choose the Milestone option of the 
Task menu. 

Milestones appear as tasks with rounded corners 
on the Schedule Chart. They are identified with 
diamond-shaped markers on the Task and Resource 
Time lines. 

I Oevtl~p fir st 3-~•~r bud9•I projec)ion 

l • Alloc .te fund s : 
i ; i I lmpltmtnl Advtrlising & Sign•9e Pl•n 

A diamond marks m ilestones on the Schedule and Resource 
Charts 

The Task Timeline shows each activity stretched 
out across the time scale for the whole project. Any 
changes made to the Schedule Chart will be 
automatically reflected in the Task Timeline - you 
cannot make changes to the Task Timeline directly, 
except to select the scale of the timeline itself. 
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0 I Minute 
O 30 Minutes 
O I Hour 
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O I Week 
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® I Month 
0 I Quarter 

OK 
I Cancel l 

Projects 

Use the Timeline option of the Dates menu to compress or 
expand the Timeline Charts 

The slack time for non-critical tasks is shown in 
grey shading on the Task Timeline, which is 
automatically created based on the information entered 
on the Schedule Chart. 

Site Oeuelop ement 

1 / 29 2/26 3/26 4/23 
fQ 

1-~---,~~~~~,..-~~~~.,....-~~~~......--~~~~-.-~~~--t""" 
!W!i 

• S TART :::::: 

G~~;:::::!rch Propos•d ln~ •n\ory i:i:ii 

~fine Acc:oun ting S1Js tem ~equireme nt s 
D•:f~~'!!i'y~'~ il Mark•\in9 PlaJ , 

Gfin•IDisplay and Sto},a9• Spac• N••d~ 
Reque~t Propo{~~f¥.ll~tr;~!~ PR Firms : 

"'~f '.':::::f ::;:::.:,~:::.1:::1:':: ""' , . .,i ..... ,.,.,, J 

The Resource Timeline 

L'2 

The Task Timeline shows "slack time" in grey 

In addition to specifying the duration of each task, 
you can specify the name of the person responsible for 
that task . A task may involve more than one person (up 
to 6 with MacProject). Based on these entries, the 
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program creates a Resource Timeline showing each 
person's activities over time, such as the chart shown 
below. 

Site Deuelopement 

1/29 2/26 3/26 4 /23 

Define Concept! I 
Li s i /Rese~rch Proposed lni entory 

Define Acc;ounting System ~•quirements 

Def;~~'~:iV:~'.c~ 1 Marketing Pla~ 
! I 
i i 

-~ I HirP Floor 

i 

Define Concep lj I 
Lisl/Rese~rch Proposed ln~ enlory I 

Definej Display and Sto~ a9• Spaco N••d•: 

Request Proposals :from Spac• D .. ign•rs 
: t I 

The Resource Timeline shows "slack time" in grey 

The Resource Timeline may reveal that some team 
members will be idle w hile they wait for others to 
complete a task. You can add personnel to some 
activities to speed them up, or redistribute 
responsibilites amongst the team members. As in the 
Task Timeline, slack time is displayed as grey shading. 
Here also, any changes must be entered through the 
Schedule Chart, you cannot make changes to the 
Resource Timeline directly except to change the scale of 
the timeline 

The Cost Schedule 

So you've completed your initial project entries, 
and you're excited to announce the scheduled Grand 
Opening date at the next staff meeting. Your own staff 
greeted the news with much more enthusiasm than the 
CFO, w ho returned his copy of your project schedule 
with a brief note attached: "Cost schedule missing''. 

MacProject provides two different tables for entering 
project cost estimates: the Task Cost Entry table and the 
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Resource Cost Entry table. These options are offered 
under the Chart menu. These cost tables appear on the 
screen with the list of tasks (or resources) drawn from 
the Schedule Chart - you cannot add tasks or resources 
to these tables directly. You can, however, enter dollar 
amounts in the columns provided on these tables. 

Use the Resource Cost Entry table to list the rate of 
pay per unit of time for each resource involved in the 
project. The unit of time here is the one you selected 
for the duration unit of each task: a minute, an hour, a 
day, a week, or a month. You can view this table after 
you complete your Schedule Chart entries. Any resource 
entered through the Schedule Chart will automatically 
be listed here. You cannot add, delete or edit resource 
descriptions in this table, or in the Task Cost Entry 
Table, but you can enter text as notes anywhere on the 
screen. 

In this case, the resources you entered in the 
Schedule Chart are all people, but they could also 
include other categories of information. A construction 
firm might pay a daily rate to rent a bulldozer, for 
instance, and this bulldozer rental would be entered as 
a resource on the Schedule Chart, and its rental rate 
would be entered in the Resource Cost Table. 

1 

2 

3 

4 

s 
6 

7 

8 

EMO 

l/P 

O'Loskey 

Binet 

Davila 

Bunz 

Howard 

Moore 

Resource Name 

The Resource Cost Entry Table 

Cost/Week Accrual Method 

1000.00 Multiple 

0.00 Multiple 

1000.00 Multiple 

800.00 Multiple 

400.00 Multiple 

600.00 Multiple 

400.00 Multiple 

600.00 Multiple 

Use the Task Cost Entry table to list the fixed cost 
of a task, over and above any resource costs. For 
example, the cost of materials in building display 
shelves in the store can be estimated as a fixed cost, but 
the cost of the carpentry service (which would have 
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been entered in the Resource Cost Entry Chart) will 
depend on how long it takes to assemble the counters. 

Task Name 

START 

2 Define Concept 

. List/Research Proposed Inventory 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

Define Display and Storage Space 

Define Accounting System 

Define Local Marketing Plan 

Request Proposals from PR Firms 

Request Proposals from Space 

Develop Pilot Accounting System 

Research/Find Space to Lease in 

Develop first 3-year budget 

Allocate Funds 

Implement Advertising & Signage 

Order Inventory 

Hire Floor Staff 

Implement Space [)'!'sign Contr.oct 

The Task Cost Entry Table 

Fixed Cost Fixed Income 

0 0 

0 0 

0 0 

0 0 

0 0 

0 0 

100 0 

100 0 

0 0 

2500 0 

0 0 

0 0 

5000 0 

25000 0 

1000 0 

10000 0 

The Cash Flow Table summarizes all the financial 
information you have entered for the project. If you are 
clear on the distinction between costs which are fixed 
and costs which will vary depending on the duration of 
each task, then you will know whether to enter an item 
as a resource or include it as a fixed cost. This way, 

Starting Costs Income EndirtQ Cumulative 

1 /1 12200.00 0.00 1 /29 -1 2200.00 

1129 10900.00 0.00 2/26 -23100.00 

2126 7400.00 0.00 3/26 -30500.00 

3126 54200.00 0.00 4/23 -84700.00 

4/23 7600.00 0.00 5/21 -92300.00 

5121 3200.00 0.00 6/18 -95500.00 

6/18 10600.00 0.00 7/16 -106100.00 

The Cash Flow Table 
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your Cash Flow Table will remain accurate throughout 
the project as you change projected figures to actual 
figures. 

The Project Table presents a consolidated summary 
of all activities, showing start and finish dates, resources 
and costs for each task. This table is created by 
MacProject based on your entries in the cost tables and 
on the Schedule Chart. You cannot make changes to 
this table directly. 

T1sk N1me Week!: Earliesl St.art Earliest Finish L•lesl Start Lat.est Finish Fixed Cost Resource C°'t Fl>eCI Income Resource 1 

2 

3 .. 
5 
6 

8 

9 

10 

II 

12 

13 

14 

15 

16 

17 

START 

Derlne Concept 

LlsUReseerch Pro,osed 

Deftn• Otspl•y ind Storage 
Define AccounUn9 System 

Define Local Nerkellng Plan 

Request PrOQo5tls rrom PR Firms 

Req uest Proposals fr om 
Develop Pilot Accounll~ System 

Rese.-d1/Flnd Sp.1ce Lo 

Oevelo1 ft r'Sl 3-yur budget 

Allocate Funds 

lmpleme•l Adver"l1sln9 & 

Crder rnv!fltory 

Hire Floor Sltff 

Implement Sp1ee Oesil}l Contract 

GRAND OPENING 

Project Control 

0 

I 

I 

I 

I 

I 

4 .. 
8 

4 

2 

0 

12 

4 

4 

8 

0 

I/I I/I 77 77 0 0 0 

I/I 116 77 77 0 1800 O O"Lost•y 

1/8 1/15 77 77 0 1800 O O'loskty 

I/IS 1/22 77 77 0 1200 0 Binet 

1/8 1115 ?1 ?? 0 1600 O Ol.osk.ey 

118 1115 1121 1128 0 1600 0 otosk.ey 

1/15 2112 1/28 2125 100 2400 O Moore 

1122 2/19 77 1/28 100 3200 0 81not 

1115 3112 ?? 2125 0 8000 O Bunz 

2119 3/19 1128 2125 2500 3200 0 Binet 

3/19 4/2 2/25 3111 0 6000 0 O"Lostey 

4/2 4/2 3/ 11 3/11 0 0 0 

4/2 6/25 3/1 1 6/3 5000 7200 O Moore 

412 4130 5/6 6/3 25000 1600 0011vt111 

4/2 4/30 5/6 613 1000 6400 O Otosk.ev 

412 5128 416 6/3 10000 6400 0 Binet 

6125 6/25 6/3 6/3 10000 0 0 

The Project Table 

The Project Table is useful as an overview of the 
entire project. Use it as a reference and as a "note 
pad" - accumulating hand-written notes about changed 
dates, costs, and resources - until you update the file 
during your next MacProject session. 

Project control, the underlying managerial function, 
begins with refining the initial project plan details, and 
continues with reviewing the difference between the 
schedule and actual performance over the life of the 
project. Review points may be identified on the 
Schedule as rounded "milestones". At these review 
points, the project schedule may be updated to reflect 
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revised task duration estimates, personnel assignments, 
and start/finish dates. You can also enter the actual 
number of days it took for completed tasks and the days 
remaining to complete tasks in progress, and the 
scheduled dates for activities which follow will be 
adjusted accordi ngly. 

Any changes made in the Schedule Ch art will be 
reflected in the Task and Resource Timelines 
automatically. Each of these charts can be printed out, 
horizontally or vertically, on 81/i inch wide paper. You 
can preview pages before printing (through the Show 
Entire Chart option of the Layout menu), so you can 
manipulate the Schedule Chart to accommodate page 
breaks. Individual task rectangles or circles may be 
made larger or smaller for purposes of emphasis or 
aesthetics. Task and Resource Tirneline Charts which 
span a long time period can be shortened by changing 
the scale of the time axis from one week to two weeks, 
one month or one quarter. You can also set the time line 
to one minute, 30 minutes, or one h our. 

With MacProject, you can type additional text 
anywhere you like on the Schedule Chart. The charts 
created by MacProject can be copied into MacWrite or MS 
Word, merging the diagrams with the text of a fu ll 
proposal or project plan narrative. The charts can also 
be copied into MacDraw, where borders, shading, and 
more text may be added for the final presentation. 

For large projects, you might want to start with the 
overall plan, then break it into segments which you 
copy into sub-files and expand. In deciding "which way 
to go," yo u can show alternative plans by cloning and 
changing the first basic plan. With MacPruject at your 
service, you may find that your needs for clearly 
documented "plans" expand to include simple office 
routines, such as end-of-month closing procedures, 
which go into an in-house training and reference 
manual. 

The value of project planning is tremendous. Well
planned projects not only keep the project team happy, 
th ey are more likely to be completed on time and 
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within budget. There is no doubt that good planning 
tools improve the implementation of any project - large 
or small . And, as a manager of a project, summarizing 
the steps required to get something done can be, in and 
of itself, an exercise of great value. Once again, we can 
see what a tremendous "thinking tool" the Mac can be. 

Toylech Shop 

Ll1Vlle1ean:h 
Prop .. ed 
Inventory 

Pleasant Valley Mall 
Development Plan 

Define Dis play -------- -----i Ordtt 

-------.~ Inventory and Storqe 
Spate Needs Request .,••••111'1 Prop ..... 

from Spate 
Destanen 

Re1ean:h/Flnd 
Space to Leue 

inPleuant 
Valley 

Implement 
m--+--...J Spate 

Define 
Accountlna 

Syatem 
Req ulrements 

Develop Pilot 
Accountiaa 

Syatem 

Reques t 
Prop ..... 

from PR Flnm 

Develop finit 
3-year 
bud&et 

projection 

Schedule Chart enhanced through MacDraw 

Des tan 
<Ant.net 

GaA•D 
OPElll•G 

MacProject is easy to learn, either through the 
tutorial provided or simply by studying the excellent 
examples of project p lans provided on the MacProject 
disk. These programs make the previously complex (or 
at least mysterious) task of planning a project simple. 
Don't let your Mac go without it! 

52 



Chapter 
3 Diagrams 

MacPaint vs. MacDraw 
Flow Charts 
Organization Charts 
Floor Plans 
Street Maps 
Merging Diagrams with Text 





Chapter 
3 Diagrams 

-
MacPaint 

-

There was once a company which grew so quickly, 
it had to move its offices three times in one year. New 
employees were being hired every week, and the chain 
of command seemed to change as often. To make 
matters even more complicated, they were constantly 
promoting people from within the company and moving 
them from one department to another. The .whole thing 
came to a head one day when the president, J.B. 
himself, realized he didn't know who was in some of 
the company's key positions. To make matters worse, he 
had a board meeting the next day and, of course, the 
agenda included discussing the company's organization, 
as well as a discussion of the physical plant. The 
physical plant! Double-bad news - he hadn't been able 
to find the CFO's office on the third floor last Friday! 

In the past, preparation of attractive, clear 
materials to present this kind of information took days 
or possibly weeks to prepare, depending on the 
back-log in the art department. Today, the Macintosh is 
able to produce all the floor plans and diagrams J.B. 
and his staff need- in less than a quarter of the time it 
takes to produce the same diagrams using manual 
drafting techniques. 

The examples presented here include J.B.'s 
organization chart and floor plans, as well as other 
common charts and diagrams which can be created 
using MacDraw or MacPaint, though most frequently 

55 



MAC AT WORK 

MacPaint vs. MacDraw 

Diagrams 

we'll be referring to MacDraw. As in the previous 
chapters, even if you don't have the program you can 
still benefit from the following sections because they are 
designed to help you think about how to use these 
kinds of graphics in your own business. It can be quite 
revealing to draw a flow chart of a common procedure 
in your office. Why does an invoice go to Lucille's desk 
first, then to John's desk, then back to Lucille? By seeing 
the whole picture, you can often find ways to make 
operations more efficient. Graphics are indeed a 
"thinking tool" and a simple diagram can clarify 
relationships that are cloudy when information stored in 
our left brain is not matched by an image on the right 
side of our brain. 

The basic techniques presented in this chapter can 
be extended to create a wide variety of graphic images, 
or to enhance the graphics crea ted with Microsoft Chart 
and MacProject, as discussed in Chapters 1 and 2. 

Almost everyone who has a Macintosh has the 
software program MacPaint. When the Macintosh was 
announced in January of 1984, its revolutionary 
capabilities were partly a result of the machine, and 
partly the wizardry of the MacPaint program. Thousands 
of artists have used the MacPaint "pen" to produce 
entire galleries of fine illustrations. 

MacDraw, on the other hand, was released about a 
year later. It is essentially a sophisticated "clone" of the 
program LisaDraw, the drawing and drafting program on 
the Mac's big sister, the Lisa computer. 

There are some differences between MacPaint and 
MacDraw that are important to understand so that you 
can make the best use of each . The most basic 
difference is that MacPaint sees what's on the screen as 
pixels (a pixel is one "dot" on the screen) and MacDraw 
is "object oriented" - i.e. it sees each circle, for example, 
as a circle, not as separate dots. So, while you can use 
MacPaint's Fat Bits to create the finest details in your 
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illustratio.n, MacDraw has a different kind of flexibility 
that is extremely important in designing forms and 
diagrams. 

In MacDraw, for example, you can draw a circle, 
then place a rectangle on top of that circle. With a click 
of the mouse you can "grab" either the circle or the 
rectangle and separate the two objects. Both objects 
remain whole objects. At any point an object can be 
moved, made larger, smaller, or actually stretched to 
become a different shape. Also, text is treated as an 
object so you can change the font or style at any time, 
as well as the location of the text. 

MacDraw 
.;,,·:,; 

T 
+ ····:··· ·:·· · ·:····:· · ·······;··· · :· ···:····:····:····:···+···>k 

. . 

. .,;. 

········l······ ~········:········~········:········~········=········i········:········~ ... ···=········~······ · :f' 
. . . . . . . . . 

: . : . . . . . . . . . . . . . . ........... ... . . . . . . . ... . . . . . . . ... . . . . . . . .. . .. . . . . . ... . . . 

In MacDraw objects can be moved individually 

In MacPaint, on the other hand, you can reshape 
and move objects but only while the object is originally 
selected or is not connected to any other object. And, if 
you draw a rectangle over a circle and try to separate 
the two, you will destroy part of the circle. Once you 
have put text in place and gone on to do something else 
on the screen, you cannot come back and change the 
font or style of the text with a simple menu selection. 
Instead, you must delete old text and re-type in the new 
font. 
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In MacPaint separating two objects destroys one of them 

Diagrams 

What these differences mean in practice is that 
MacDraw is generally best suited for most bu siness 
applications if for no other reason than because it allows 
you to easily change your mind. There are other 
reasons, too, besides the ones we've already mentioned . 
For example, MacDraw has a Show Size command 
which lets you see the exact size (in inches) each object 
will be when printed out. 

Of course, you can use MacPaint for any diagram 
but you need to plan the page layout more carefully 
before you begin - you can't design onscreen so easily 
as with MacDraw. MacPaint does excel at "fine tuning" a 
drawing, and at adding artistic touches. Fortu nately, you 
can paste a MacDraw document into MacPaint and the 
two programs combined give you a powerful graphic 
tool. If your company logo, for example, contains many 
non-geometrical elements, it may be easiest to produce 
in MacPaint. Then you can paste it from MacPaint into 
the MacDraw file where you built your diagram or form. 
The final printout to the ImageWriter or LaserWriter 
printer will yield results that will impress the most 
skeptical of your crew! 
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Receive 
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Fill out order form with 
product codes and 

prices 

Deliver products 
with invoice 

To Accounting 

Diagrams 

A flow chart is simply a diagram showing a 
sequence of steps. The concept was made popular by 
computer programmers who used flow charts to work 
out the sequence of steps to be written into a program. 
The same type of diagram is useful for charting 
sequences of manual tasks or procedures as well. 

Flow charts can be especially useful for teaching 
routine activities to new employees, or for reminding 
you how to perform complex tasks that you don't do 
often . Flowcharts, like project plans, can also be useful 
for coordinating activities between a number of people. 
For example, you can show the steps involved in 
processing a customer's order. 

One major difference between a flow chart and a 
project schedule (created with MacProject - see Chapter 
2) is that project schedules force you to go always 
forward, whereas a flow chart can have branches which 
go back to a previous step. These backward-pointing 
branches usually occur conditionally; for instance, you 
could say "If there is not enough inventory on hand, 
enter a backorder." 

Fill out order form with 

product codes and I 
prices 

.______.......-

Deliver products 
with invoice 

Backward Branching 
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Another difference between a flow chart and a 
project schedule is that a flow chart specifies only tasks 
and conditions for branching. No start times or 
durations are included. 

Creating a Flow Chart 

The following steps will allow you to create a flow 
chart quickly and efficiently. These are the steps for 
using the MacDraw program. A similar diagram could 
be created, however, using MacPaint. 

Open a MacDraw file. Click the mouse on the 
Rectangle selection box, then draw a box at the top 
center of the chart area, large enough to include the 
first task description. You can use the Layout menu to 
display Standard Rulers if you like to be precise. This 
command causes rulers to appear on the top and left of 
the screen. 

The Font menu is used to select a lettering size and 
style. Use the Style menu to select bold or italic type, to 
center the text, and in MacDraw only, to set single-space 
paragraphs. 

With the rectangle still "selected" (i.e., framed in 
small black markers) type the description of the first 
activity. In MacDraw, you need not select the Text 
option; as you type, the text will appear inside the box, 
with the box edges serving as text margins. This ability 
to type text inside a shape is unique to MacDraw. 
Experiment with this feature - you'll find it handy for a 
variety of applications. 

If each task description is roughly the same length, 
you can duplicate the first box as many times as 
needed, then go back and select each box with the 
mouse, typing the task description directly in each . If 
task descriptions vary in size, or if you wish to use 
different types of task boxes (squared, rounded, and 
triangular, for instance) you can draw each box 
individually sized to fit each task description as you go 
along. 
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WAREHOUSE 
ACTIVITIES 

Diagrams 

It's a good idea to keep the box as small as possible 
while including all the text. (If the white "fill" around 
the words overlaps the box border, you can grab the 
corner and make the box larger or use the Fill menu to 
set all text fill to None.) 

Add more tasks which branch off from the central 
line where appropriate. You may need to re-arrange the 
main line to show the correct relationship between 
tasks. 

Receive 
Custome(s Orders 

Fill out order form with 
product codes and 1-----, 

prices 

Enter some 
products as 
back-orders 

Arrows on lines show sequence of tasks 

Finally, use the Layout menu to Reduce To Fit and 
click the mouse on the Line selection box to add lines 
connecting task boxes. Add arrows to all lines if they do 
not all point downward and to the right. 

Complex Layouts 
One way of developing your charting skills is to 

diagram as many of your internal ·office procedures as 
possible. In doing so, you will find some charts more 
difficult than others. For example, it may be that the 
flow chart you need shows a circular cycle, such as 
the cycle of inventory depletion and re-stocking. Not 
only will it clarify relationships for you, but it will also 
make it infinitely easier to communicate to others in 
your organization. 
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In creating a flow chart with an unusual or 
com plicated format, such as a circular pattern, build 
each activity box first, then move them into arrangment 
around the large flow circle. For large diagrams, use the 
Layout menu to Reduce To Fit, so you can see the whole 
diagram at once and re-arrange the elements on the 
page. You can draw the con necting lines using the arc 
sh ape or simply move each activity box into position 
around an oval or circular line. If the circular line 
appears to lie on top of the activity boxes, use the 
Arrange menu to Send to Back (i.e. , position it behind 
the activities) . 

~D Sole Process 
:::~f : : 
T ...... : ....... ; ....... L ...... : ..... i. oRriER . L .... ; .. . 
+ j ~ j . ~ROCESSING . 
'\, ....... = ...... : ...... : ........ .. 

D 
0 ...... ;····l"'·""'···= ... "'! .. ;= .. """';'=;g:::::~:..:..;· 
0 ~ 

Arrange large diagrams in " Reduce to Fit" sca le 

You cannot add ar rows to lines created with the 
Arc option by a menu selection. To add arrows to 
curved arcs, draw a triangle with the polygon icon, then 
use the Fill menu to shade it black. 

MacDraw and MacPaint have feature called Auto
Grid which, when it's ON, will line up objects on an 
invisible grid. Each "grid line" is eight pixels apart. By 
working with Auto-Grid ON, you will be assured of 
lin ing up all text and lines along a defined grid, but 
sometimes you may want more freedom to arrange text 
and lines in finer increments than the auto-grid option 
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allows. For fine positioning, use the Layout menu to 
Turn Grid Off. 

Organization Charts 

An organization chart is a useful tool for 
announcing a business reorganization, for explaining 
your organizational hierarchy to a new employee, or for 
reviewing the overall division of resp onsibilities during a 
staff meeting. The chart itself may show individuals' 
n ames and titles, department names and managers, or 
corporate divisions. 

Ron Turnell 
VP Marketing & Sales 

Bud Stark 
Easlem Region 

Mary Questor 
Eastern Admin 

J.B. Morless 
President & CEO 

Elana Driggs 
VP AdminsilraUon 

Helen Dale 
Personnel 

Carol Adler 
Clerical Group 

Mike Murray 
Shipping 

Organization Chart 

Marla Brandonis 
Complroller 

Robert Irons 
VP Production 

Allen Sharp 
Main Plant 

Jon Little 
Aspen Plant 

We could use the same steps to produce an 
organization chart that we used to create a flow chart, 
but J.B. might not be happy with the end product. In 
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Marla Brandonls 
Comptroller 

Diagrams 

flow charting, it's alright if all the boxes are different 
sizes. On the other hand, because of the uses made of 
Organization Charts - Board Meetings and such - we 
want all the boxes to be the same size, or we want the 
size of the box to reflect the level of the position rather 
than the number of letters in the person's name or title. 

Furthermore, aesthetics may become an important 
factor in organization charts. For instance, drop
shadows - shadow-like outlines behind each box in the 
chart - will give your overhead transparencies or slides 
a more polished appearance and make your 
presentation more effective. For these reasons, we 
followed a slightly different sequence of steps in 
producing the organization chart shown here. 

Producing an Organization Chart 

Compare these steps to those suggested for creating 
flow chart. The first steps are the same: 

Open a MacDraw file. Click the mouse on the Text 
selection box, then position the cursor at the top cen ter 
of Lhe chart area. Use the Layout menu to display 
Standard Rulers if you like to be precise. Use the Font 
menu to select a lettering size and style. Use the Style 
menu to select bold or italic type, to center the text, and 
set single-space paragraphs. 

First type the longest name on the list, and on the 
next line type the longest title. The title here does not 
necessarily match the name - you are typing the longest 
words in order to determine the standard size for all the 
boxes on your chart. The name and title may by typed 
in two different type styles and sizes. Both lines should 
be typed under the Center option of the Type menu. 

Draw a box around the name and title. Click on 
the text and set the Fill to None so the box can fit the 
text tightly. 

If you want to drop-shadow every box, do that 
now. Use the Edit menu to Duplicate the first box. The 
second box will cover the first, but don't worry, simply 

64 



MAC AT WORK 

< 
\ 

< 

c # 
< 

I < # c 

- \ ), 

• < • 
\ ), 

Ron Turnell 
VP Marketing & Sales 

Bud ~tark 
~astern Reg1o~ . . . 

Marla Brandonis 
VP Marketing & Sales 

Floor Plans 

• I 

Diagrams 

use the Arrange menu to send the shaded box to the 
back. Use the Fill menu to make the second box black 
or grey. 

Select the whole box and the text as a unit and use 
the Arrange menu to Group them as an object. Then 
use the Edit menu to Duplicate it as many times as 
there are people. 

Use the Layout menu to Reduce to fit, and arrange 
the boxes on the page as appropriate. Begin by setting 
up the widest line of boxes, and let all other lines fall 
from these. Before printing out, use the File menu to 
change to a Wide page format if necessary. Don't worry 
that all the boxes show the same name and title. 

Use the Layout menu to return to Normal size. Use 
the Edit menu to Select All, and the Arrange menu to 
Ungroup all the grouped boxes. Now you can go 
through and click the mouse on each name and title, 
replacing them with the correct individual names and 
titles. 

Here you can see that you have saved time by 
selecting the type font and style for these two lines only 
once - when you built the first box - rather than every 
time you type a new name or title. (For more tips on 
preparing presentations, see Chapter 9). 

Large offices like J.B.'s make good use of floor plans 
to help employees and visitors find their way around. 
New or expanding offices work with informal floor 
plans to see how many workstations will fit in a given 
space. Fortunately, you don't have to be a draftsman to 
produce a floor plan with MacDraw. 
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Choir 

Desk 

·~ She'.u~s 
Porlltlon 

Diagrams 

Floor Pion 
. . . . . . .· . . . . . ~ . . ..... :' .. : .. 

~~~· 
'·~ ........ '··:· ... ·: ..... . 

. ··:· .... 

Floor Plan 

The steps in creating a floor plan differ slightly 
from those in creating a flow chart or an organization 
chart. Whereas in a flow chart we used no standard, 
repeated symbols, and in an organization chart we 
created only one or two standard symbols which we 
duplicated many times, in a floor plan we create many 
different standard symbols for duplication . 

For example, you can see that our floor plan uses 
one symbol for a chair, another for a desk, and two 

. . . . . . • . . • . . : . . . . . . . . . : . ~ii~!; 

' . . . . . . . . . . . . . . . . . . . . : ........ : ..... ' .. : ........ ~ . . . :::. 
ii~;: 

....... \': 

Partition 

Worksta tion : ~ 

A "Workstation" can be created by grouping smaller objects 
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Street Maps 

Diagrams 

more for shelving and partitions. What you might not 
realize by looking at the final printout is that the entire 
desk/chair/bookshelf unit is a single object, created by 
grouping the components . Grouped objects can be 
duplicated with a single click of the mouse. 

Some objects in your floor plan may be candidates 
for the Arrange menu's Rotate and Flip options. 

s File Edit Style Font Layout 

§0 Floo 

Ij±~£~ r 
0 
0 

' _Q, 

~ 

.. ~· .... ·:· .. 
llliqn to &rill 
llliljfl IJIJ.fl'Gh ... 

Arrange menu's Rotate and Flip options are useful in arranging 
some objects, such as workstations 

For precise measures, use the Layout menu to 
select Show size while you are building the floor plan. 
With Show size ON, you can see the exact 
measurements of each object as you build it. Also, you 
can see the size of finished objects by clicking the 
mouse on each object. 

MacDraw makes drawing a street map so easy that 
you may want to add a simple map to the next office 
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picnic invitation or storewide sale announcement. 
Including a street map in sales literature may encourage 
people to come to your location . 

_J LJ LJ I / ToyTech Shop r 7 Space Street 

] ! s:~:.:· j [ 
j Valley :1> 
.... Mall ~ 
~----~=' 

MiltyWay !; 

1nn1 
Street Map 

The street map intrdouces one additional special 
fea ture w hich you did not encounter with any of the 
other charts or diagrams in this chapter: labeling 
vertically as well as horizontally. This is a simple menu 
selection, namely Rotate Left or Right options from the 
Arrange menu. 

The street map is one of the only examples in this 
book where we use the smallest type sizes available (9 
point). 

Merging Diagrams with Text 
Remember that you can use the Cut and Paste 

options of the Edit menu to paste figures from MacPaint 
and MacDraw into MacWrite or Microsoft Word. 

Once pasted into a text file, you can shift the 
drawing left or right by adjusting the margin settings, 
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but you cannot type text on e ither side of it. MacWrite 
allows you to re-size drawings once they are pasted in 
from MacPaint or MacDraw, Microsoft Word does not. 

s file Cdit Search Format font 5tyle 

~O untitled 

1;.::~::L. ... 1 ... ... 1... . ... 1 ..•.. 1. ;1;··1 .... ... 1... . ... 1 . • ... 1.1 ... 1. • .. 1 .• . 1 ...•. ..1 .~ •... 1 ... • ~ .. ... 1 .. . .. .1 ....... 1. ... .. 1... . .. 1 .. . .. 1-;[:111:1 

. @fl~ D 6 lines/inch It ~ § [3 ~ ~ ~ ~ !J!:i!!~ 
:j1:~M 

Workstation 

You can position a drawing in a text file by adjusting the margins 
or selling the format a left, right or center 

You can also typeset figures and text directly from 
Mac disks. (See the Introduction to this book for 
details. ) 
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Chapter 
4 Financials 

Multiplan 

-

In any business, it's important to be able to 
measure success on the basis of more than simply the 
customers' smiles and the amount of cash in the bank. 
Even if the owners of a business feel good about their 
condition, based on some intuitive judgement, outside 
institutions like banks and the IRS demand careful proof 
of the company's success or promise. Towards this 
purpose, accountants have evolved certain routine ways 
to report financial condition such as the Balance Sheet 
and the Profit/Loss Statement. 

With Microsoft's spreadsheet package, Multiplan , 
you can create profit/loss reports, future sales 
projections, loan payment calculations or other 
spreadsheets easily. A spreadsheet is any report with 
columns and rows of information. The entries may be 
text, numerical values or formulas which calculate values. 

Computerized spreadsheets offer some remarkable 
advantages over the old hand-written columnar pad. 
The most obvious is that columns or rows can be 
totalled automatically by entering a formula in the 
TOTAL area. Also, once you've checked your formulas 
for accuracy, you can make changes to the other values 
on the spreadsheet and recalculate the totals in an 
instant with confidence that the calculated new values 
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will always be right. Furthermore, once you have 
created a spreadsheet format you can copy it and re-use 
it month after month, keeping all the titles and 
formulas and entering only the new information. 

Bolonce Sheet 
2 

... .. ... .. .. ..... ...... ..... . . . . ... : ~.791.9.Q9 . 
.. 3 .... 3 .49WQ9.Q ..... .... .. .. .. ....... • .. . 

:3 . . . .... . ....... :P630QO I 

~~i"'''""" ••••• •• · ·· · · ···· · •!!:i••• •• · ···· · • !i:·· · · ••••••••••.••••••.•••• i•·· 1 
.. ... ... .. .. ... .... ... .... : : ::: ~:$\Jt(@:~i~:~hi~i :: : : ::: : ::::: 

.. ... . : : . . . . rm:~ 
.. .. 1. ... . k1~$.l\.ff.I~.$ :~ .$!.~.l>~.Q\.Ri;~: .~Q~l.1Y .. : ..... . . 

I P•~•blt lo Banks '6 .. ...... : !.~?.~9.00.Q 
~~9;,:~r)ii:~:~~~:~1:~ .f~~~;~~~~:~p~:~~~~::: : . 8251000 . . ::::: :: .... i!mi 

t.~~;:~1~;~~;:;r~ ~~1~r~ .~. ~~~~fiJ• :1 ... :r-g~: .:.:::::: :.j: : 1.1.ll 

.. W~~.~P~~1pm ... .... .. :: : .. . ::: .. .. .. ... : ~:~~1~@:~i~:RH:t~l ............ ... , .. 
?.t.q~~!>!l1.~~r~.'.E~4i,t,y;_ .... ..... . :s. . . . . . . . . . .. . . . . .. .. .. .. . .. I· . 
.. ~'1(1''1)9~ ~lo9!<.. . . . . . . . . .. . . . .. . .. .. . . .. . . . . .. ......... · I . 
. . R~!~!\>~.~ .E~rr.ip9~ .......... . . ....... . .. . ·I· . 
. . ~rnq<~9.E~'. ~.QV.IJY ................ : 

TOTAL LIABILITIES & E UITY 

Spreadsheet showing formulas 

You can also perform calculations which you never 
would have attempted manually because they would 
have taken too long. For example, you can build a 
model to project future sales, then ask for projections 
based on different assumptions such as: "What if the 
price is $10 instead of $20?" "What if we sell twice as 
many?" 

In this chapter, we first look at how four district 
sales managers approach the question of next year's 
sales projections, including one example of "what-if" 
formulas. Next we view the CFO's full Profit and Loss 
Projection, based on the sales managers' projections and 
including a formula for looking up production costs 
based on production volume. Then several variations of 
Cash Flow Analysis are presented. Finally, the elements 
of a Balance Sheet are reviewed. 
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Sales Projections 
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The figures entered in a spreadsheet can be used in 
a charting program, such as Microsoft's Chart to 
produce pie charts, bar charts, line graphs or other 
graphic representations of the figures. The spreadsheet 
figures can also be copied into text files created with 
MacWrite or Word, or into files or database programs 
such as Microsoft's File. 

~+>Net ......... Sales 
' 

+ $$ 

400 

300 

200 

100 

0 

1980 1981 1982 1983 1984 

Bar chart shows net sales 

As a District Manager in the Sales Division of The 
Activity Group Corporation (TAG), you are invited to 
join other regional managers in Las Vegas for the annual 
plan ning session to discuss the past and target the 
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future. As part of the preliminary handouts for the 
meeting, you have received the following reports in the 
mail: 

• Last year's sales volume by quarter 
• The CFO's preliminary sales projections for next 

year, by quarter 
• Table and graph of last 3 years' sales/profits and 

one-year projection 

TAG Silt s Reports 

aJARTERI. V FIGURES 
19ll:S Sales Isl Qlr 2nd Qlr 3rd Qlr 4lh Qlr 19~ 
(lho<Jund•l 
Easl 120 125 115 130 490 
Norlh 90 96 87 104 377 
Soolh 150 160 149 171 630 
w .. t 170 182 165 180 706 
TOTAL 530 563 5 16 594 2203 

1906 Projecllons Isl Qtr 2nd Jllr 3rd Qlr 4ll1Qtr 1906 
(lhous...ts) 

Easl 144 150 136 156 586 
Norlh 106 115.2 104.4 124.6 452.4 
Soolh 100 192 170.0 20:5.2 7:56 
Wnl 204 216.4 106 226.6 847.2 
TOTAL 636 67:i.6 619.2 712.6 2643.6 

AIHJAL FIGURES 
TAG Soles 1962 1963 19114 1965 1966 
llhousands) PRQ£CTED 
Easl 350 369 410 490 590 
Norlh 300 330 370 377 445 
Soolh 450 476 540 630 750 
West 545 563 609 706 650 
TOTAL 1645 1740 1929 2203 2635 

Preliminary Sa les Reports 

When you checked into your hotel room this 
morning, you were given a canvas bag containing a 
Macintosh and a disk with all the files used in the 
printed reports. You were told that you have four hours 
to review the materials and prepare for the first 
meeting, at which the summary reports would be 
revised based on input from you and every other 
regional manager. Which manager are you in the 
following scenarios? 

North knows that he can count on his sales force to 
meet nearly 80% of their targeted sales volume. His 
strategy for projecting sales for his region is simple : Let 
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the CFO decide what North's target should be, and 
work backward from there. He looked at the CFO's 
projections and jotted a few notes on the memo pad 
provided by the hotel. 

.sALf.5 foRc.E WI L.L MEET 

<i?O°lo OF 17>-R.&E'T 

ANNOUNC.c No~.... Pl!>IRlC.T 

6-0AL. ~ .$ S"bf, 000 
North's mental spreadsheet 

The whole thing seemed too simple to need a 
computer or more than a few minutes thought. For 
North, this was more than enough preparation for the 
annual sales planning meeting; North liked to do most 
of his real planning during the group meetings 
themselves. He folded his notes into his pocket, then 
left his room to search for his old friend West. 

West knows that 80% of his region's sales volume 
come from 20% of his customers. He also knows that 
the economy is on an upswing, and his big customers 
are likely to increase their orders this year. He didn't 
spend much time looking at the handouts he had 
received. Instead, he prepared himself by looking over 
the summary reports on his top-20% clients. His own 
projections are based on the assumption that he can 
increase each major account's purchases by 20% in 1986 
over 1985. 
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/ General 
Dollar 
Percent 
No Decimal 
Decimal 
Scientific 
Bar Graph 

Number Of Decimals ... 

Align Left 3€F 
Align Center :igr; 
Align Righ t :l!:H 

Commas 
-----------· 

[olumn Width ... 

Wes tern Diuision 

West's estimates 

Building a Spreadsheet with Multiplan 

Here are the basic steps in developing any 
spreadsheet using Multiplan : 

Financia ls 

Open a new Multiplan file. Type the row labels in 
the first column. Use the Format menu's Column 
Widths option to make the first column wide enough to 
hold the w idest label. 

Use the mouse to return the cursor to the top of 
the second column and type the year: in this case, 1985. 
To help distinguish between this entry and other 
numbers on the spreadsheet (dollar values) use the 
Format menu's Align Center option for this entry. Enter 
1985's dollar values down column two, pressing the 
RETURN key after each entry until you reach the 
TOTAL row. 

To enter a formula for the 1985 TOTAL, position the 
cursor in the TOTAL row of column two. Type an equal 
sign , then type SUM(, then drag the cursor over the 

R8C2 @ =SUM(R[-6JC :R[-1 )C~ 

west ern Dluislon 
3 

t )l'.~~Hl!~.~~!.~ !(;J: .. .. . .. . '·· .. 1.~ ........... . 
M91'!¥ll.L ...................... : ......... !~7 .: . 

3 Account B · 142 ·-:" 

~;1r·:·:·::·::::-:::·.,:::.::·::::::::.::. :~-::.::: : ·::::: · ·:. :::1!.ii· 
;~r9.;tr: ~9~:~::::::: :: ::::: ::(m11mdlii)<;i::::::::: .. ::: :i 

. . 

The TOTAL formula 
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[ nn 1 Undo :•:z 
Cu t SCH 
Copy sec 
Paste scu 
Clear see 
Show Clipboard 
Pusl<i <111<1 l.ink .. , 
Unlink .. , 

llbsoh11 e flefenrnn• :•:1 

FIJI Right 
FIJI Down 
Sort... 

:!CR 
:!CD 

Financials 

figures in rows 2 through 7. As you do, a formula will 
appear in the TOTAL cell . Type a right parenthesis and 
press the RETURN key to complete the formula. 

As an alternative, you can use the Edit menu's 
Paste Function option to create the SUM formula. After 
entering any formula, you must always press the 
RETURN ketj rather than using the mouse to move to a 
new cell. If you don't press RETURN first, then the next 
cell you jump to will be added into the formula. 

Western Diuision 
I 3 

The TOTAL cell displays the results of the formula calculation 

After entering the TOTAL formula in column two 
and pressing RETURN, use the mouse to move to the 
top of the third column. Enter and center the year (1986) 
as you did in column two. 

West assumed that he could increase each major 
account's purchases by 20% in 1986 over 1985 figures. To 
create West's spreadsheet's formulas for projecting each 
account's 1985 figures: 

First, with the cursor in the second row of the 
third column, type an equal sign, then the number 1.2 
(i.e., 120%), then an asterisk (Multiplan's symbol for 
multiplication) then use the mouse to click row two, 
column two, and press RETURN. 

R2C3 @ =t .2•RCl-t l 

Formula for Account A 
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To duplicate the formula for Account A to the other 
accounts' rows, drag the cursor down column 3, rows 2 
through 7, then use the Edit menu to Fill Down. Press 
RETURN. 

Format Options Calculate 

Show Clipboord 
Pnst <! <111<1 link ... 

~'.? .. 
I.~ .. 
!!~ .. 

----·~ ~? . 
Pns1e Nnmr ... 
Paste Function ... 

:!CR 
,· I 

QQ •. 

Use the Fill Down option to replicate a formula dow n a column 

One way or another, it's a good idea to check your 
formulas whenever you build a spreadsheet for the first 
time. Click the mouse in any cell down column three to 
see that the formulas created by the Fill Down option 
have all been replicated correctly. You can check this 
also by visually verifying the results of the calculations . 

Use the File menu's Print option to print your 
spreadsheet out. Fin ally, you can Save the file or simply 
Quit the Multiplan program through the File menu. 
When you Quit, Multiplan will still offer you a chance 
to Save your file if you have not done so already. 

\llESTERN DISTRICT 1985 1986 
ACCO<.llt A 167 200.4 
Account B 142 170.4 
ACCO<.llt C 110 1392 
Account D 66 103.2 
ACCO<.llt E S3 63.6 
All othor Accoonls 142 170.4 
TOTAL 700 0472 

Printed report 
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EASTERN DISTRICT 1985 1986 
Industry To!Jl 7343 5700 
TAG To!Jl 2203 2784 
Share or Market 0 .300014 0 .32 
Eastern Total 490 619.22833 
Eastern Share(") 0.222424 0 .222424 

Financials 

West had just finished entering his calculations into 
the Macintosh when North knocked on his door. "Let's 
see if East wants to come with us" he suggested, as 
they headed off for the hotel lounge. 

East was the newest of all the regional managers, 
but he was no dummy. He had spent the last week 
"researching" the industry - calling some of his old 
school buddies who were working downtown, trying to 
figure out what the competition was doing. This 
morning he spent another hour on the phone line, this 
time with his Mac hooked up by modem to the biggest 
industry database in the country. He now had what he 
considered a pretty good assessment of the sales 
volume for the entire industry over the next year. He 
expected TAG to gain an additonal 2 points on their 
share of the whole market. The rest was simple. 

E11stern District 
1 2 3 

;.~rn~.!>.~TRP. ........ : !.~ .................... : J~?~ .. . 
!i)~~-~\~~. !.9M .. ............ :7ML ........... .......... :?.(9!1 ........ .. ...... ....... . 
T.~(i M~.1... ................ :n9.~ ..................... ... :7.~17. i.JO:: ~ R ( - J.IG 
?.~rr.~.rn.•rM ......... ... : 7.1!17.1.K:/~h?J\: ... ......... :9 .. ~~- · ······· ··· · ············ 
~~~!~rn.J:o\~!.. ........ ..... ; ~~-·. .. .. ............ . .... '.7Hl7.t. J.:;H J.•!<.H~ ..... . 
f~s.\~mP:!w.~.('i!'il... ...... : c.'ll7.1.11;:1.~1~.~J\:..... - r. -

East's formula and results 

North, West and East were well into the second 
round of jokes and anecdotes before South finally found 
them in the lounge. By far the most methodical, and 
usually the most optimistic of the crew, South spent 
almost all of his four hours playing with MacPaint on 
the Macintosh. It wasn't until the last twenty minutes 
that he got down to the business of actually projecting 
sales using Multiplan. His idea was simple enough, 
target sales to grow at a certain rate. 
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Formula ----1~iiiiF~;.F;.I;ii;·~'-I~T·1-~~1'-~~j)~.1 ~so~u~t~h~'s~P~ro~j~e~ct~lo~n~s~;;;;;;;;g 
I 2 3 4 5 6 7 8 

tl~li!".1~.~-=.. .. .. ...... . . ... .... ........ . 
' -~~-~.GRQ\V!l:l.~~K ................ . 

20.09.'lil : ... ....... ....... .. .. ........ .. ... ...... . . 
~~ .. . . .. . . ... :.. . ...... . . . . . ........ . . . . .. . . ... .. . ..... . . •• ... • . .. . .. 
1985 Sal<> . . . : I.~\ .Qtr .. . '2.~~ .9lr .... :~r.~.Qlr . .. :~.t.~ .Q!r .... : .... !.?~s .. : 
<t~:.;y~~4~1 . . . . . . . . . . . . . .. . . . . . . . . . ...... ... ..... ...... .. ..... ............. ... . 

1 E~.~\ .!~Q .. : ... .. !25 : 115 : 130 : .1~9 .. : .. . 
North .. ~Q : ... .. . . ~9. ::: ::::a?::: :: !Q4 .: .... .. m. .: . ........ . . 
s.oul~... 150 160 : .M? .. : ..... 171 : 630 : · ··:i'io: = . . 182 165 = ...... rnL 706 .... ... ... .. . 

. . . . . . . . . . . . . .. s~Q ... ..... 5~3 ..... ... 5!.L ... ... 5~L ... P.o3 .. : .. . 

: : : : ~ (~' :Qtr:: :: ~ ir;4:o~r .... : ~r4 .0~r .. .. : 4.t.~ :o~r: .. . : .... .1.~~9 .. :. . . . 

South's formula and results 

In South's spreadsheet, the formula for the 1986 
figures are based on the sales figures for the past year 
(entered in rows 7-10) and the targeted rate of growth 
(entered in row 3 column 1). When South enters the 
annual growth rate, the 1986 sales figures are 
automatically calculated for all districts (rows 16-19). 

At that afternoon's planning session, South's 
approach was accepted by all. They agreed to target 
sales to grow at an annual rate of 20% during 1986. 

ASSUMfO: TAG 1986 Soles Projections 
198S GRO;ITH AA IT 

Z0.0011 

ACTUAL: 
1985 Sales 1st Cllr 2nd Qtr 3rd Qtr 4th Qtr 198S 
(Thousands) 

East 120 125 115 130 490 
North 90 96 87 104 577 
South ISO 160 149 171 630 
\l/esl 170 182 165 189 706 
TOTAL 530 563 516 594 2203 

PROJECTED: 
1086 S•l~9' lot Otr 2nd Olr 3rd Olr 4th Olr 1966 
(Thousands) 

Eest 144 150 138 156 588 
North 108 115.2 104.4 124.8 452.4 
South 180 192 178.8 205.2 756 
\I/est 204 216.4 198 226.8 847.2 
TOTAL 636 675.6 619.2 712.8 2643.6 

Final spreadsheet 
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ASSUMED: 

Calculate Now 3€= 
.1Rutom11ttc ca1cu1at1on 

Iterate 
./Don't Iterate 

' I 

Set Completion Test 
si~ll't:1 Corn11IHHon re~t 

1985 GROWTH RATE 
0.2 
ACTUAL: 
1985 Sele! 
(Thousands) 

Eest 
North 
South 
West 
TOTAL 

PRQ.ECTED: 
1986 Seles 
(Thousands) 

Eest 
North 
South 
West 
TOTAL 

1st Otr 

120 
90 
150 
170 
-SUNCRHIC:R!-1 JC) 

1st Otr 

~l-9JC• ( hR3C1 l 
~l-9JC•(l+R3Cll 

~l-9JC•C1+R3C1) 
~l-9JC• (l+R3C1) 
•SUN(R!-4 IC :R!-1 JC) 

~:i•• 
Rll Cells 3€R 
Last Cell 
N<trne ... 

l.inl: ... 
~··-···--

Show Rcllue Cell :JCS 

mi[;lllj . illll' 

Oell>te Name ... ~ 

Financials 

Tips on Developing Complex Spreadsheets 

Here are some good rules of thumb which may 
save you a lot of time and trouble when you are 
developing your own large spreadsheets and "what-if" 
models. 

• Work under the Manual Calculation option 
of the Calculator menu while you are building the 
spreadsheet. Otherwise, under automatic calculation 
every formula on the spreadsheet will be recalculated 
immediately when you enter one new value. This can 
cause considerable delay when you are working on a 
large spreadsheet with a lot of formulas. Under Manual 
Calculation, you can make a lot of entries quickly, then 
use the Calculate menu to Calculate Now. 

• To condense large spreadsheets as much as 
possible, select No Decimals from the Format menu and 
set Column Widths as narrow as possible to accomodate 
entries. 

• Clearly separate the entered assumptions from 
the calculated values. One method is to put all your 
assumptions in the first column of the spreadsheet. For 
example, South's Sales Projections showed the assumed 
rate of growth in a cell of its own, rather than "hiding" 
it inside the formulas of rows 16-19. 

This not only makes it easy to see what all the 
assumed values are, it also makes it easy to see which 
formulas reference your assumptions: '1\ssumed" values 
which appear in formulas should be referenced as 
absolute addresses (e.g., R3C1) rather than relative addresses 
(e.g., R[-9]C). 

• Give frequently-referenced cells a Name for easy 
identification in formulas : when you select the Define 
Name option, Multiplan will find the most likely row or 
column heading as a name for the value(s) . You can 
keep this name, or change it to any name you like - a 
shorter verison, for instance. Names composed of more 
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than one word always use an underscore instead of a 
space to separate words. Once you give a cell or group 
of cells a name, you can use that name instead of cell 
addresses in formulas. 

"Named" Range 

ffiMC.~lt . . . .. . . .. . . . .. .. .. ..... : .. .. .. .. .. .. . .................... .. 
.t .~O.~ .S~JM .. .. .... ... , ............ : . . . .......................... . 
. <Thit<minds) ..... ..... ............. : . ... .. . .. ......................... : 
E~~~ . .. .. .. .. .. . . .................. : :ill 79.IC ~(1 ~.GRO'\IOJl .. .AA m .. .. : 
Nclr:U> ......... .... ....... . ....... : :i1l79JC~(1~.GRQWJJWlATEl .... : 
~~\h .......................... , .... : :i1l79.IC~( 1~.GRQWJ.l:UATEl .... : 
W~'-~ .......... .. .................. . : :ill 791C ~.< 1 :+:GRQWJli.JlA m ..... : 
TOTAL ' -SUH - 4 C:R -1 C : 

You ca n give cell a name and use that name in formu las 

• For spreadsheets which print as more than one 
page, use the Options menu to Set Page Breaks and 
logically group rows and columns on each page. For 
example, if you enter all your assumptions in column 
one, for example, you can Set Page Break after column 
two if you want to print out the results only, and not 
the assumptions themselves. 

• To print only part of the spreadsheet, mark the 
cells you wish to print before you use the File menu to 
select Print. The dialog box offers you the option to 
Print Selection Only. 

R13CI eE9J(CTEI>'. 

Quality: 

P11ge R11nge: 

Copies: 

Poper Feed: 

@ High 

@All 

D 
®Continuous 

181 Print Selettion Only 
~ 

O St anclarcl O Omit 

0 From: D To: 0 
0 Cut Sheet 

Dialog box lets you Print Selection Only 
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Profit & Loss Projection 

Projecting sales is just one part of the larger 
picture: projecting the net profit (or loss) for the 
company as a whole. For this, the projections made by 
the marketing group are combined with projected 
General & Adminstative (G&A) expenses. The essential 
difference between a Profit & Loss Statement and a P&L 
Projection lies in its purpose and use. 

Projections serve as a means of communicating 
between departments, or between top management and 
operations. They can serve as a plan to be followed, 
educating company employees as to what is to be done 
and assisting them in doing it. They can serve as a 
standard against which performance can be measured. 

Profit & Loss Projections are also a means for 
controlling the future expenses and income of a company 
if it is enforced as a strict guideline for managers in 
each responsible department. They can help extend the 
reach of top management by communicating downwards 
company objectives and activities, and guiding corporate 
operations. 

Since the sales managers were projecting sa les in 
dollars, the CFO had to answer an important question 
before h e could project gross profits: How many units 
will TAG need to manufacture - and what will be the 
cost of this production? In the case of TAG, the CFO 
developed cost figures based on volume ranges and 
projected seasonal variations in price. These costs were 
entered into the spreadsheet as formulas which "look 
up" the costs in a table. 

I llSSlM() 
,·~"t,11nr P~ci . 

3 1.98.~ .YRO"!'~H R II TE . 
9l./NHl.1Y~D.(QQQ) . 
\Jl'l!T.C.<!$.1 ........... ...... . 

Detailed Pin 
3 4 

100.: 
~ Iii. 

!==u I 5 c ZS 3 
it-0 00 !55 00 !50 00 H5 00 HO 00 

Cost of Goods Sold is determined by looking up the quantity 
sold in a cost table (Rows 4 & 5) 
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Cash Flow 

86 

Financials 

Of course, when the president gets this report 
along with a copy of the final disk files, he will test the 
figures against his own profit ratio expectations. With 
his Macintosh at hand, the president could see how 
much flexibility he could tolerate in the figures, rather 
than adopt his old "do or die" policy in targeting sales. 

RA TIO ANALYSIS 

Pr<>m 6. Loss (Tlloos1nos) AcllJll Projected 
1985 1986 

Net Sites 2203 264J From Mlrkellng Deparlmenl 
Cost of Goods Sold 096 1195 From CEO 

Gross Profit 1207 1446 
Sales Expenses 120 145 Usullly 1ox or Gross Prom 
G&.A ExpenSts 500 550 1011! lncr11st ..,.r lost yur 

Operating Profit 587 753 
Oll>er Expenses 47 50 Seme es last yHr. roooded 
Income Tu Provision 270 352 Al 5011! tax rote 

Net Profit 1n.r Tox1s 270 352 

Asstl5 114800 120900 From Belonc:o Sheol 
Tangible Net Worth 1400 1700 From Calonc:e Sheet 
Reltrn on Nol Worth 0.192013 0.206824 • Net Profit An er T ox I Ntl Worth 
Siias Margin 0 .122547 0.133031 • Net Prom Aner Tex I Net Siles 
Productivity of Asset. 0.008162 0 .009069 • Gro•s Income - T oxn I Asset. 

The president's formu las 

While the Profit and Loss Projections show 
expected income and expenses over time, the Profit and 
Loss Statement shows categories and amounts of income 
and expenses extending over the past years, months or 
quarters. Income and expense categories for your 
company may differ from the ones shown here, 
depending on the nature of your business and the 
recommendations of your accountant. 

The "common sense" definition of cash flow is the 
difference in the cash balances of a company on two 
dates. For example, if a company has a cash balance of 
$750,000 on December 31, 1983 and $900,000 on 
December 31, 1984, we can say that there was a net cash 
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inflow of $150,000. Changes in cash and other "working 
capital" components are often detailed in annual 
reports. Use Microsoft's Multiplan on the Macintosh to 
create the cash flow system shown here. 

TAG Sloltmonl of ChangtS In Finonciol Condition 

TAG Consolidated Statement or Changes In Financial Condition 
Vur Endod O.cambor 31 

-1965- -1966-

Sources of Working Capital 
Net Eernlngs $22,163 $27,669 
Deprecl1Uon Ind AmorUuUon 9,874 12.696 
Provision ror doftrrtd Income llxH - not 2.666 1.002 

Working Copita1 providod from CJllfr•tlons 34,945 41,569 
Proceeds rrom sole or common stock 5 ,203 5,361 
Common stock iuutd r ... CO<Mlrllbl• dobtnlur•• 2,192 2,425 
Oisposlions or prOj)erly. pl111l Ind equipment 2,942 2.064 
lncre1S1 in l0fl9·lerm nolos p1yobl1 0 40,655 
Increase In leeSI obligations 2.396 0 

Total sotrces or Working Capital 47,678 92,294 

Appllcellons or Wort.Ing Cepltal 
Additions lo properly. plant end equipmonl 40,771 65,089 
Payments on long-term nolr.i payable 6. leases 1,037 691 
Conversion er.cl redtmc>lion of debtnlilres 2.196 2,426 
Purchase or treasury stock 713 0 
Dividends poid 3.936 4,604 

Other - net 3.703 4,679 

52,358 77.091 
Increase (docr1u1) In Working Copilol Components 
Cash 6.062 -4.550 
Cerlificotts or Deposit -13,274 -11,520 
Marketable 5ec1rltles 4,309 3,910 
ACCOl.nls RecolVlbl• 14,066 26,287 

Inventories -3,234 41,511 

Pr91>1id 11epenses 4,105 866 
Notes payable lo banks -15,282 -10,103 
Convnerci1l paper 0 -6,300 
Current maturities or long-term notes payable -191 -437 
Accoools p1yabl1 ind accrued expenses -2.270 -24,574 
Income taxes payable 989 -469 

Net lncreeSI (decrease) In working capital -4.660 14,603 

Total Applications or Werling Capllol $47,670.00 $92,294 

Changes in Working Capital reported in Annual Report 
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Fi nancials 

It is a matter of debate as to whether certain 
operating data, such as "debt write-off" and "inventory 
on h and", should be included in a net cash flow 
statement. Three different definitions have been used for 

Nel lncom<1 $200 
Plus 0.procialion $200 ............ --........ ...................... m 

"TRADITl()(Al.. CASH Flo.I $400 

Plus Other E>q>tnHs nol affoding 
Werling C1pllll (Dererred Texes. etc.) $200 

Less other Raveooes nol 1ffecllng 
Werling C1pl11I (Equity E.-nings, etc.) CSIOO) 
r-:TTTFS ~ . ~ ·z= 
\l/all:.ING CAPITAL FRa1 a>ERA TIONS $500 

Less lncr11ses in Acc0U1ls Roceivlble ($ 1000) 
Less lncruse In Inventory ($1 000) 
Plus lncr1n;1 In Accounts P1y1bla $600 
Plus 1ncre1S1 In Accrued Llebllllles $400 ·-- --- . 
a>ERA TING CASH Flo.I •~oo 

Three views of Cash Flow 

"Net Cash Flow" totals. It's important to be specific 
about which method you are using when reporting from 
a cash flow summary statement. We have used the third 
method, identified as "Operating Cash Flow." 

You can create the year-end cash flow summary for 
your annual report by extracting the totals for each 
category from your monthly cash flow statements. 
Similarly, you can consolidate statements from a number 
of years to derive a Cash Flow History. 

Cash Flow Projection 

A Cash Flow Projection is essentially a table which 
shows when future income is expected and when 
payments are due out. If you have never projected cash 
flow, you may wonder why anyone would care to know 
exactly what their checking account balance would be 
on a particular day. There are at least three good 
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reasons for taking the time to project the cash flow for 
yourself or your company. 

First, if you can predict when you will have a high 
cash balance and how long the balance will remain 
h igh, you can manage your cash wisely by putting part 
of it in short-term interest-earning accounts such as 
Certificates of Deposit. Many companies follow this 
practice, "sweeping" funds from one account to another 
as often as daily. With extremely high balances, this 
practice can earn hundreds of thousands of dollars in 
interest. 

Second, if your income is based on an irregular 
sales pattern, you can use a cash flow projection to see 
exactly how soon you will need to close the next deal in 
order to keep up your regular overhead payments, or 
what volume of sales to target for the next period, or 
how much short-term borrowing will be needed. On the 
other hand, if you h ave had especially good sales this 
period, you can use the cash flow projection to see how 
long you can go on vacation. In either case, companies 
and individuals with irregular schedules of payments 
often rely on cash flow projections for planning. 

Finally, a monthly cash flow projection is a 
standard part of any business plan or loan application 
associated with starting up or expanding a business. 
Lenders want to know that you have thought about the 
future carefully and when you will break even. Even if 
you are going to fund a new business entirely from 
your own savings, you probably want to know exactly 
how long it will be before you will start earning profits . 

Cash Flow 
Item 

_ ... ,_. 

'84 _ ... __ 
--

'8S 
----
--

'86 
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....... .. ....... 
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::::: :::~87::::::::::: : : : 
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~Mt.<..:::: 
tt?U t t ootu t·:-: 

°'"""~"""':::: 
~OM.<---·:·: :o:u::;;:;:::::: 
(O~<~U'HH 1 :-:: 
{<O(>O~OUC(:o " !!:::: 

:-:-:-:-:-:·:·:·:·:.:·:-:-:-:-

Cash Flow Table from past Cash Flow Statements 
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Alternatively, you can project a Cash Flow based 
on past Profit & Loss Statements, but the Cash Flow 
Projections are usually shown monthly or weekly -
perhaps even daily - rather than quarterly or yearly. 
Also, some categories are more accurately projected 
using formulas rather than projecting absolute levels. 
For example: 

• "Payroll expenses" could be calculated as a 
percentage of "Gross wages" (usually 10-45%). 

• "Repairs and maintenance" could include an 
allowance painting and decorating which occurs 
periodically, but might not show up every year. 

• "Other" could include an allowance for the 
"unexpected", or could be calculated as a percentage of 
the total of all other "known" expenses. 

If you are a small business with more variable 
income and expenses, consider this daily tracking 
system. In addition to projecting routine monthly 
expenses, such as office rent and equipment lease 
payments, you can easily add unusual income or 
expenses by date under this system. 

Un II tied 
3 4 :; 

.. :: :: ~: :cA~tt :o~r: : ~: : :c:~stt : 1N .:: ~ ... . Nu... ... · · · · · · ·· ·· · · · · · ·· 
3 ----------------------------7:.-:: :.-.:::.-.:::.::::.::::.::7-----------------~:~~:~: .... .. rnm 

(~( ::~~:~~Qi~~1:~~~·~~~~np_et. · · ~ ... $.;~.~~-· ~ : : : : ~: : )$. :~~~~~: : ~: · · •· · · .. . · · ,! .• i,! ,; .. ,! .~.: 
ih : : : :~ii4iP..n;~i\~~i':~~y~~~·~, . · .... h'.~o:: : : : ::::::: :: : : : : ::: $.~:i::~~o:: : : : :: ·· "'''' 

1 W .. ..:P.~~rn\1 .. ..................... .. ~?Q.9!l9 .. ' ' ... $.!.!.~~ .. : ... ...... ....•...... .. rn:: 
w .... :~.~~r.ql.l.J.m~ .. ... ....... .. : ..... $it.09.0 .. : .. .... : .. ... $~,'/~ .. :. 
w .... :?~l.~~ .'' ......... '' .. .... .............. , .. ... :. '. ~9Q.QQQ . : . ' ' $.9~.~~Q .. :.' ' 
U~ .... :?~l.~~ ................ ....... . :... .. . . ... : ... ~9Q .QQQ .. : ... $.1?~.~~Q .. : 
W.~ .. :~.~~rn\1 .............. .... .... : ... ~?Q.QQQ .. : ..... ... ..... .. : ... ~4~.~~0 .. : .. 
i.m .. :!'.m.q1J. T.m~ ...... .. ..... . : .. .. . $it.®.0 .. ' ........ .. ..... : ... $4U~ .. ' .... . 
J.0.~. : !'!~!.11'.4~.~ ....... ........... : ..... $.U)Q9 .. : ...... ....... .. '··· ~4~.~~Q .. : .. ..... ... .. . 
l.0.~ .. :?.~~L ................. .... : ............... : ... ~9Q,OQQ .. : ... $.?~ .~~ .. : ..... ............. ....... . 
J.M . :!i!!rmt. ............ ······ ·'········ ···· ···'··· ··*·'·•?QQ .. : ... U~.!~9 .. : ............... :.... ., .. . 
J/itL~.~~L ............. ......... : ..... .... ...... : ... $.~Q.®.0 .. : .. $.1.0V~ .. : .. .. . 
Wf!. :?.~~L. .................... : ............. .. ' ... ~¥!.QQQ .. : .. H~.!~9 .. ' .. .... ............. ..... ..... 

m::.::=~i't~:~~~~~~~1 ::::::::i :::::::::::: : :::::: : :::im:i~: : :: : ::::::::::: : :: ::: ::::. im1: 
l :p 11 : . : 11 I 

Daily Cash Flow Tracking System 
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Balance Sheet 
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Here, lines are deleted from the top of the 
spreadsheet as they occur - i.e. , only the future is 
projected . New items are added in date sequence. 
Entries which repeat regularly, such as monthly rent, 
are moved from the top of the form to the bottom as 
they transpire. For example, when the rent is paid in 
October, the line projecting October's rent is modified to 
show November's rent and moved into sequence. 

Daily Cash Flow 
Date Desc IN OUT Balance 

Cash Flow Updating 

Move past lines 
into the future 
and change the 
date entries 

A Balance Sheet is statement of a company's or 
individual's financial condition at a single point in 
time - usually the end of a year or a quarter. The report 
is called a balance sheet because the first column must 
'balance" with the second column; i.e., the first 
column's total always equals the second column's total. 

A balance sheet may seem short and simple at first 
glance, but in fact it can be the most difficult to 
understand of all financial reports. Because balance 
sheets are used by banks and investors as a measure of 
a company's condition, they have sometimes been 
manipulated by clever accountants to make a company 
seem better off than it really is. The Securities and 
Exchange Commission sets stringent requirements for 
footnoting unusual items on the balance sheet in annual 
reports to stockholders. 
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The first part of a balance sheet shows all tangible 
"assets" - cash and resaleable property and equipment. 
The second part shows all claims against those assets -
current and long-term debt (liabilities) plus stockholders' 
equity. Assets and liabilities are each divided into short
term and long-term categories. 

Belll\Ce Sheet IS or December J 1. 1965 

ASSETS 
Cash 
Short-term Investments 
Rtctiwl>los 
SeetrlUIS 
Long-term lnveslmtnts 
Roel E51ale 
Equipment 
other As>ets 

TOT Al ASSETS 

Notes 

2 
3 
4 
5 
2.6 
2,6 

Assets portion of balance sheet 

5,701,000 
34,080,000 

6,163,000 
131,000 
250,000 

25,079.000 
1,097,000 

16,767,000 
89,288,000 

Short-term assets are those holdings which can 
easily be converted to cash, whereas long-term assets 
may take longer to sell. For example, stock which is 
publicly traded on the stock exchange is considered 
readily convertible to cash. On the other hand, stock 
held in your Uncle Jack's fertilizer delivery business may 
be harder to liquidate, unless other members of the 
family are willing to buy it from you. Furthermore, the 
exact value of an asset such as stock is harder to 
determine than the exact value of a debt. 

This distinction between long- and short-term is 
more straightforward for liabilities: Short-term liabilities 
are debts which must be paid within one year (12 
months), long-term liabilities are due more than one 
year from the date of the balance sheet. Some long-term 

LIABILITIES L STOCKHQ.OERS' EClJITY 
Paylllle to ~ns 
AcCO<.Wlts Peylblo L A=uod E__. 
ACCJ'Uld E~loyee Sllry L Benents 
LQn9-llrm Dobl 

TOT Al LIMILITIES 
Slodholdors' Equity: 

Corrrnon Slodt 
Rolelnod Ernlngs 
STOCKHQ.OERS' EClJITY 
TOT Al LIMILITIES L E<JJITY 

6 

7 

8 

Liability portion of balance sheet 
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16,599,000 
6,251,000 
4,131,000 
1,375,000 

32,356,000 

405,000 
24.171,000 
24,576,000 
89,288,000 
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debts will be identified on the balance sheet as "current 
long-term debt" - i.e., that portion of the long-term debt 
which is payable within the next twelve months. 

"Equity", for individuals, proprietorships and 
partnerships is often calculated as the difference 
between the value of your assets and your liabilities. In 
this case, it is usually called "net worth" and your 
balance sheet will balance by definition. For 
corporations which are not traded publicly, the value of 
the owners' stock may be a combination of actual cash 
contributions from investors and some imputed value 
assigned to the founders by vote of the stockholders. 

For publicly traded corporations, the valuation of 
stockholders' equity is more controlled: At the time of 
going public, the stock value of the company may be 
determined by taking some multiple of the tangible net 
worth . For example, a company with tangible net worth 
of $100,000 may decide that it is really worth $1,000,000 
(a multiple of 10), and thereby offer 100,000 shares of 
stock at $10. Once the stock is on the market, its actual 
value will rise or fall according to the price people are 
willing to pay for it. From that point on, stockholders' 
equity will be the sum of all monies received by the 
company from sale of stock, plus all assigned and 
unassigned treasury stock at par value, plus retained 
earnings (net profits after taxes which have been 
accumulated in previous years and not distributed as 
dividends). 

"Goodwill" may appear as an asset on a balance 
sheet in the case of selling a business, for instance, or 
determining the value of stock which h as not been 
traded on the open exchange. From the seller's point of 
view, goodwill is the intangible value which accrues 
from building a solid base of happy, loyal customers -
the residual, lasting effect of advertising and service 
quality. From the buyer's perspective, goodwill is a plug 
item on the balance sheet when you are paying more 
for the company than the assets are really worth. 
Goodwill as an asset has no value when a company 
goes bankrupt and sells all its tangible assets in auction. 
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Charting the Figures 

Financia ls 

You can use Microsoft's Chart to create graphs 
directly from information entered on a Multiplan 
spreadsheet. Detailed instructions for copying the data 
froip Multiplan to Chart are given in Chapter 1. 

400 
300 

100 
0 

1981 

Net Sales 

1982 1983 1984 

Chart derived from Mu/tip/an data 

1985 

Merging Tables with Text 

You can copy information entered on a Multiplan 
spreadsheet into MacWrite or Word. Simply select the 
area of the spreadsheet you wish to copy, the use the 
Edit menu to Copy the information onto the Clipboard. 
Quit Multiplan, open a MacWrite or Word file, and use 
the Edit menu to Paste the information into the text. 
Finally, select a type style and size the data before 
you set tabs to arrange the data in columns on the page. 

JJ._i..., ..J ... 'i .... J? .... 1_, ..J .... ..J •.• -1?~1-• ... L • ...J • .• .J.1.;& .... L . .. 1_ •.. l~•-·' ··;k·•-'-• lf. ... 1 •• .1 ...... 1 ... .. 1~ 
~ ~ 0 6 lines/ Inch ~ §} EJ ~ ~ ~ ~ ,,;_, 

8olonce Sheet os of December 3 1, 1985 

ASSETS Notes 

·::i~!· .. :;: 
•: 

Cosh 5,701 ,000 
Short-term Investments 2 34,080,000 .,~:. 
Receivables 3 6, 163,000 I ~;': 

Set tabs in MacWrite to arrange M u/t ip /an data in columns 
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Spreadsheets and Databases 

You can copy information entered on a Multiplan 
spreadsheet into a database or file program such as 
Microsoft File. Select the area of the spreadsheet you 
wish to copy, then use the Edit menu to Copy the 
information onto the Clipboard. Quit Multiplan, open a 
File file, and set up a form which provides a field for 
each column of copied data. Be sure to identify fields as 
text or number fields. Finally, use the Edit menu to 
Paste the information into the datafile. 

Values which were calculated by formulas entered 
on the spreadsheet will be copied into the database as 
numeric values only. You can create new fields to 
calculate these values if your file program allows 
formulas. 

Similarly, you can copy records from a database 
into rows on a spreadsheet. Values which were 
calculated by formulas entered in the database will be 
copied into the spreadsheet as numeric values only. You 
can re-create the formulas to calculate these values if 
you wish. 

A Note About SYLK Files 

You may have noticed that when you Save a file 
using Microsoft's Multiplan (and other Microsoft 
products) the dialog box offers the option of saving the 
file in either Normal or SYLK format. 

SYLK format is a "standard" format which 
Microsoft has developed in order to convert files from 
one program to another: Mu/tiplan files to Word files, for 
example. Since the Macintosh version of these programs 
handles the conversion for you, you don't have to be 
concerned about SYLK formats for working on your 
own machine. 

95 



MAC AT WORK 

Saue document as 

Sm•e 

ONormal 

Cancel 

@SYLK 
lit 

MultiPlan ... 

Eject 

Driue 

Dialog box shows SYLK option 

Financials 

The SYLK format would, however, be required if 
you wish to transfer your Multiplan (or Word) files from 
your Macintosh to an IBM PC, for example, over the 
phone lines. Multiplan files which are saved in "normal" 
Macintosh format cannot be used by the IBM PC 
version of Multiplan; SYLK format Multiplan files, on the 
other hand, can be telecomrnunicated from your 
Macintosh and used by most Microsoft products on 
many other machines. 

If you are interested in seeing what a SYLK file 
looks like, try saving one of your Multiplan files in 
SYLK format. A SYLK file is stored as ASCII characters; 
you can view the SYLK file using MacWrite or any other 
word processing program. 
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Chapter 
5 Text 

~ 
MacWrite 

-

~ 
l Word 

-

Even in this day of electronic communications, 
most of us still conduct our businesses on paper. 
Contracts, reports, memos and letters are an integral 
part of daily business. The printed page is vital and 
your business can benefit from producing high-quality 
letters as much as it does by producing high-quality 
products or services. Whether you use an ImageWriter 
printer with dot matrix printing, a character printer with 
"letter quality" printing, or a LaserWriter with almost 
"typeset quality" output, you can produce beautiful 
printed copy with your Macintosh. 

We have selected the examples in this chapter 
because they are common to most businesses and 
because they each illustrate different formats. We start 
with a simple memo, then we produce a letter with an 
envelope, then we produce a series of form letters -
each with the same text but a different addressee. 
Finally, we look at the various formats you can use to 
prepare resumes and reports. 

It's easy to produce these and other business 
documents using the tools demonstrated this chapter: 
MacWrite and Microsoft Word. 

The format of a document is, essentially, the 
arrangement of the words on the page. For instance, a 
typical letter might be formatted "flush left" and 
"ragged right". This means that the left margin of the 
text is straight and the right margin is uneven, but 
within a right margin setting. If the text is "justified", 
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Memos 

Text 

rather than ragged right, then all lines end at the right 
margin setting precisely . 

.. ~.L •.. .1 ... • .. 1 ...• .. .J.~ •... 1 ... • .. .1 .. , .. 1 ... .. . .J.~ •.. 1 ... •... 1.. •... 1 .. • . .J.'-1. .. 1 ...• .. .1 .•. . 1 ...• . .J.~ •.. .J ... • l:;;·• ... 1 .... .. .J.~ •... 1 .... . .1 ...• .. L • .. J 
~~ 0611nes/i nc11 ~ ~ (3 ~~~~ 

Single-spaced 

Space-and-a-half 

Double- spaced 

Basic format options 

Justified margins 

Flush-right, ragged left 

Centered lines 

Flush-left, ragged right 

Since each paragraph can have a format of its own, 
and since most documents are constructed of more than 
one paragraph, more than one format may be defined 
within a document. You will find that the tools used in 
this chapter make it easy to set up and change 
paragraph formats as you go along. 

Of course, there's more to a document than the 
format- namely the content. Unfortunately, this chapter 
does not show you how to write, except to remind you 
of the "seven virtues of good business letters": they 
should be short, neat, clear, direct, sincere, grammatical, 
and forceful. 

The typical memo uses the simplest format of all 
document types. To produce the one shown here, 
simply use the "default" format, i.e., the format which 
MacWrite or Word provides for you until you select a 
different one. The default format for these and most 
other text processing tools is: flush left, ragged right, 
with approximately one-inch margins. 
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New 
OtH~n ... 
Close 
Saue 
Saue Rs ... 
Page Setup ... 

()Ult 

Text 

-~-'-· -J-.~·--·-1!'~1 ...• _J __ , __ 1-. .. .1~ •.. 1 ...•.. .1 ...•... 1-.•. -1.1 .. I . ... J... •.•. 1_ ... ..1.~ •... 1 .... i-·- l-.... 1.~ .... 1 ... ... L. . ... 1_ .•... . '\} 
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MEMO 

DATE: October 2, 1965 

TO: All Regionol Sol es t1onogers 

FROt1: J .B. Morless, President 

Attached you will find prel iminer y f igur es f or 1965 sol es. You moy f ind 

these useful in preporing for the soles plonning meetings next week. 
lnevitobly, there will be some of you who ore uncertain obout the 
rornifi cotions of 

A memo with ruler l ine shows MacWrite's intitial format 

Four steps are required to produce this memo: 
open a new MacWrite file, type the memo, print it out, 
and exit or (optionally) save the file. These steps are 
summarized here for MacWrite; the same basic steps 
apply for Word, though the menu titles may differ. 

Open a new file and start typing as you would on 
a typewriter except you don't have to press the RETURN 
(i.e. , carriage return) key at the end of every line. 
MacWrite automatically fits the text within the margins. 
Press the RETURN key at the end of each paragraph, or 
whenever you want to end a short line. 

To print the memo, select Print from the File 
menu. (For longer documents, it's a good idea to Save 
your file periodically while you work, especially before 
printing the document) . A dialog box lets you set the 
print quality (high, standard, or draft), p age range, 
number of copies, and paper type (continuous feed or 
cut sheets). 

l mageWriter (Standard or Wide) (CE: ] 
Quality: 0 High ®Standard 0 Orort 

Page Rang e: ® All O From: 0 To: D ( Cancel ) 

Copies: LJ 
Paper Feed: ® Continuous 0 Cut Sheet 

Print dia log box 
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Envelopes 

Text 

For this particular memo and other simple, one
page documents, no particular settings or selections are 
required. Be sure the printer is ON and the paper is 
inserted properly before you click OK. MacWrite expects 
the top edge of the paper to be just covered by the 
paper guard mechanism on the printer (the bar with 
black rollers). The text automatically prints out with 1 
1/4- inch margins, unless you have specified otherwise 
by adjusting the margins on the ruler line . 

To produce a single letter with an envelope (as 
opposed to a series of form letters), use this simple 
technique: type the letter as the first page(s) of the file, 
type the envelope address as the last page of the file. 

Addresses normally appear in the middle of an 8 
1/z-inch wide envelope, so before typing the address set 
a tab a few inches to the right of the left margin. The 
tab settings appear as triangles on MacWrite's ruler line. 
MacWrite places one for you automatically at the 5 
1/2-inch mark. You can move this to another position by 
positioning the mouse pointer over it and holding the 
mouse button as you drag the mouse to the new 
position - for example, the 4-inch mark on the ruler 
line - then release the mouse button. (You can get 
more tabs from the boxes at the lower left on the ruler 
line: plain trangles are flush-left tabs, trangles with dots 
inside are decimal tabs.) 

.. ~ . .L • .. .L • .. .1-•• .1.?._.1 ...•... l... •... 1 ...•• .1.~ .......... 1... . ......... ,!;;'1 ... 1 •.•... L. . ... 1 ...•. J.!5 •... 1 •.•.• 1... •.•. 1.. •• • ..19 ...... ... .1 ...•... 1.. . • .. 1 
~~ 0611nes/1ncn ~~El ~~~~ 

Ruler line shows tab positioned at the 4-inch mark 

Next, position the cursor at the end of the text of 
the memo (or letter) and use the Format menu to Insert 
Page Break. Then type the address, pressing the TAB 
key at the beginning of each new line. 

102 



M AC AT WORK 

1- I 

Letterhead and Logos 

Letter/ Enuelope 

Mr. Horold Winkler 
TAG, Inc. 

43 Li nebough Blvd. 
Tompo, FL 33624 

Envelope address on second page 

Text 

When you go to Print from the File menu, be sure 
to select Cut Sheets, rather than continuous feed paper. 
This way, the printer pauses after printing the first sheet 
of paper (the memo or letter) and asks you to insert the 
second sheet (the envelope) before continuing to print. 
The first time you print an envelope, the address may 
appear too high, too low, too far left, or right. Develop 
your own standards for positioning the tab on the ruler 
line and for positioning the envelope in the printer. 

As normal procedure, you could print a second 
copy of the letter itself (not the envelope) for your own 
files, then modify this same file to produce your next 
letter. In other words, save a printed copy of the letter 
for reference and re-use the same file on the disk to 
produce other letters . This way, the file is always saved 
under the name "Letter/Envelope" and you keep your 
disk free of unnecessary files. 

If you are using your own pre-printed letterhead 
stationery, you may need to skip a few lines at the top 
of each letter file to allow space for your letterhead and 
logo on the paper. It's a better idea to start with a few 
blank lines in the fil e than to simply position the print 
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head below your logo when positioning the paper in 
the printer, especially i£ your letter is longer than one 
page. 

If you are not using letterhead stationery, you can 
type your company name and address as part of the file 
to be printed. You can even design your logo using 
MacPaint or MacDraw and paste in into your letter file. 
To do this, first create your full letterhead with logo and 
company name and address using MacPaint or MacDraw. 
While still in MacPaint or MacDraw, use the Edit menu 
to Copy the entire letterhead design into the clipboard. 

Then Quit MacPaint or MacDraw and open a 
MacWrite or Word file - either a new file or a letter 
which you have already typed. (If you are using a 
single disk drive, you may need to change disks during 
this process, but the Macintosh operating system copies 
the clipboard from one disk to the next for you.) Once 
in your text file, position the cursor at the top of the file 
and use the Edit menu to Paste the letterhead design 
from the clipboard to the top of your letter file. 

··~- '- •. . L •.. 1_ •. J.? ... 1 •.• -.l ...•... i ...• . _[} • ... 1 ...•. _L. •... 1_ •. ,!;;1 .. 1 ...• _.1 _ .•.. J _ .• ... l.~ •... 1_ .•. .J •.•... 1.~-J§._1_._L . ..i_._l 
~ GEi D 6 11nes11nch l~l l 11 I 1~1 1 11 11 I 

l Yl\GJ 
The Aettvtty Group Corporati1111 l 
999 Mark•t Strut, Sui If BIL -1 
Los Anaelu. CA 90011. ~I 

MEMO 

DATE: October 2, 1985 

TO: All Regi onal Sales Managers 

FROM: J B Morless, Presiden t 

Attached you w ill f ind preliminary figures for 1985 sales. Vou may find 
these useful in prepari~ for the sal es planning meelinqs nex t week. 

Letterhead on screen 

The letterhead here - or any other drawing pasted 
from MacPaint or MacDraw into MacWrite- is a single 
object, like a letter of the alphabet: you can select the 
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Form Letters 

Text 

whole thing with a single click of the mouse, and cut it 
or copy it to other locations in the text, and you can 
move it left or right by adjusting the margins. In 
MacWrite (but not Word) you can even re-size the object 
using the same techniques as in MacPaint or MacDraw. 
You cannot, however change individual words or 
characters within text which has been pasted from a 
drawing program into a text file. 

Form letters were once easily recognized as 
photocopied "standard" letters, often with the 
addressee's name and address typed directly onto the 
photocopy. As soon as you opened one of these you 
realized that a) you were one of many people who were 
getting the same message, and b) it was either a 
rejection notice or a request for money. 

With the advent of the microcomputer, growing 
volumes of form letters are now "personalized": the 
entire letter is printed as an original, including your 
name and address. Now when you open your mail you 
may not realize, at first, that the letter you are reading· 
is being read by hundreds of oth ers. What this means 
for businesses who use form letters is that your message 
stands a much higher chance of being read by your 
audience. 

Ideally, you are printing your form letters onto 
continuous-form paper, which can be pre-printed with 
your logo and company address. Many office-supply 
outlets now offer this service. Alternatively, you can use 
an automatic feeder for individual sheets of stationery. 
In the worst case, you will need to Print using Single 
Sheets, and stand by during the printing process to 
insert each new sheet, clicking OK to print each letter. 

Similarly, you can print a series of envelopes easily 
if they are designed for continuous feed, or you can 
print a continuous stream of addresses on mailing 
labels. Otherwise, you need to position each envelope 
in the printer as called for. 
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of Letter 
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\/ 
Series 
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Letters 

Text 

Unfortunately, at the time of this writing MacWrite 
alone cannot automatically produce form letters by 
merging a letter file with a series of names and 
addresses. If MacWrite is the only text program you 
have, you can still produce a series of letters in this 
make-shift manner: type the letter with the first 
addressee's name and address, then print it, change the 
name and address, print again, etc. This technique is 
labor-intensive (compared to any automatic merge 
process) and the list of names is not saved for re-use. 

In order to be able to produce a series of letters 
automatically, you need to purchase a different text 
program, such as Word, or a list-handling program 
which works in conjunction with MacWrite, such as 
MegaMerge. Here in this chapter we look at the steps 
involved in printing a series of addresses with Word. 

Word is a text processing program which includes 
merge capabilities. That is, you can create both your list 
of adresses and your form letter, and print out the 
series of letters using Word alone. 

Two different files are involved in producing a 
series of form letters : one file contains the text of the 
letter itself, and another file contains all the names and 
addresses to which the letter will be sent. 

First, prepare the file that contains all the names 
and addresses. On the first line of the file, type a list of 
all the fields which appear in each record. Each field 
should be separated by a comma or a tab. Remember 
that a record is simply all the information pertaining to 
a single addressee, for example: 

first name, last name, company name, street address, 
suite number, city, state and zip. 

Type each name/address record on a line of its own. Set 
margin s wide enough to accommodate the longest 
record, and press the RETURN key at the end of each 
record . 
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Separate each field of the address w ith a comma. 
Include a comma or tab for every field, even if some of 
the records do not have information for every field. If 
any field must have a comma within it (e.g. , "Fun 
Things, Inc"), the entire field must be framed in 
quotation marks. 

Customer Moi lin 

LAST NAME,FIRST NAME,COMPANY,ADDRESS,CITY,ST,ZIP,PHONE 
Aikens,Lisa,Aikenwood Leisure, 1681 Kirk Street,Dallas,TX, 90009,(8 17)976-8 
Wong,Simon,Chee Lee Games,234 Stockton St.,Tampa,FL,33624,(813)82 1-95 1•. 

Smaucombe,Debra,Debra°S Dolls Limited. 4129 Pachecho Blvd .,san Rose.CA, 93 :rn:· 
Nelson, William.For Kids Only,685 Market Blvd.,Nashv111e,TN,69345.(615)445 
McClave,Jimmy,"Fun Things, lnc.",7665 Church Street,santa Cruz,CA,98345,(4 
Granados,Aura,GameTime,234 67th Street,Front Royal,VA,63489,(703)674-9 '" 
Nasra,Elias,Gladstone Garnes,354 So. Hill Blvd.,Gary,IN,87652,(317)843-1010 
Langley,Rooort,Langley Games & Toys,4567 Stout Way,Bethesda,MD,20016,( 
·································································································································· ......................... . ...................... ............................... .................................................................... ........................... . 

List of addressees must follow strict rules in order to be used to 
print mailing labels or form letters 

In order to print out a series of mailing labels or 
form letters, a second file must be created in addition to 
the list of addressees. This second file contains the letter 
or defines how the addresses are to be printed . For 
example, a file which prints mailing labels should look 
something like this : 

,J)A TA Customer Mailing,, 

«FIRST NAME» «LAST NAME» 
«COMPANY» 
<<ADDRESS» 
·<CITY», «ST» «ZIP,, 
<<NEXT» 

«FIRST NAME» «LAST NAME» 
<<COMPANY» 
<<ADDRESS,, 
«CITY», «ST» «ZIP» 
«NEXT» 

L11bels 

':!!! 

«FIRST NAME» «LAST NAME» :;~. 
«UJMPANY,. Fn-1 
~rmi:11;~~. M 

Mailing label print file 

107 



MAC AT WORK 

New :!CN 
Open... 3€0 
Close :icw 
saue :ics 
Soue Rs ... 
Page Setup ... 
Print.. . 3€P 

Printer Setup ... 
Ou it 31:0 

Report Formats 

As you can see, each element of the address is 
listed by name and framed in special brackets. The 
opening bracket is created by pressing the Option 
and Backslash keys simultaneously. The closing 

Text 

bracket is created by pressing the Option, Backslash 
and Shift keys simultaneously. A file to print a series of 
form letters through Word should look something like 
this: 

~[ 

«DAT A Customer Mailing» 

November !st. 1935 

«FIRST NAME>> «LAST NAME» 
«COMP/',NY,, 
«ADDRESS» 
«CITY», «ST» «ZIP» 

Dear «FIRST NAME». 

Form Letter 

~~ ., 
As one of our top $ales -:>uUets, we want you to look far beyond ~ 
the boundaries oi «CITY,, to the vision of our national marketing I IO 

Pege I ]Q_T T tr· '"'''H'ii''':b~f-:7 · ,,.,,,l%~: :1d%%:\tii\iff1i'i~::::Wi!:i'' ''W!iH~:) ]Q QJ 

Form letter print file 

To print a series of letters or address labels with 
Word, use the File Menu to Print Merge from a file 
which has been prepared with field names in brackets, 
such as the one shown above. With Word you can insert 
special instructions in any print file - allowing you to 
add personalized salutations or closing for each letter, 
for example, or to select the addresses you want to use. 

You can also use the merge feature to print your 
mailing list on plain paper, easy reference as a phone 
list (if your file includes phone numbers), or as a 
membership list for your club or association. For other 
applications of merge-printed lists, see Chapter 7. 

If memos and letters are all you ever produce, you 
probably don't need to know anything more about 
formatting than that MacWrite and Word will do it all for 
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'As an editor for a publishing 
company, I receive large 
quantities of mail that I must 
go through quickly. With the 
emergence of Mac documents, 
the look of proposals has 
changed. Now I not only 
spend my time reading, but I 
am also entertained by 
pictures and other graphics." 
-Amanda Hixson 

Addison-Wesley Publishing 

Text 

you. However, if you need to produce longer documents 
here are a few more tricks to make the process simple, 
and the finished product more pleasing. 

A simple series of paragraphs is very easy to type. 
Complex formats are too time-consuming to produce 
using conventional typewriters. This may be why this 
unexciting format has turned up in so many business 
documents. 

However, documents which are quick in production 
often make for rather slow reading compared to those 
which use changing type styles and paragraph formats 
to show emphasis and to distinguish between levels of 
content. With computerized text processing, new 
formats are developing which make reading or 
referencing a document easy. 

The quickest way to dress up a dry format is to 
take advantage of the wide variety of type styles 
available with the Macintosh technology, but don't go 
w ild using every font available. For business documents, 
it's a good idea. to stick to one type style thoughout the 
text, varying size to distinguish between heading levels. 
If you include graphics, follow the common practice of 
using a different type style in the illustrations and figure 
titles from the one you use in the text itself. 

In addition to varying type sizes, you can vary 
paragraph formats to make it easy for the report. People 
who don't have time to read the entire document will 
appreciate being able to skim for summary sentences 
throughout . 

With MacWrite, paragraph formats are set by 
adjusting the margins and tab settings along the ruler 
line. In setting up standards for common documents 
like letters or monthly sales summaries, stick to a single 
ruler line which includes all the tabs you need for the 
document. For longer, more complex documents, use 
the Format menu's Insert Ruler option whenever you 
change to a new format within the text. 
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Undo Typing 31:2 

[Ut ;o;l) 
( opy :•:C 
P11sfe :•:ll 
[ !rnr :•:!! 
Show Clipboard 
Show Glossary 

I I • 

Show 'II 3!:Y 
Preferences ... 

Text 
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MacWrite's ruler line symbols 

MacWrite's ruler line also lets you set paragraph 
indentation, select single, 1 1/2, or double spacing 
between lines, and set paragraph lines to be flush-left, 
flush-right, centered, or justified (i.e., flush-left and 
flush-right). 

The version of MacWrite released in early 1985 (ask 
your dealer for your free u pgrade if you have the earlier 
version!) lets you select 6 lines p er inch for printing on 
forms or labels which expect this conventional measure. 
If you do not select this option, the number of lines per 
inch will depend on the style and size of type you 
select. If you do select this option, you will need to 
select type sizes of 12 points or less; otherwise, lines of 
large type will write over each other (and you can see 
this on the screen when you make this selection) . 

Word offers a greater number of options than 
MacWrite for defining the format of your document. This 
makes Word more truly a writer's tool, but the tradeoff 
is that Word is more difficult to learn at first. 

~o 13 14 15 

Word's ruler line 

Like MacWrite, Word uses a ruler line which you can 
view by selecting Show Ruler from the Edit menu. You 
can set tabs along this ruler line by first selecting Tabs 
from the Paragraph menu, then selecting options in a 
dialog box. Here you have not only flush-left and 
decimal tabs, but also center and flush-right tabs. Word 
also offers the option of creating a tab leader, i.e., a 
dotted line, dashed line, or solid line preceding every 
tabbed entry. Finally, you set the tab by specifying its 
position in inches along the ruler line. 
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2 
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.......... 
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Tabs 

r Allgnment-, r Leoder-, ~ 
+@ Left @ Bionic 
i O Center O ......... Cancel 
1- Q Right 0 ----- Position: 
i · 0 Decimal 0- 1~ .s · I 

Word's tab options 

In addition to using the ruler line and tab settings, 
you can use Word's Paragraph menu to set spacing 
between lines and to position the text on the left, right, 
centered, or justified. The Formats option is used to 
specify line indentation, to set extra space before or 
after a paragraph, to keep lines of a paragraph together 
on a page, and to set a fixed line height. 

One of the miraculous advantages of producing 
documents on a computer, rather that a typewriter, is 
that you can create running headers and footers which 
appear on every page. Use of headers and footers is 
especially appropriate in producing reports, so readers ,,.., 
can easily see what section they are reading or skip to 
one particular section. 

With MacWrite, headers and footers are entered 
through the Format menu's Open Header and Open 
Footer options. You can enter more than one line of text 
for your headers or footers. 

MacWrite header entry 
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Complex Formats 

Text 

Word lets you enter a header under the 
Document menu's Running Head submenu of options. 
You can specify whether this running head appears at 
the top or bottom of the page, whether it prints on the 
first page, and whether it prints on odd or even pages 
only. 

Running Head ( OK ~ 
,_oc:c:urs on ( Cancel ) 

fZJ Odd Pag~ rPosition-
fZ] Ellen Pages 1~Top 
O First Page Ci Bottom 

Entering a header through Word 

If you work frequently with long documents or 
complex formats you have probably developed your own 
system for making the production process simple and 
efficient. Here we offer some tips collected from 
professional writers and word processing experts. 

• Sometimes it is easiest to type all the text first, and 
do all the formatting afterwards. What this means in 
practice is that you spend the first part of the job 
working only on the keyboard, the second part working 
mainly with the mouse. This approach is especially 
handy if you are dividing the work between two 
people: a high-speed typist (who may know the 
keyboard but doesn't know the text processing package 
you are using) and a format specialist (who is familiar 
with the capabilities of a complex program like Word). 

When working by this method, after the words 
have been typed you can globally change the entire 
document to the most common format first, then work 
on exceptions. In addition to formatting, this second 
stage could include copying other files from MacPaint, 
MacDraw, Multiplan, MacProject, etc. 

112 



MAC AT WORK 

Resumes 

Text 

• In producing a very long document, you may need 
to divide it into small sections which you save as 
individual files. Early versions of MacWrite limited the 
size of each text file to no more than eight pages, and 
Word files were similarly limited by the size of your 
Macintosh's memory. Later versions of these programs 
take advantage of larger memory and extra space on 
your disk, allowing you to create longer files. 
Nevertheless, it's a good idea to keep your text files 
small whenever possible. When you print any text file, 
these programs create a duplicate called a print file on 
the disk. In other words, you will always need to have 
free space on your disk equivalent to the size of the 
largest file you are printing from the disk . (This 
limitation is not so signficant if you are working with a 
hard disk.) 

Finally, the example of a resume illustrates working 
with some unusual paragraph formats. A well-arranged 
resume is easy to read. The format you choose depends 
upon the amount and type of information you are 
presenting as well as on presentation . 

- -
-

- -

Resume formats 
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Printing Options 

Text 

The recommended practice is to limit your resume 
to one or two pages. It is also a good idea to leave lots 
of "white space". The general rule which derives from 
these two conflicting aims is that it is better to cut 
words and be succinct, rather that cram one page from 
margin to margin with long descriptions of your 
qualifications. 

Some employment agents recommend that you 
print your resume on a high-quality character printer 
such as a daisy wheel printer, rather than on a dot
matrix printer such as the ImageWriter. On the other 
hand, with an ImageWriter you can select different sizes 
and styles of type for different sections of your resume. 
Use a LaserWriter if you have access to one. Select only 
one type style and stick with it throughout; use italics 
and bold sparingly (only in section headings, for 
instance). 

The type of printer you are using can affect your 
decisions about how to format and produce your 
documents. For example, if you are using an 
ImageWriter dot matrix printer, you will probably want 
to print all final copies using the high resolution option. 
If the dot-matrix look of ImageWriter printout is still too 
informal for your business, you can hook your Mac up 
to a letter quality printer. 

Letter quality printers offer standard typewriter 
fonts, and they cannot print out graphics. These printers 
can use carbon ribbons and produce crisper, darker 
letters than the ImageWriter with a fabric ribbon. These 
printers generally require an additional software 
program - a printer driver, which converts the Mac's bit
mapped characters into the more traditional ASCII 
codes. Some of these programs include additional 
features, such as the ability to queue several documents 
for printing sequentially one after another. Also, some 
letter quality printers can be used with Word without 
additional software. Check with your dealer before you 
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buy a letter quality printer to find out if you need 
additional software. 

A LaserWriter printer offers the best of both 

Text 

worlds: high quality printing as well as graphics and 
different type styles. The only drawback of laser printers 
is their price, though this is offset by the fact that you 
can hook many Macs up to one LaserWriter for 
simultaneous use. If your office can afford it, it's well 
worth the investment for the quality of output. 

Merging Text with Other Files 

As mentioned briefly in this chapter, using the 
Macintosh you can create graphic images, such as a 
logo, using MacPaint or MacDraw, then copy that image 
into a MacWrite or Word file to create your own 
letterhead. You can also copy from MacProject, Chart and 
Multiplan into MacWrite or Word. Tabular information 
from MncWrite or Word can be pasted into a Multiplan 
spreadsheet. Examples of merging text with tables of 
figures, charts and diagrams are included in the 
chapters which discuss each of these other programs. 
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6 Forms 

-

Perhaps the business document that most often 
comes to mind when we say "paperwork" is the blank 
form that inevitably must get filled out. Forms, however, 
serve a very important function in daily business . 
operations. They are simply an organized format for 
gathering information needed to run the business 
efficiently. 

The Macintosh lets you design forms that suit your 
need, either to create forms that never existed or to 
modify an old form that your business has long since 
outgrown. Using MacDraw you can produce your own 
customized forms. 

These forms may be printed out as blanks and 
filled in by hand, or they may be filled in on the screen 
and printed out. For example, as an alternative to a cash 
register, you might use your Mac at the front counter of 
your store to produce an invoice every time a sale is 
made. Or, baseµ on an insight discovered by flow 
charting some internal office procedure, you might 
create a new form that will easily track a part of your 
inventory that was previously lumped in the 
"Miscellaneous" category. 

Whether you have a LaserWriter printer with 
several Macs attached to it or one Mac with an 
ImageWriter printer, you can use completed forms as a 
source for typing input to your spreadsheet or database 
files . (See also Chapter 7, Lists, for automated 
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Forms 

processing examples). From inventory to invoicing, 
forms can help you run your business more efficiently. 

Forms created using MacDraw can include your logo 
or trademarks and use a greater selection of type styles 
than allowed by MacWrite or Word. 

-~i.~1 
ToyTech 

Logo Examples 

In designing any form, first ask yourself: what is 
the final size desired? While it is possible to reduce or 
enlarge a form after it has been designed, it can be 
time-consuming if you have to re-size all your type style 
selections. 

In selecting a form size, ask yourself how you will 
be u sing the form. If, for example, you want to 
photocopy the form and fill it in by hand, then fit the 
form to your printed paper - usually 8 1/2" X 11''. 

If you want speedy on-screen entry for each 
transaction, then design the form such that the entry 
area is confined to one 6 1/i" X 3 1/i" area on the 
form- the area visible on the screen. The rest of the 
page can include a promotion for your store, conditions 
of warranty, or terms of sale. 

If you want to use windowed envelopes to mail 
copies of this form to your customer, position your 
company address and the customer's address to match 
the position of the w indows in the envelope. 
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If you want to take the "master" printout of your 
blank form to a printer or copy shop for reproduction, 
you can save printing costs by printing more than one 
form on a single sheet. For example, you can make the 
form 8 1/i'' X 5 1/2" and fit two forms on each 8 1/2" X 11" 
sheet. Most printers have paper cutters which can slice 
all the pages in half for you. 

With MacDraw you needn't be limited by the 
conservative tradition of pre-printed universal forms. 
Your customized forms can include artistic touches 
consistent with the style of your business. 

ToyTech 

Quanttty Item 

7 Spac;-- Street 
Pleasant Valley, CA 

Unit Price 

Dale , Page 

Total 

THANK YOU! 
Subtotal 1-----1 

Tax 

TOTAL 

ToyTech Invo ice 
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Creating a Form 

Recluce 
f: nl<tqJ<i 

Turn lirlcl On 
Hlcle Grlcl Lines 

Show Size 
Hlcle Poge Breoks 
Drawing Size ... 

Forms 

To create a form with MacDraw on the Macintosh, 
open a new MacDraw file and use the Layout menu to 
Reduce to Fit. This gives you a view of the entire 8 X 10 
inch print area. Use the rectangle icon option to mark 
out the edges of your form. In the example shown here, 
the form is 5 X 8 inches. Change the Fill from White to 
None so you can see the grid lines underneath. 

.S file 

m 
mrt:. 
T 
+ ' ........ ...... ( ···~······: ..... ··· ··~······ 

g .·.·.·.·.·. ' LL L. 
i ··········:·····> ··: ..... : ......... : .... . 
,...,., -··· ·>···· ; .... ; ...... , .......... , ..... . 
".:.../ : ~ : 

....... . .... : .... ' ~· .... . ; .... ~. . . . . . . .... : ..... . 
.......... ., ...... : ..... ;... .. ; ....... ... :····· 

Layout area marked w ith a rectangle 

Use the Layout menu to return to Normal Size and 
design the form. Begin with the title of the form. Fields 
composed of a title and one blank line may be created 
using keyboard characters, including the underscore 
character. 

A series of lines or columns can be created using 
the vertical and horizontal line icon. Draw one line first 
to the desired length and ~hickness, duplicate it once 
and position the duplicate far enough from the first line 
to allow room for the information to be entered. Once 
you position this second line, subsequent duplicates will 
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J 

Form s 

automatically position themselves the same distances 
apart. 

=o INUOICES J\? ··: .. ·r ·· ·· ······· ····· ··-:- :··: i 
~ .... : ... · ....... :. ······················:·················:················:·· 

"' : . : INUOICE # 

~ I T l '1'' , :••······ 
.._..,_ : SOLD TD: : : : j 
~-········ ~ :_ ... · ·. ·:· · · · · · · · ·:· · · ~D~~~ih·e·fi r~;1i·~~." : · · · · · · · · · · 

.--i • · duplicate it. and : 
....................... ...... : ........ ......... : ... ..... : .... position the duplicate ..... . 

: · : · Subsequent duplicates ·T.iu 
: : position themselves at 

.... • · · ... · · · · · . : . . . . . . ... : . . . . . equal distances apan .. .. . . . . . 

Duplicating lines in a series 

If you have trouble positioning lines or text exactly 
where you want them, you can use the Layout menu to 
Turn Grid Off. With the grid ON, you move objects at 
intervals of 8 pixels, or about 1/16th of an inch ; with the 
grid OFF you can position objects at finer intervals, but 
it may be more difficult to get exact alignment between 
objects without using the Arrange menu's Align Objects 
option. 

You can save time by duplicating and changing 
words whenever possible. In this example, the "Sold to" 
text and lines were simply selected, duplicated, and 
moved . Th en the word "Sold to" was changed to "Ship 
to" in the duplicate. 

SOLO TO: : : SHIP TO: 
........... . . . .... "' . . . ' ................ . . .. .. . 

"Sold to" text and lines were duplicated and modified to create 
"Ship to" area 
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To create a section for entering rows and columns 
of information, such as qu antity, description, unit price 
and total, use the Layout menu to Reduce to Fit. Use 
the rectangle to outline the area and, as before, select 
the Fill pattern None. Duplicate a series of horizontal 
lines using the same techniques described above for the 
"Sold to" name and address lines. 

: D .. lCIS 

····· ·· ····'.···· ·:······:······ .,. : - a . --. - .- -
. ~ : : : . 
-·-:~. 

··· · ·~······~·····r. ..... ~ ..... . 
.,"' . . •..1' . 
--: - .- .-
. ; ; . : ; .. 

. . . . . 

. .. .. : ..... j ..... -~· ..... : . . . . 

• • • • • ~· • • o - : ., o I ; • • • • •; • • • 

. . 
. . .. ; . . .. : . . . . ~ . .. . ~-.. . -

. . ... · ...... : . . . " ..... ~ .. 

Outline a subsection of 1he form for rows and columns 

On most forms the vertical lines are best handled a 
little differently from the horizontal lines: draw the first 
vertical line and duplicate as many as you need, then 
position them varying distances apart to accomodate the 
different types of information. 

: n•m• 
: ~ ..... ~-.... ·'.· ..... : .... --:-- .... 

-·-'. ~ 
.- : -: ·- ·- :- .. 
~.-. -·- .
- · - · -: - ·-

........... 
. . 

.... ~· ~": 
' ~· ......... . . 

·~a• ... __ 
. .... ; ...... ; . .,.: ~ ~ 

·-.-. -~-

:::=:~ 

Draw ing vertica l lines 
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Use the Layout menu to return to Normal Size and 
type the headings for each column. The simplest 
method is to type all the headings as one line of text. 

Meticulous designers may prefer this more time
consuming alternative: type the first heading, using the 
Style menu to Center it, then duplicate the first heading 
several times, and position each duplicate exactly in the 
center of each column. Then click the mouse on one 
column heading at a time and change the duplicated 
word. 

Now you can be certain that each column heading 
is centered within its column. To be absolutely sure that 
all the headings are also aligned with each other 
horizontally- especially if you are working with the 
grid turned OFF- you can select all the column 
headings and use the Arrange menu's Align Objects 
option to Align Tops. 

Rlign Objects : 

O Left Sides 0 L/ R Centers 0 Right Sides 

@ Tops O T/ 8 Centers O Bottoms 

OK Cance l 

Alignment dialog box 

To select more than one object at a time, you can 
either "lasso" the objects with the mouse pointer, or 
hold down the Shift key as you click the mouse pointer 
on each object. 

Finally, add your company name and logo. If you 
have drawn this before, you can copy it in from another 
file and reduce it to fit the space on your form. You can 
open the second file while the form is still on the 
screen. 
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lliJli Ill! .. 
Bring to Front 
Send to Bock 
Paste in Front 
Paste In Bock 

Rotate Left 
Rotate Right 
Flip Horlzontol 
Flip Uerticol 

lll!JI 

Ungroup 
-lit" 

H--·--
Lock 
Unlock 

lllign to f1rl1l 
llliqo Objt~ch .. , 

Forms 

Select the logo which already exists in one file, use 
the Edit menu to Copy it into the clipboard. Then use 
the File menu to Close the logo file and re-activate the 
window showing the form you are building. Here, use 
the Edit menu to Paste the logo into the form file. 

s File 

r;:~::: 
T 
+ 
" 0 

Style Font Loyout Arrange Fill Lines Pen 

Clear 
Ouplicote 
Select Rll 

:!€H INUO I CES 
:M:C 

: INUOICE # 
ORTE: ____ _ 

. . . . 
31:0 ... , ........ : .. ... ...; ....... : .. . 

0 
0 
""\ 

:!CR : B.D ToyTech logo 
SOL1------1.:. f.:~f:' · ·; ·: · · · ·:· · · ·: ; · · ·:· · · ·: 

*ll : T 
Ji ....... . ... : ... + ........ : ..... ... , .. 
t:::J 

Pasting the logo into the invoice file 

If the objects you are selecting are not already 
grouped as a single object, it's a good idea to use the 
Arrange menu to Group them immediately after pasting 
the objects into the file. After positioning and sizing 
them appropriately, you can always Ungroup them if 
you wish to make detail changes. 

In this example, the form is designed to be 5 X 8 
inches so two will fit on one 81/2 X 11 inch printed page. 
The print shop will cut the forms in half. Two final 
steps are required to create a "camera-ready" master for 
the printer. 

First, use the File menu's Page Setup option to set 
the printer to print the page Wide rather than Tall. 
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Filling m a Form 

Paper: ® US Letter 

O us Legal 

Orientation: O Tall 

0 R4 Letter 

0 International Fanfold 

0 Tall Rdjusted ® Wide 

Page Setup dialog box 

Forms 

( OK 

[ Cancel J 

Then use the Layout menu to Reduce to Fit, use 
the Edit menu to Select All, use the Arrange menu to 
Group Objects and the Edit menu to Duplicate the 
form. Position the two form~ next to each other on one 
page. It's a good idea to use the File menu to Save your 
form before you Print it. 

••""" INVOICE# I ~!'no'" INVOICE # 
~~:' ... ~'i.'t'n DATE: - - ;._~~~1 

... • ... ·l-zn DATE: - -
U l.#O«MA tHf1 U U IOAJrt.l .. , ,, 

UMIH Tlly Trch U MllO 

SHIP TO: : SHIP TO: 

QTY 0 [$CfUPTION UNITS TOTALS QTY DESCRIPTION UNIT S TOTALS 

~BTOTAl 
THANK YOU 1 [,___r•_• _,_______. 

[ TOTAL 

§erou.L 

THANK YOU! ,__a_x -1------< 
[ TOTAL 

Two identica l forms fil on one page 

There are basically three ways of filling in a form: 
1) You can fill in the variable information on each 

form by hand. All you need to do is print out one blank 
form and take it to a printer or copy service to 
reproduce as many copies as you need. 

2) You can display the blank form on the screen 
and fill it in using MacDraw before you print it out. If 
you choose this approach, there is one more step which 
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UNIT$ TOTRL~ 

• • 
• • 

Forms 

makes this process easier: enter a bullet (press the 
Option Key and the number 8) or an asterisk in each 
field that will be entered on-screen. The data you enter 
stands out most clearly if it is in a different font from 
the form labels. To enter information in a field, simply 
click the mouse on the bullet or asterisk and type the 
data . 

3) For forms with many rows and columns of 
entries, you may choose to build parts of the form using 
MacDraw (logos, headings, etc. ) then paste these parts 
into the MacWrite or Word file where you then will enter 
the variable data. This method offers two advantages: 

It is easy to fi ll in large forms using the tabbing 
capabilities of a text processing program. MacDraw has 
no tabbing function, so you are slowed down by 
switching from keyboard to mouse repeatedly as you fill 
in the form. 

Text typed in MacWrite and Word can be copied into 
a spreadsheet or database file. Text typed in MacDraw 
cannot be manipulated by other programs. 

~D Untitled 

. ]+-•~-1-SJ •-}} '-• I •-'--•_!~•-'-·• '-• 1.;!;"J.1 1 • I .&;.-'-·-~~ 
g} ~ D 5 l ines/Inch ~ [§] § ti' 
26 JANUARY 1966 E 

Andreo Doyton 
5609 Ogden Lone 
6ethesdo, MD 20001 

QTY DESCR IPTION 

QP Boby Robot 
ROZO ID 

I UNIT$1 

35 95 
9999 

Form to be filled out using MacWrite 
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The two primary disadvantages of working with a 
form in MacWrite or Word are that you cannot type new 
text in an area of the form which has been pasted into 
MacWrite or Word from MacDraw. This means, for 
instance, that you cannot build a grid of lines to create 
rows and columns in MacDraw, then fill in that grid 
using MacWrite. Create only the unchanging parts of the 
form with MacDraw, such as the logo and boxed column 
headings. You cannot . drop vertical lines down areas of 
the form to be filled in as text. 

The process of copying drawings from MacDraw to 
MacWrite, as described elsewhere in this book, involves 
selecting the drawing in MacDraw, using the Edit menu 
to Copy it onto the Clipboard, then opening a MacWrite 
file and using the Edit menu to Paste the drawing into 
the text file. If you are pasting more than one drawing 
into a text file, use the Scrapbook feature to collect all 
the elements from your MacDraw files before entering 
the MacWrite file. 

Sales Orders and Invoices 

A Sales Order form records a request from a 
customer for your products or services. If payment is 
collected at the time the order is placed, then the Sales 
Order (or a second copy of it) also serves as the Invoice 
and Receipt. 
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Essential fields on a Sales Order can include: 
• Date of order 
• Order number 
• Customer's P.O. number 
• Customer's name, address, phone and account 

number 
• Bill-to address, if different from the Ship-to 

address 
• Quantities ordered, item descriptions, unit prices 

and totals 
• Total order value, discount, tax, and total amount 

due 
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• Method of payment: cash, C.0 .0 ., Charge 
(account number) 

• Customer's signature, accepting order and 
acknowledging delivery 

• Salesperson's ID 
• Standard message, such as "Thank you" 

Forms 

Tho Aciivity Group Corpor•tlon 
888 Markel Slreel , Suile 88 
Los Angeles, CA 90017 

DAlE I ~~ID~ I PAGE I 

PHONE (415)123·4567 

............... _. ........................ -
OROERNO ORDERDATE CUSTOMERNO l SALESPERSON 

l 
SHIPPED VIA DATE SlflPPED TERMS 

OTY OTY ITEM NUMBER DESCRIPTION 
ORDERED SHIPPEO 

PUR::HASEOROERNUMllER 

' MEnlODOFPA\'MEtlT 

UtllT PRICE EXTENDED 
PRICE 

,,,.,, ................. -:-_4J ....... , ............................................................... ·····-······················ 
DELIVERY INSTRUCTIONS: 

SALES AMOUNT 

SALES TAX 

FREIGHT 

THANK YOU TOTAL 

Sales Order Form and Invoice 
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t--

Sales Order 

Forms 

You may want to add columns for QTY SHIPPED 
and QTY BACK-ORDERED. If so, three copies of the 
form may be called -for: one as the customer's invoice 
and receipt, one for your invoice file, and one for your 
unfilled orders file. 

Your customized Sales Order form can include 
descriptions and prices for your most commonly 

. ordered products, to save time during order entry. 
An Invoice looks exactly like the Sales Order form, 

but it is usually mailed to the customer after the order 1 Invoice is placed and delivered. You can add information which 

1 was not known at the time the order was placed, such 
Packing Slip J as delivery date and method. You can also include the 

'--~~~~~~~ 

Credit Memo 

terms of payment applicable to each customer, and an 
explanation of finance charges. 

You can create a series of similar forms easily. Build 
your first form and save it under its own name. Then 
modify the form and use the File menu's Save As 
option, giving the file a new name. This creates a 
second file on the disk; the first file remains 
unchanged. 

You can mail the Invoice out in duplicate, so the 
customer can keep one copy and return one copy with 
payment, or include ~nstructions for returning part of 
the form (see Account Statement, later in this chapter) . 
You can purchase continous form computer paper that 
is 2 or 3 part carbonless paper. 

One or two additions to your Sales Order form 
converts it to a Credit Memo, noting that the amount 
shown is a credit for returned merchandise, or a billing 
correction. You can easily copy and modify your Sales 
Order file to make the Credit Memo a completely 
different form, or print it on a different color of paper 
so there is no chance for confusion in the accounting 
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department. The Credit Memo includes an area for 
referencing the original Sales Order/Invoice number, and 
may include a place for a signature authorizing the 
credit . 

The ActiYity Group Corporation 
888 Market Street, Suite 88 
Los Angeles, CA 90017 

PH ON E (415)123·4567 

SOLD TO SHIP TO 

OADERNO ORDERDATE CUSTOMERNO SALESPERSON PURCHASEORDERNUMBEA 

SHIPPED VIA DATE SHIPPED TEAMS 

QTY ITEM NUMBER DESCRIPTION 
RElURllED 

EXPLANATION 

THANK YOU 

Credit Memo 
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METHODOFPAYMENT 

UNIT PRICE 

SALES AMOUNT 

SALES TAX 

FREIGHT 

CREDIT 

EXTENDED 
PRICE 
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Account Statement 

Forms 

Account Statements summarize each customer's 
account, including the balance forwarded from the 
previous statement, recent payments received, and 
current-period invoice totals. 

The Actlvlly Group Corpornllon 
888 Markel Slrcol , Sulle 88 
Los Angelos, CA 90017 

PHONE (415) 123·4567 

DATE I NU~ER PAGE 

Date Description 

Account Statement 
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Account# ______ _ 

Amount Due: S _____ _ 

Amount Enclosed: S ___ _ 

Charges Credit Balance 
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In this example, the Account Statement is set up so 
the customer can return part of it with the payment, 
and keep part for their own records. The addresses here 
are lined up for a windowed envelope to be used in 
making the payment. 

Addresses match windowed envelope 

Your Account Statement form may need to include 
a complete breakdown of finance charges as required by 
Federal Regulation Z . Your attorney or accounting firm 
can tell you if this regulation applies to you. 

The Finance Charge is computed by Current 
Charges 

applying a "Per iodic Rate" of 1.2% per 
Past 

month which is an Annual Percentage Due 
Rate of 16% applied to the Previous 

Finance 
Balance without deducting current Charges 
payments and/or credits appearing in this Account 
statement. Balance 
Account Balance must be paid within 30 Minimum 
days to avoid additional finance charges. Payment 
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Purchase Order 

Forms 

Purchase orders are customized forms for ordering 
products or services from other companies. Notice that 
the Purchase Order looks much like a Sales Order, but 
it adds a line for an approval signature and it does not 
include a final total. 

The Activity Group Corporation 
888 Market Street, Sulle 88 
Los Angeles, CA 90017 

PHONE (415)123·4567 

VENDOR: 

Ac.count• - ----

ORDER NO ORDER DATE ACCOUNTNOl 

l 
SHIPPED VI A DATE SHIPPED 

OTY QTY ITEM NUMBER 
ORDERED SHIPPED 

- -
'" ___ --· !-"--·-·---

--- -
--

DELIVERY INSTRUCTIONS: 

DATE NUMBER PAGE 

IP> llil JI~ Ilu rai lS) te 

<ID Jr cdl ~ Jr 

AUTHBY PURCHASE ORDER I 

TERMS METHOD OF PAYMENT 

DESCRIPTION UMT PRICE 

SALE AMOUNT 

THANK YOU 

Purchase Order 
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Forms vs. Files 

"""°' 1SPAOECJR[f.l 
0 ........... "1£Y 

c:.wroAIM .. m 
IMM \10 

Forms 

Whether you are completing each form by hand or 
on screen, you will probably want to save the 
information entered on some forms into a data file . 

INVOICE# oo:L. 
DATE' _2 ;,. 8> 

~o 
I 

- lnuoltes == 
Invoi ce " : I 11 ~ 

SHIP TO: 

Do t e: jJon2. 1985 I f-
Sol d- t o Nome: IK. Payne I h . 

' 
Sold- to Stree t : 13915 24th Street . • D I 
Sold- to City/Stole: !San Franci sco, CA I Zip: I 94, 11 41 

ji·:.1 
Sold- to Phone: 1<415)647- 1110 I 

OTY DESCRIPTION UNITS TOTALS Subtotal : I \ 99 99 I 
i QP 2 o oD Tox: I io so I 

Toto I : I \ 106 49 I Dote Potd: ! Jon~ . 1985 I 

Note: ICheck • 30~ 

I I ! 

New .. 
1/1 OLJ::.2 ' h ' ·._i :· '~:::\: :L:'.":~": ..::. T7?JQ 12l 

SUBTO TAL 9f. 
THANK YOU! 1--'_A•-+-='-I 

TOTAL 

The next chapter, Lists, offers some tips and 
alternatives for accomplishing this. 
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Chapter 
7 Lists 

We all keep lists of one kind or another. The most 
common is a list of names with addresses and phone 
numbers, whether they be family or friends, clients or 
suppliers. Another common list is a list of the checks 
written, along with check number, date, payee and 
amount. You might have a list of all the equipment and 
valuables you own, with serial numbers and appraised 
market value or residual value after depreciation . 

Some businesses keep lists of invoices with invoice 
number, customer name, and total amount due. When 
they receive payments, they check off the invoice listing 
in their credit ledger and transfer the amount from 
"Receivables" to "Cash In''. 

If you have more than a few employees, then you 
probably have a list showing how much you have paid 
to each in wages or salary and h ow much you have 
withheld for taxes, insurance, pension funds, etc. Retail 
businesses maintain price lists and product inventories. 

These familiar lists are the stuff of which a 
com puter database is made. A database program helps 
you define your list, and get the information you need 
from that list. Hundreds of hours of work can be saved 
by using the Mac to help you maintain the lists you use 
every day. 

It is important to understand how easy it is to use 
a database to help you in your daily business. We 
d iscuss what special features databases offer you, then 
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File 

-
What's a Database? 

Invoice a 23 

we give you some tips on how to select the best 
database program for your needs. 

Li sts 

After going over the basics, we demonstrate two 
lists which are common in business, yet which are very 
different. We build a simple name/address/phone list 
which we sort by zip code and print onto address 
labels. Then we show some of the differences between 
that simple kind of list, and an inventory list, which 
includes mathematical calculations. 

For purposes of demonstration, we use the 
program called File, by Microsoft. Even if you don't have 
the File program, you can still benefit by looking at the 
following examples. They are designed to give you a 
taste of what is possible with a database program. Once 
you get an idea of how a database program works, you 
can take a more informed look at the forms and files 
you use in your daily business. 

A database is a filing system. Almost anything you 
now store in a filing cabinet is a candidate for 
conversion into a database on your computer. In fact, a 
simple database program is sometimes called a filing 
program. 

For example, one of the drawers in your filing 
cabinet might be labelled "Invoices." Inside the drawer 
there are a series of file folders, perhaps one for each 
month. Inside each file folder is a series of invoices in 
numerical order. Each invoice shows the same categories 
of information, though the contents of each category 
differ from one invoice to the next: invoice number, 
customer name and address, list of products ordered, 
and total value of the order. 
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Invoice O 

lrM>ice 
File or 

-- Database 

• 

A database is a filing system with new names for each 
component 

Lists 

In a computerized database, each invoice (or name) 
is called a record, and each category of information is 
called a field. The database is the collection of all 
invoices. With your Macintosh you can sort your data 
almost any way you wish and group it into categories 
for subtotalling. For example, you can get a list of all 
invoices in numerical order, you can sort your invoices 
in date sequence and ask for subtotals by month, or you 
can re-arrange your invoices in alphabetical order by 
customer name and calculate the total amount owed by 
each customer. 

You can search through your file for a name or part 
of a name. In just a few seconds you can find the 
records for ToyTech Shop, Pleasant Valley ToyTech, and 
TAG Corp. (ToyTech Division) - three related records 
which might have taken hours to locate searching by 
hand through an oak filing cabinet. 

Find 

E Find H LClear I 
!Jenny 11armor I 
I I iiiiii 

NAME: 

COMPANY: 

Most database programs let you search for words 
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File 

Lists 

Using a database package, you can print your lists 
out in many different formats. You can even get totals 
and subtotals for different categories. 

Price List List of 
Manufacturers 

Inventor y Count 
and Value 

- - = -- -- - -- - - - - - -- - - - - - -- - -- - -- - - - -

Database programs offer many options for printing out reports 

In addition, some database programs offer the 
ability to enter your own formulas for calculating values, 
similar to fu nctions provided by spreadsheet packages. 

Formulo:j quantity In stock * wholesale 

Some database programs let you enter formulas to calculate 
values 

Although the two have certajn functions in 
common, a database is not a spreadsheet. For instance, 
most spreadsheet packages include some sorting 
capabilities, but none have the searching capabilities 
which are essential to database management. You can't 
easily print mailing labels directly from a spreadsheet 
file of names and addresses, nor can you easily print 
out a list of all invoices with automatic subtotalling of 
net due per customer. You may be using a spreadsheet 
program to handle information which would be more 
manageable with a database program. 

Sophisticated database programs are called relational 
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Selecting A Database 

Lists 

databases, because they have the ability to pull, or 
relate, information from one database into another. With 
a relational database, you might have one file that 
contains your client's addresses, and another invoice file 
which, by simply entering the account name or number 
you enter, "pulls" the addresses from the address file 
onto each invoice. There are relational databases for the 
Mac, but File is not one . 

A relational database will let you build an invoice 
file in which you enter only the product name and 
quantity, and the database program itself then calculates 
the invoice total based on information it gets from a 
price list in another file or in another part of the 
database. The program might even go into the inventory 
file and automatically deduct the quantity ordered from 
the inventory total for each product shown on the 
invoice. Instead of buying a database package, you 
could buy an accounting package which is already 
designed to do inventory maintenance and invoicing. In 
other words, a database program is not an accounting 
package, though some database programs can handle 
most of the functions required for business accounting. 

When you decide to buy a database package you 
will find that of the many types of software applications 
available for the Mac- word processing, project 
planning, spreadsheets, etc. - there are more databases 
to choose from than any other type of software. 
Everything from simple mailing list programs to 
sophisticated database systems are available, and finding 
the program that's right for you can be tough. We've 
said generally that with a database program you can 
sort, subtotal, search, and print out your files any way 
you wish. In practice, some database programs are more 
flexible than others in handling these basic functions. 
You can't always discover the Achilles' Heel of a package 
before you buy it, but there are certain guidelines you 
can follow that will help you narrow down your choices. 
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In looking for a database package, it's important 
first to know what your own needs are. How much 
information will you want to store in your database? 
How much will you want to manipulate the data? Do 
you expect your information needs to grow with your 
business; will you want to add new fields to your files 
over time? Do you want to be able to use the Mac's full 
range of type styles? Will you want to include graphics 
with your data? 

If you will use your database primarily for a 
mailing list, how large will it be? Do you want to print 
only mailing labels, or do you want to print form letters 
or invoices as well? Do you want to know simply who 
your customers are, or do you also want to know the 
current account balance for each? Do you want to sort 
by name only, or by zip code also? 

For example, when shopping for a database or file 
program you might ask: "How many records can this 
package handle?" If you have a mailing list with 10,000 
names, then you'd better be sure the database package 
you buy is not limited to smaller file sizes. A related 
question is: "How big can each record be?" Will you be 
limited to name, address and phone number only, or 
can you also store date of birth, current account balance, 
detailed transaction histories, etc.? 

The size of any database will be limited by your 
equipment as well as by the software package you buy. 
You will be able to maintain much larger databases on a 
hard disk than on a 3%" floppy diskette. 

How complex is the information you wish to store? 
A simple list would show only one address and phone 
number for each name, a more complicated list would 
allow two addresses per name (home and office, ship-to 
and bill-to, etc.). Some database programs will not allow 
two records for the same name. You would have to 
decide whether you wanted to store John Smith's office 
address or his home address, because you could not 
keep both - the second John Smith entry would 
automatically replace the first. 
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Customer List 

Will you want to frequently search for names or 
words? Will you want to sort and re-sort the data? If 
your files are very large, this processing will be slow 
and tie up your Mac for h ours. 

Lists 

One of the drawbacks of early database programs 
was that once you designed a file you could never 
change that design. In other words, once you created a 
phone list, for example, you could not easily go back 
and add a full address for each name. Be sure that the 
package you buy lets you add or remove categories in 
your lists easily. 

If your main need is to send bulk mailings to sales 
contacts, make sure the program can produce all the 
fo nts and graphics you need. We know of one unhappy 
car salesman who simply wanted to maintain regular 
correspondence with his 200 or so customers. He 
bought a powerful database package that had many 
calculating and sorting functions; however, it did not 
take advantage of the Mac's fonts . It wasn't much fun to 
send letters in the "draft-quality" Geneva font! 

The Mac offers some really unique features that 
make it a pleasure to use - fonts, pop-down menus, 
and the ability to "point and click" with the mouse. 
Some programs utilize these features more than others, 
and it's important to choose a program that you fin d 
easy to use. 

Make sure the program can at minimum perform 
the tasks you have in mind for it . Don't buy a database 
program without first thinking about your own work 
and what you need to accomplish . 

The file in this example can be u sed to print 
mailing labels or a phone list. We begin with such a list 
in order to demonstrate a simple sequence of steps 
involved in creating and using a database. The steps 
here show you how to .build an address list and print it 
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out onto 81/i X 11 inch paper first, then onto mailing 
labels, sorted by zip code. The examples use Microsoft's 
File, but they offer plenty of good tips for designing a 
database using ~my program. 

I NAME: !Mildred Pierce I 
COMPANY: jMildred's Diner I 
STREET: j •1 Ocean View I 
CITY: STATE: ZIP: jcarmel 1~194949 I 
PHONE: j647-1234 I 
DATE OF LAST PURCHASE: !Jul 6, 1965 I 

2 NAME: !Johnny Car son I 
COMPANY: !Car son's Cors I 
STREET: j 123 Ma in I 
CITY: STATE: ZIP: !Blue Hillis llECJ@:@JTI 
PHONE: 1657-0294 I 
DATE OF LAST PURCHASE: !Sep 10, 1965 I 

Address List 

Build ing an Address List 

The first step in setting up any database, large or 
small, is deciding wh at information each database file 
will contain. In the case of a simple customer file, you 
need to determine things like "Should the list contain a 
company name for each person?" or "Should each 
record have a space for one phone number or two?" 
While many programs, including File, will let you add a 
new item of information (a new field) to your list, it will 
save you time in the long run to plan out as much as 
you can first . 

With any database, the first step is to create the 
form through which the data will be entered. In this 
case, we are not talking about pieces of paper - like the 
forms described in the last chapter (though a paper 
form could provide the source information for a 
database). The database form not only arranges and 
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labels information on the screen, but also defines the 
type of information which will appear in each field: 
text, numbers, dates, or pictures. (You can include 
pictures created with MacPaint or MacDraw in some 
databases, including File.) 

To create a new data input form choose New from 
the File menu. Type in a new name for the file. 

Name for New Datafile: 

._IT_RG_c_u_s_to_m_e_rs _____ ~J (MA!§IM 
or Select a Datafile: 
CUSTOMERS 
TAG Distributors 

Qj copy Fiie 

Three Months Sales Quotas 
Open Eject 

QJ 
[ Cancel Driue 

Opening a new data file 

The first screen which appears in the File program 
is where you'll create the data input form by defining 
the different fields of information your list is to contain. 
Type in the name label of each field. For a customer list, 
we begin with the field label "Last Name". After typing 
in the label File asks you to define the type of data that 
will be typed into that space. In the case of names, 

Form 

Selecting the type of data that wil l be entered 
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addresses (combination of numbers and text), titles, and 
descriptions, we want to define Text as the data type. If 
you define a field type as Number, only numbers and a 
few punctuation marks can be entered. If you have any 
question about the type of data, choose Text, as it will 
accept any character from the keyboard (except 
graphics). 

After you've chosen the type of data for the field, 
the field label appears at the top of the screen. This is 
where you'll enter the data, once you have completed 
designing your form. You can change the length of a 
field by grabbing the right side of the box on the form 
and dragging it to the left or right. 

s File Edit Form Organize 

Changing the w idth of a fie ld on the form using the mouse 

Follow the same procedures for the next fields: 
First Name, Company Name, Street, City, State, Zip and 
Phone Number. When you have entered all the field 
labels, you're ready to input your data . 
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IRG Customers 

I Fole Willlom 
2 Nosro Elles 

Show Form 

Format Flelll ... 
Se t Font... 

Lists 

File allows you to enter data into your file through 
one of two different forms. The way it initially appears 
on the screen in the List Helper format. This format is 
similar to a spreadsheet - the information you must 
enter is listed in rows and columns. As an alternative, 
you can enter the information in the Vertical Form 
format, a format similar to a paper form you might fill 
out. 

IRG l uslomers 

ADORE 
346 7 Norra ons 

6 LAST NAME jGronoaos I 
FIRST NAME· !Auro I 
COMPA NY jsameT1me I 
ADDRESS. j23J 67 th Street I 
CITY. l?ort Solute I 
ST : ~ 
ZIP. ~ 
TELEPHONE: IB 1377J9-0923 I 

,..w LAST NAME I\ J 
FIRST NAME. ] 
COMPANY. J 
ADDRESS. J 
CITY J 
ST _[ l 

Q 

H 
H 

0 
0/8 tQII IQ 

You can enter data in the List Helper (left) or the Vertical Form 
(righ t) 

In the beginning, it's easiest to use the List Helper 
format for most data entry. List Helper arranges the 
data with each row showing all the fields in one record. 
You can see many records on the screen at once. If your 
records run off the right side of the screen you can 
select Vertical Form to see all the fields arranged one on 
top of the other. This arrangement makes it easy to 
enter data but you can view only a few records at a 
time. 

You can re-arrange the data fields to print out in 
any order or location you like, as long as List Helper is 
turned OFF. To do this, select Vertical Form and Show 
Form from the Form menu. You will see two windows. 
Click on any field you want to move in the form 
window and drag it to a new location. You can drag 
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fields into the grey area of the form if you want the 
information to remain in the file itself but not display 
on the screen or print out when you are editing or 
printing records. You can also drag the field labels into 
the grey area. 

Printing Mailing Labels 

You could, for example, arrange the fields from the 
Customer List in a mailing label format. This would be 
a good alternative if you don't have a text merging 
program, like Microsoft Word or Megahaus MegaMerge 
(used with MacWrite), for printing out mailing labels. 
However, your labels will not look quite as good using 
this method - there may be a lot of blank space left 
between first and last names, for example, if the first 
name is short. Text merging programs usually 
compensate for this. 

TAG Customers 

lllse I I Aikens 

IAikenwoocl Leisure I 
I 168 1 Kirk Street 

._IBu_r_lin"""ga_m_e _ __,1~1607 1 2 

~D Form 

0 IFIA ST NAME I !LAST NAME !:! 

I COMPANY I 10 
I ADDRES S I :!:': 

H !CITY l~IZ IP •rn 

Field labels are positioned in grey area of form so they will not 
print out 

File offers a convenient way to use your list with 
the text merging features of Microsoft's Word (see 
Chapter 5 for more details) . From the File menu, select 
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Save Records As to choose the option for saving your 
database records in a format that Word can use, namely 
a file in w hich the fields in each record are separated by 
commas. 

Saue Recor ds Rs: 

I Cust omer Merg~ 
Q Normal 
® Te11t (Microsoft Pr int Merge) 

Copy File 

Ejec t 

( Concel J I ( Driue 

The Save Records dialog box offer the option of saving records in 
a format for text merge w ith MS Word 

Print ing Reports 

All database and filing programs let you print out 
your information in a report. Some programs offer 
greater flexibility in the report format than others. Some 
reports let you position data fields on the printed page 
wherever you want, while other offer only one or two 
options. For maximum flexibility in defining your 
printout formats, some database programs require the 
help of an additional program called a report writer. 

Further, most programs will give you totals for 
certain fields, or perform other calculations. File offers 
only a columnar, or "Table" format for printing out your 
list. You can, however, perform certain math matical 
calculations on various fields. This function is most 
helpful when dealing with financial or statistical data, 
which we'll discuss in the Inventory List section . 

To create a report, choose Report from the 
Organize menu. The report formatting area appears in 

a&F the lower half of the screen. Fields can be manipulated 
the same way as the fields on the form : click the mouse 
on any field and drag it into the appropriate columns 
on the report worksheet (Sort, Not Sorted, or Not 
Shown). Fields that you do not want to appear on the 
report sould be dragged to the Not Shown column. 
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Repor t 

D Summary Report 

Report formatting area 

You can Preview the report on the screen if you 
wish, or simply request the printed Summary Report 
through the File menu's Print Report option . 

Preuiew 

COMPANY TELEPHONE FIRST NAME LAST NAME 
Aikenwood Leisure 802/ 981-91 28 Lisa Aikens 
Chee Lee Games 415/ 876-9235 Si mon Wong 
Debr a's Dolls Unlimit 415/458-9574 De~ra Smallcombe 
For Kids Only 219/ 987-4658 Wil liam Nelson 
Fun Things, Inc 305/986- 1604 Jimmy Mcclave 
Game Time 8 13/749-0923 Aura Granados 
!Jladst one Games 8 13/872-9 126 Elias Nasra 
Langley Games &. Toy! 803/927-8600 Robert Langley 
Nelson's Spor t s 305/234-8945 Karen Nelson 
Toys 'N' Stuff 617/436-2385 Will i em Foley 

Records processed: 1 O Records to process: 1 O [ !'nuse ] ~ 

Report can be previewed on screen before printing out on paper 

Sorting 

One of the most important advantages of putting 
your lists on the Mac is that you can use File or some 
other database program to sort your records. You can 
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Find ... 3€F 
Hlll!' HhOld~ :•:ti 
Show All Records 

Report... l!CR 

Lists 

arrange your file in order by any field- by last name, 
company name, or by zip code. You can arrange your 
file in different ways by a simple click of the mouse. 

In File, simply choose the Sort option on the 
Organize menu. A window will appear which shows 
each field in your form. Simply click on the field by 
which you wish to arrange your records. 

TRG Customers 
LAST NAME FIRST NAME COMPANY ADORE 

I Foley Will i am Toys 'N' Stuf f 346 7 Nar ragans 
2 Nasr a Elias Gladstone Garnes 354 So. Hill Bou 
3 Smallcombe Debra Debra's Dolls Unlimited 4 129 Pachecho 
4 Wong Simon Chee Lee Gemes 234 Stockton St 
5 Aikens Lisa Aikenwood Leisur e I 6B I Kirk Stree 
6 McClave Jimmy Fun Things, Inc. 7665 Church St r 
7 Nelson Karen Nelson·s Sports 2233 Post Stree 
8 Granados Aura Game Time 234 6 7th St reet 
9 Langley Robert Langley Games & Toys 4567 Stout Way 
10 Nel son \vi ll iam For Kids Onl y 6B5 ~lerket Blvd 

Sort 

COMPANY 

Click in the field which you want your list sorted by 

File arranges your records in ascending (A, B,C or 
1,2,3, etc.) or descending (Z,Y,X or 10,9,8, etc.) order. To 
change from ascending to descending order, simply click 
on the field in the Sort window. In our example, we 
arrange the list alphabetically by company name. 

LAST NAME FIRST NAME COMPANY ADDR~ 
I Aikens Lisa Ai kenwood Leisure 168 1 Kirk Stree 
2 Wong Simon Chee Lee Games 234 Stockton St 
3 Smallcornbe Deer a Debra's Dolls Unl11nited 41 29 Pechecho 
4 Nelson William For Kids Only 685 Market Bl vd 
5 ~lcCla •1e Jimmy Fun Things, Inc . 7665 Chur ch Str 
6 Granados Aura Game Time 234 6 7th Street 
7 Nasr a Elias Gladstone Garnes 354 So. Hill Bou 

The list sorted alphabetica lly by company name 
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Inventory List 

Lists 

Graphics 

One of the unique features of using File (and some 
other database programs) on the Macintosh is the ability 
to include pictures in each record. These pictures must 
be created using MacPaint or MacDraw and pasted into 
the appropriate fields of each record. With File you can 
make the field box on the form as wide and deep as 
needed to accommodate the picture. 

~O Three Months Soles Quotas 

5 Kasper, Bernice 
~----~ l~A_ri_zo_n_a -~ 

Jonuory Februory Morch 

s26,7a9.oo I 
::=:=$3=o=.o=o=o.=oo~l~l==$=35=,o=o=o.=oo~ll::=:======~ 
.__ __ a9_.3_o~xl~l _ __ o_o_o~xll.__ ___ ~ 

January February March 

$36, 124.oo I 
$30,000.00 11 s3s,ooo.oo 11 

:=====:::::: .__ __ 1 2_0_.4_1 ~xl~l ___ o_.o_o~xll.__ ___ ~ 

Microsoft File can include pictures pasted in from MacPaint or 
MacDraw 

Finally, this inventory example includes two fields 
with calculated entries: the total sale value of an 
inventoried product equals the quantity on hand times 
the list price per unit, the insurance value of an 
inventoried item equals the quantity on h and times the 
replacement value per unit. 
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~o lnuento~ 

ll!.roduct31 J!!Oduct nome JL d11te J l_g_u11ntity_ in stockJ 1! 

I ~onufocturer I' list price I 
.... --=---'·I wholes11Je 

:::;:: 

-.-+-r -_ -_ -_ "7_12:=3;a;P~Z_,o=i...,..d7 -~ -= -= -= -= -,;J,_ bJ-an-,-. -, 9~6~5-]~IT----1...,..00~~~:~~: 

Moore & Moore I 99.991 -> I $9,999.00 I iJi!/i 

35.671 -> I s3,567.oo I~ ;;: 
L..__L~~~-============::::!_~~~~~~~~~_:_~___J~~ 

formBt Number f ield 

Nome: I insuronce uolue 

Display 
0 General 
@ Dollar 
O Percent 
O Declmal 
O Scientific 

Align 
O Lert 
ocenter 
@ Right 

Inventory file form ula 

w 
I [ CBncel J 

Style---. 
181 Border 
D Underline 
D Bold 
D I talic 
181 commas 

The report from the inventory file shows the total 
value of the entire inventory. This includes the list price 
total as well as replacement value total. 

Copying Your List to Other Programs 

Soles 
District I s t Qtr 2nd.J!!r Jrd Qtr 

1 Eost 120 125 115 
2 Herth ~ 96 87 
J Snuth 150 160 149 
4 West 170 182 165 

Using the Macintosh's Copy and Paste commands, 
you can copy the records created with Microsoft File into 
Microsoft Mu/tip/an, Word and MacWrite. 

Records copied into Multiplan will be arranged with 
one record per row, one field per column. 

4 th::filr Toto I 
RICI Jl i n t. 

IJO 490 
104 J77 

_2_ _l_ 
120 12' 

171 6JO 'JO % 
169 706 '~ 160 

170 182 

Oi l ;~ 

Records copied from Fi le into Mu/tip/an 
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115 
87 ,.. 
••• 

i 

"" '°' 17!. 
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Oi s l r1 ct I s l Qlr 
I Eost 120 
2 North 90 
3 South 150 
4 West 170 

Snles 

Li sts 

You can also copy from Multiplan into File. If you 
have been using Multiplan to manage information which 
would be more appropriately stored in a database, you 
can still build an instant database by coping rows and 
columns from Multiplan into File. You need to set up a 
form in File with a field name for every column of 
information you are copying from Multiplan. 

Records copied from File into MacWrite or Word may 
require additional tab settings in order to arrange the 
information in columns. 

2nd Olr 3 rd Qtr 41hJl.!r Toto I 
125 
96 

160 
162 

115 130 490 
67 104 377 

149 171 630 
165 1~706 

Eas t 
tlorth 
South 
West 

120 
90 

150 
170 

125 
96 

160 
162 

115 
67 

149 
165 

130 
104 
171 
169 

490 
}77 
630 
706 

Data copied into MacWrite can be arranged in columns with the 
proper tab settings 

You can also copy text, numbers or drawings from 
MacWrite, Word, MacPaint or MacDraw into File - one 
field at a time. You cannot build whole records by 
copying from these programs. 
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Chapter 
8 Telecommunications 

M acTerminal 

-

The world is getting smaller. Not so long ago, three 
thousand miles seemed far away and you had to plan 
days ahead to. get a packet of papers delivered on time. 
Now, with your microcomputer h ooked up to a phone 
line, you can exchange messages, business reports, and 
published information all over the world within 
minutes. 

For example, you can transfer information easily 
from one Macintosh to another over the phone lines, 
including graphics! Of course, if you're not in a hurry 
you could simply mail disks of your files to the other 
offices which use Macintoshes. But what if the other 
offices are u sing Apple He's or IBM PC's? These other 
machines don't use the same disks as the Mac. Even if 
they have 3 114 -inch disk drives, other types of 
computers can't read the information directly from a 
disk produced on the Macintosh . 

Using a telecommunications package like 
MacTerminal you can send information from the Mac to 
any other computer equipped to receive data over a 
phone line. You can send text files created with MacWrite 
to another computer, which in turn can use its own text 
processing program to read, edit and print the files you 
send . You can even sen d text to typesetting shops for 
phototypeset output - as we did with this entire book! 
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Files created with certain programs - Microsoft's 
Multiplan and Chart, for instance - can be transmitted 
from a Mac to an IBM PC and be manipulated further 
using the IBM version of Multiplan or Chart. You can 
even hook up to an IBM mainframe computer and use 
your Mac as a terminal to read or edit files in the main 
computer, or to copy parts of files from the main 
computer into your Mac and edit or print them out 
them with MacWrite . 

Local and national networks are springing up 
everywhere, offering access to on-line ''bulletin boards" 
and electronic mail services at prices that are 
competitive with more traditional methods of 
communication. On-line newsletters can be updated 
daily, so the latest entries are instantly available to 
readers. Electronic mailboxes can be password-protected, 
so only your employees can read the notes in your 
company's mailbox. 

Finally, there are many information services 
available which offer access to on-line libraries, news 
summaries, stock prices, airline schedules, "bulletin 
boards" and games. Typically these services require an 
initial subscription fee which entitles you to a password 
and a few hours of free time, after which you will be 
billed according to the number of minutes you use the 
service each month. 

Your Macintosh can access these other computers 
and the vast pools of information offered through 
commercial information networks . All you need is a 
compatible modem, and a communications software 
package like MacTerminal. 

If you have never telecommunicated before, it's a 
good idea to look over the manuals provided with your 
communications package before hooking up your 
modem. As in previous chapters, you need not have the 
MacTerminal program to benefit from reading the 
following sections. If you are new to 
telecommunications, be sure and start with the 
following section which will familiarize you with some 
of the terminology and concepts involved. 

160 



MAC AT WORK 

The Basics 

Telecommunications 

Whether you are communicating with another 
Macintosh, an IBM PC, an IBM mainframe, or an 
information network, there are certain basic steps 
involved which are common to all telecommunications 
procedures. In a nutshell, you need to hook up your 
Mac to your modem, hook your modem into your 
phone line, and start up your telecommunication 
program. We review these steps here before discussing 
specific applications. 

The Modem 

A modem is a piece of hardware - usually a plastic 
or metal box about the size of a book- which translates 
signals from the computer into a form which can be 
sent over phone lines, and translates incoming messages 
back into computer signals. In order to communicate 
between two computers over phone lines, both must be 
attached to the phone line through a modem. 

om ~:::/<; ~ ~t . u 
0 0000 00000 --- - -a - a -

A modem is a small p iece of hardware required at each end of 
the phone line for communication between two computers 

There are many different models of modems which 
can be hooked up to a Macintosh, and there are several 
different telecommunications programs which run on 
the Mac. You must be sure foat the telecommunications 
package you buy can run with the modem you select
some telecommunications programs work with only a 
few different modems. 

161 



MAC AT WORK Telecommunications 

One of the main differences between modems is 
the speed at which they can transmit or receive 
information. If you send large files often enough, then 
you will save phone line charges by transmitting at high 
speeds. On the other hand, if you use 
telecommunications for many short requests (for 
instance, if you are a travel agent checking flight 
schedules throughout the day) then you won't notice 
much difference between high-speed and low-speed 
transmissions. High-speed usually means that data will 
be transmitted at 1200 baud, or at the rate of 100 to 120 
characters per second. Low-speed modems usually send 
data at 300 baud, or 25 to 30 characters per second. 
High-speed modems generally cost more than low
speed modems. 

Telecomm unications Packages 

In addition to a modem, you need to have a 
telecommunications program in order to send or receive 
information over the phone lines. It is through the 
telecommunications program that you actually set the 
speed for the modem, along with other settings which 
we describe next. 

Exampl e Session 

The steps in setting up your equipment and 
telecommunicating are almost the same no matter what 
type of modem and telecommunications package you 
have. 

First, attach the modem to the port marked with a 
sm all te lephone icon in the back of the Mac. A second 
wire from the modem plugs into your phone line. You 
may need to disconnect your telephone to attach this 
wire - so it's a good idea to wait until you are ready to 
dial before making this connection. Finally, a third wire 
plugs your modem into a standard electrical socket for 
power. 

162 



MAC AT WORK 

Terminal ... 
' I 

File Transfer... "t 
Rnswerback Message ... 

Show Tab Ruler 

Telecommunications 

DD 

o~ 
Mac with modem 

Next, start your telecommunications program. This 
program (in this case we are using MacTerminal) makes it 
easy for you to set the "switches and dials" which make 
your system compatible with the one you will be dialing 
up. These settings, called communication parameters, 
define how your data will be transmitted and received. 
MacTerminal prompts you for this information from the 
Compatibility Settings menu. 

Compatibility Settings 

Baud Rate 0 50 0 75 0 110 0 134.5 

0 150 0 200 0 300 0 600 

@ 1200 0 1800 0 2000 0 2400 

03600 0 4BOO 0 9600 0 19200 

Bits per Character O 7 Bits @ 8 Bits 

Pority O Euen 0 Odd @None 

Handshake O HOn/ HOff @None 

Connection @ Modem O Another Computer 

Connection Port @ J~I 0 JJ11 !,;;I ~ 
~~~ 

MacTermina/'s Compatibility Settings menu 
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The essential information here includes baud rate 
(speed of transmission), number of bits per character (7 or 
8), parity (odd, even, or none), and handshake (how th ~ 
flow of data between computers is regulated). All you 
need to know about these settings is that they must be 
the same at both ends of the line. If you are dialing up 
an information service or mainframe computer which 
receives many calls, then the operator at the other end 
can tell you what settings to use. If you are dialing up 
another microcomputer, then you must agree with the 
operator at the other end as to what settings to use. 

MacTennina/ also provides a menu of File Transfer 
Settings which make it easy for you to send whole files 
which yo u h ave created u sing MacWrite, Multiplan , etc., 
and a menu of Terminal Settings which you can use to 
make your Mac act like machines such as the DEC 
VTIOO, and the IBM 3278, or a TTY (teletype) . These 
menus are discussed in the following sections where 
they apply. For now, let's assume that all your settings 
are correct and that you are ready to dial up or receive 
a call from another computer. 

If you will be receiving data over the lines, but you 
don't want to save that data, use the Commands menu 
to set Don't Record Lines Off Top. Under this option, 
information which comes in over the phone lines will 
be displayed on the screen line by line, and as the 
screen fills up the oldest lines will roll off the top of the 
screen - you must read them while they are visible on 
the screen, because they will not be saved. Otherwise, 
MacTerm ina/ will accumulate lines into a file as they roll 
off the top of your display screen, and you can read 
that file or print it out at any time. 

Use the Phone menu's Phone Settings option to 
enter the phone number (if you are dialing out) or to 
set the number of rings before your modem answers (if 
you are receiving a call). 

If you expect to be telecommunicating to the same 
number repeatedly, you can save all the settings made 
during the first telecommunication session under a 
unique file name, such as "Dow Jones". Whenever you 
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wan t to connect to that number again, simply open the 
"Dow Jones" file instead of starting from scratch with a 
new MncTerminal file. The MacTerminal disk comes with a 
few such fi les which have already been set up for 
specific types of communications, including Mac-to
Mac, AppleLine, and Commercial Services. 

~o Mac Term 
10 itoms 3391( in disk 601( n•il• blo 

~ 
IQ 

~ CJ CJ 
Mae Terminal Disk COj>IJ S<Js l•m rolder Empty Foldl'f" 

~ ~ ~ 
Mac-to-Mac Commtrclll Sffvl«s Hard Disk - Commt'ro111 s~rvicf.s 

~ ~ ~ 
Appl<L'"" Appleltnt Supervisor Apple Clusltr Conlrolltr 

~ ~ 1C 
Some files are a lready set up (or you on the MacTerminal disk 

Tf you wish to save your settings, it's a good idea to 
do that now, before making the actual connection. 
Finally, with all the settings saved , use the Phone menu 
to select Dial or Wait for a Call . 

Information services and communication networks 
have special numbers which are answered only by 
computer. If you dialed one of these numbers yourself, 
you would be greeted by a series of electronic beeps. If 
you dial one of these numbers through your modem, 
the beeps will be translated into messages which appear 
in English on your terminal screen . 

If you are dialing up an office which does not have 
lines devoted exclusively to telecommunications, then 
you may need to call them first and use your own voice 
to let them know that you are ready to 
telecommunicate. Then they need to set up their own 
computer and modem so it is ready to receive the cal l 
from your computer. If a human voice answers a call 
from your modem, you may need to hang up and dial 
again . 
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Once connected to the other computer, you can 
"chat" w ith the operator there (typing your messages 
through your keyboard), you can send or receive fil es, 
or you can view and edit information stored in the 
other computer's files. Some examples of these 
procedures are given in the next sections . 

Whe n you are finished communicating, use the 
Phone menu to Hang Up. Remember to re-connect your 
own phone, if necessary, so you can receive calls 
normally when you are finished . 

There are two different ways that your Mac can 
communicate with other Macs. If you are considering 
using several Macs in your offi ce, you may want to 
connect them together in what is called a "local area 
network". If the Mac with which you wa nt to 
communicate is in another building, another part of 
tow n, or another state, you'll need to use the telephone 
lines to communicate. 

Networks 

A network, also known as a l ocal Area Network 
(LAN), is a system for allowing several microcomputers 
to share common resources. Resources may include files 
and/or hardware such as hard disks or printers. 
Networks consist of cables to connect the va rious 
computers and hardware, and software to help direct 
the "traffic" on the network. 

Networks are an essentia l part of the office 
environment . They allow several people to input to or 
edit the same file w ithout having to physically pass a 
diskette around the office. By allowing several machines 
to share the same hardware, an office can rea lize a 
tremendous cost savings. For example, severa l Macs can 
share the same LaserWriter printer, connected by 
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Apple's AppleTalk Personal Network. The distance that 
two machines can communicate over a network varies 
from system to system . 

D 

lQI - ~ -

Telecommunicating Mac to Mac 

While networks are good for connecting Macs 
within the same area, you need to communicate over 
the telephone lines when longer distances are involved. 
Your MacTerminal disk comes with a file already set up 
for you ca lled Mac-to-Mac. If you are dialing another 
Macintosh, all that is required is that both Macs open 
this MacTerminal file, with one machine set up for 
dialing and the other set up for answering the phone. 

File Transfer Settings 

Tronsfer Method @ HModern O TeHt 

Remote System ® M11cTerrnin11I O Other 

Deloy Between Chllrs lu I / 60th Second 

Deloy Be tween Lines EJ1 60 th Second 

l8J Retoin Line Brealcs 

t8:I Word Wrop Outgoing TeHt 

Mac-to-Mac File Transfer settings 
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If you are sending files to another Mac, you can 
include drawings created with MacPaint or MacDraw. If 
you are sending files to another computer, you can send 
text only - no pictures . 

• • 
@- - IQ! -

You can send p ictures to other Macs 

If yo u are communicating between a Mac and an 
IBM PC (or any other non-Mac microcomputer), the 
settings are a little different than with Mac to Mac 
communications. If the PC with which you are 
communicating uses the XMOQEM protocol, you can 
set the File Transfer Setting for Transfer Method = 
XModem. If the other computer does not use 
XMODEM protocol, then you must be sure that the File 
Transfer Settings show Transfer Method = Text and 
Remote System = Other. 

File Tronsfer Settings 

Tronsfer Method O HModem ® TeHt 

Remote System 0 Mnt Terminnl ® Other 

Oeloy Between Cho rs In I I 60th Second 

Oeloy Between lines ~I 60th Second 

181 Retain line Breolcs 

181 Word Wrop Outgoing TeHt 

Mac to IBM PC File Transfer Settings 
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You can send text files created with MacWrite or 
Microsoft Word if you Save them as Text Only (an 
option offered by both these programs during their own 
save process). You can send the words only- special 
type styles and format settings such as margins and 
tabs get stripped out. However, any text processing 
program available on the receiving computer can open 
these text files and edit or re-format them. 

ROASTED CHICKEN ~ 
Ono .T- 4 lb. Hlholo Frysr 
S T11blospoons G11rl1c & H11rb Bvllor 
S11/I & Freshly Grovnd Black Popper 
lo T11s l o 

Rinse the cbict.en and pat dry with paper 
towels. Cbicton sbould be at r oom 
wmporature. Pr eheat oven to 450•. 
Loosen but leave intact the st.in from the 

ROASTED CH I CKEN 

One 3- 4 I b . llhol e Fryer 
5 Tablespoons Gari 1c & Herb But t er 
Sa I t & Fresh I y Ground BI ock Pepper to Tas t e 

Rinse the chic~.en and pat dry ,.; th paper t°""'ls. Chicken should be ot rooa 
te~ature . Preheat oven to 450° . Loosen bi..it l eavci intact the skin from the 

Text is transmitted to other computers w ithout special type styles 
or format settings 

Files created u sing Multiplan or Chart can be 
telecommunicated from the Ma·c to other machines 
which use these programs if they are saved and 
transmitted under the SYLK format, a choice under the 
File menu's Save options for these programs. (SYLK 
files are explained in Chapter 4.) 

Mac v/Multiplan Multiplan 
SYLJ< File 

101111111111 ~....:. ..... ~ 
IBM PC v/Multiplan 

Files saved under Microsoft's SYLK format can be 
telecommunicated to other computers which use the same 
programs 

You cannot send MacPaint or MacDraw fil es to any 
computer except another Macintosh. 
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Mac to I BM Mainframe 
"Mainframe" is a term applied to large computers, 

usually managed by a staff of computer operators and 
residing in a dust-free room of their own along with 
various attachments such as large disk drives, tape 
d rives, and printers. People from other offices can 
access the mainframe through terminals - monitors and 
keyboards which are wired directly to the main 
computer or which communicate with the computer 
over the phone lines. One of the most fa miliar examples 
of a terminal hooked up to a mainframe is the type 
used by an airline ticket clerk to make or verify your 
reservation . These terminals consist of a monitor and a 
keyboard; the "computing" function is performed in the 
mainframe computer. 

If your company uses an IBM mainframe fo r 
processing corporate files, you can use your Mac like a 
terminal to access the main computer and view or edit 
information stored there. You can also collect 
information from the mainframe into your Macintosh, 
then disconnect from the mainframe and use the 
Macintosh's own programs to process and edit the 
in formation . 

In order to hook u p to an IBM mainframe, you 
need MacTer111inal plus an additional piece of hardware 
ca lled "Apple Line" - a 3-pound 12"X1Y'X2" plastic 

D ~' o• ··· o -l!:)l - -
.......-...-~--~ 

Mac Apple Line IBM Mainframe 

An App/eLine translates information between the Mac and an 
IBM 370 mainframe 
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box - which translates information between the Mac 
and the mainframe. You don't need a modem if your 
Mac is in the same building as the mainframe. If it isn't, 
you need a modem in addition to the AppleLine in 
order to dial up the mainframe over the phone lines. 

The procedure for connecting to your company's 
mainframe, including passwords and file access codes, 
will be set up and published by your own data 
processing department. Once hooked into your 
computer, you will find many standard function key 
operations available through the Keyboard menu of the 
Appleline file provided on the MacTerminal disk. 

S File Edit Commands Settings Phone 

PF1 PF2 PF3 PFo PF7 PF8 PF9 PF 10 PF 11 PF 12 

PF13 PF14 PF15 PF20 PF2 1 PF22 PF23 PF24 

PA I PA2 Attn elete T~~ Insert Reset ~ Cl ear 

AppleLine's Keyboard menu shows standard 3278 terminal 
functions 

In addition, you can use MacTerm inal's Cut and 
Paste options to copy information from the mainframe 
into the Clipboard and, later, into other Mac programs 
like MacWrite or Mu/tip/an. You cannot transfer large files 
from the IBM to the Mac. The amount of informa tion 
that you can send or receive is currently limited by the 
size of the Clipboard or the Scrapbook, which is 
determined by the amount of space left on the disk. To 
transfer large files, you may need to cut and paste the 
file in smaller pieces. 
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There are a variety of commercial information 
networks that offer online databases. The Sou rce, Dow 

.Jones News/Retrieval and CompuServe are some of the 
largest in the country today. What are these commercial 
information services and what can they do for you? 

Commercial information services use large 
mainframe computers to store and manipulate just 
about every kind of information you can imagine. Some, 
like Dow Jones News / Retrieval, specialize in certain kinds 
of information . Dow Jones is an excellent source for 
fi nancial news, including the text of the Wall Street 
Journal, through w hich you can search for information 
from any article printed in that pap er over the last 
several years. The Source and CompuServe are more 
general-purpose services, offering you the latest news, 
weather, and sports from major newspapers, the flight 
schedules fo r all the major airlines, current stock quotes 
or commodity listings from all the country's major 
exchanges, electronic mail, on-line encycloped ias, free 
software, disk space to store your own files, and access 
to many games - instantly! 

You can connect your Mac to these commercial 
services through the telephone lines. Even though these 
large computers may be located thousands of miles from 
you and your Mac, you can often reach them by dialing 
a local telephone number in your area. 

1b find out about a commercial information service, 
you need to write or call the service for a start-up kit 
(see Appendix). For a small sign-up fee, you will be 
given the te lephone number to dial in your area, and a 
secret password that you must type into the computer 
in order to h ave access to the service. You are charged 
for the service by the amount of time you spend on
li ne. Most services charge under $10 per hour for non 
prime-time (evening) use. 

For example, to dial up CompuServe, you hook up 
your modem and start your telecommunications 
program as previously described in this chapter. After 
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dialing the local number for CompuServe, you will be 
asked (i.e., a message on the screen will prompt you) 
for your User ID - an account number which you will 
be given when you sign up for the service the first 
time. Next you will be prompted to enter your 
secret password - a code which protects you against 
unauthorized use of your account. Finally, the screen 
will display the opening menu of the service, from 
which you can branch in whatever direction you wish. 

,,o 

Poge CIS-1 

(..,mpuServe lnforMt1on Service 

I Hol/tQ Ser"V I CQS: 

:· Business & Finonc1ol 
3 Per sona I Coapu t i l'ICJ 
4 Serv ice5 for Profe~5 1 onal s 
~ The Elec tronic Ma ll ( t11l 

6 User lnforrt0 t ion 
7 Index 

Enter your selec tion numbQr , 
or H for aore lnfONIQtl on . . =• 

CompuSerue 

CompuServe's Opening Menu 

Any information which displays on your screen can 
be saved in a file on your disk for later reference. With 
the Command menu's Record Lines Off Top option 
selected, MacTermina/ will automatically accumulate lines 
into a disk file as they roll off the top of your display 
screen, and you can read that file or print it out at any 
time. 

If you don't want to save the information, use the 
Commands menu to set Don't Record Lines Off Top. 
Under this option, information w hich comes in over the 
phone lines will be displayed on the screen line by line, 
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and as the screen fill s up the oldest lines will roll off 
the top of the screen - you must read them while they 
are visible on the screen, because they will not be 
saved . 

In the beginning, you may find it convenient to 
print out all of your interactions with the information 
service, and use them for later reference. This way, you 
will be able to return to a section of the service's 
database quickly, without having to figure out all over 
again the proper menu selections or page numbers 
(used by some services). 

Electronic Mai I 

Another service available through these networks is 
electronic mail. It presents one of the most exciting 
capabilities available in the new world of 
telecommunications. You can send important documents 
across the country in seconds, and at a lower cost than 
most overnight express mail carriers. 

You can send a document file to someone who 
uses the same commercial service as you . Every user of 
these networks has a "mailbox". When you first log on 
the service, you will be notified if you have any mail 
waiting. If, for example, you have offices in several 
different cities, you may want to sign up each office on 
CompuServe. 

O ne of the largest electronic mail services is offered 
by MCI Mail, through whom there are a variety of 
deli very options for your mail. Business associates w ho 
are registered with MCI Mail can stay in close 
communication: as soon as you send a file from your 
Mac, it is instantly in the ir "mailbox" and they can 
retrieve the document at any time. They may simply 
read the file onscreen, or print it out. This may be 
especially helpful in dealing with suppliers with whom 
you place frequent rush orders. This option, however, 
requires that all parties involved check MCI for their 
mail regularly. 
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You can also telecommunicate a letter or document 
that will be delivered in the form of a printed letter. For 
instance, Federal Express and the United States Post 
Office can de liver printed copies of any document that 
you telecommunicate to them from your computer. 
Similarly, MCI will print out a h ard copy of your 
document on a high-quality laser printer for delivery to 
the address you specify. You can indicate delivery 
within 4 hours (if addressee is in ,certain major cities), 
delivery overnight, or delivery by first class mail. 

MCI MAIL 

Tex t : <Enter t ex t or transmi t f i l e . Type /on a l ine by i tsel f toenO. ) 

Oeor J . B. , 

The entire staff is terr ib ly excited obout th& ~a lw~ mGwting that wi 11 blil 
he:ld next month . Our $Qfes Manager , George Fischer , w1 I I be arr iv ing one or 
two days: ear I y . Vou c:an expec t our agenda mc•d 1 f i co ti ons to arri ve: by next 
week . 

Dani e l l e Oe labourt 

Vou may enter : 

READ to rev ielfl uour let ter 
RE AD PAPER to rev i ew your I e t ter for paper 
EOI T \ o correct your l e t t er 
SEND PO!i tal del 1very for paper, 1nstont electronic de:l 1very 
SEliO ON I TE OVERN I GHT cour I er for paper; PR I OR ITV e I ec tr on i c de I I very 
SEND 4HOUR FOUR- HOUR cour i er f or paper; PR I OR ITV e I ec tron i c de I i very 
HELP for O!:S i !t tonc:e 

COClllllOnd <or 11EllU or EXIT) . 

Sending a letter on MCI Ma il 

The role of telecommunications in everyday 
business is growing rapidly. As more and more people 
use com puters to help them perform daily business 
tasks, communications via computers will continue to 
play an increasing role in all of our Jives. 
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9 Presentations 

"Let us in no way mi11i111ize 
the opportunity, or the 
danger, involved. The 30 
minutes an executive spends 
on his feet formally 
presenting his latest project to 
corporate superiors are simply 
and absolutely the most 
important 30 minutes of that 
or any other managerial 
season." 
- Walter Kiechel III 
Fortune Magazine 

The purpose of preparing charts, diagrams and 
tables is to communicate information to others . The first 
part of this book sh owed you h ow to create the basic 
ingredients of your communication. This chapter offers 
some ideas on how to put the finishing touches on your 
graphics to prepare for your presentation to a group. 

You can make overhead transparencies from the 
Imagewriter printouts of your graphics by running them 
through a copy machine which can reproduce on clear 
acetate, or you can make transparencies directly through 
the LaserWriter. You can make slides of your graphics 
by sending a disk with your files to a slide service 
bureau which offers this service or by taking a 
photograph of them with your 35 mm camera. Finally, 
you can use the same disk files to create printed sheets 
to hand out to your meeting audience. 

With animating software you can even prepare a 
series of images for display on your Mac screen (or 
through a larger video projection), and have the series 
"play out" automatically on the Mac screen. (See 
Appendix for list of animating packages) . In this 
chapter we'll begin by reviewing the sources of material 
for your presentation, then we'll see what extra touches 
can be added to make a polished presentation . 
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Compiling Exhibits 

A full presentation set will probably include some 
exhibits which are mainly verbal - topic announcements 
or bulleted lists of points. You can use MacPaint or 
MacDraw to create these topic summaries using a fu ll 
range of typefaces and sizes. 

~~ 
1984Sales 

Review 

-i/-~ 
19850penings 
and Projections 

Topic summaries created with MacDraw and prillled on a 
LaserWriter 

In addition, yo ur exhibits may include files created 
using Mu/tip/an, Chart, MacProject, MacDraw and 
MacPaint. Look at the printouts from these programs, 
and decide whether you want to use them exactly as 
they are, or add your own finishing touches through 
MacDraw or MacPaint. 

Though Chart in particular offers many formatting 
and design options, the drawing programs MacDraw and 
MacPaint allow greater flexibility than Multiplan, Chart or 
MacProject provide on their own. MacDraw and MacPaint 
offer a wider variety of type styles, more freedom in 
selecting fill patterns and drop shadows, and unlimited 
sizing options for your charts and diagrams. 

180 



MAC AT WORK Presentations 

MacDraw 
Options Chart Multiplan MacProj~ct 

Adjust cha rt size Yes No Schedule 

Change type style Yes No Chart 
On ly 

Multiple.type sty les Yes No 

Change fill patterns No n/a No 

Re-arrange elements Yes n/a Schedu le 

Drop shadows No n/a No 

Co lor No No No 

Table of Formatting Options 

The dimensions and proportions you select for 
your printed charts may be affected by the final form in 
which they will be presented . For example, if you will 
be presenting your charts as slides or overhead 
transparencies then you want the words on the charts 
to be large enough to be seen when projected before 
your au dience. A larger size of type is called for in 
charts intended for projection than in those prepared for 
printed reports. The Chart program offers more options 
for setting type sizes than Multiplan or MacProject, but 
none of these programs offers types as large as 48 
points, offered by MacDraw and MacPaint. If you find 
the charting program's options too limited, you can copy 
the chart into MacDraw to get larger type or d ifferent 
type sty les. 

Mu/tip/an offers two options only for sizing - tables 
can be printed out Tall or Wide. You cannot select type 
size directly th rough Multiplan, but Multiplan tables can 
be copied into MacWrite or Wo rd files for additional type 
size and style options (see Chapter 4). The LaserWriter 
can produce crisp, readable lettering down to 3-point 
type - smaller than the smallest lettering on most 
business cards - but be careful in trying to reduce large 
tables down to fit small spaces; stay with the larger, 
10-12 point sizes if you expect everyone to be able to 
read your tables. Generally, tables with many rows and 
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Presentations 

columns of entries do not make very good projected 
images unless they are converted into a graphic 
explanation th rough Chart. 

The Chart program by Microsoft allows you to 
select the type size and style for your chart labels, and 
you can select from several styles of borders to frame 
your charts (see Chapter 1) . With Chart you can also 
adjust the size of the chart directly - up to 81/2 X 11-
using the same techniques that yo u use in MacDraw or 
MacPaint to change size. Finally, you have the option of 
printing the charts out Tall or Wide. If you copy the 
chart into MacDraw you h ave infinite possibilities -
including producing charts larger than one 81/i X 11 
page . 

4()() Net Sales 

300 

• 200 

100 

_Ei: 

Microsoft Chart lets you adjust the size of the chart directly 

Charts created with MacProject can be printed out 
either Tall or Wide. You can use the Timeline Scale to 
adjust the width of the Task Chart and Resource Chart, 
but only the Schedule Chart can be manipulated 
directly to fit your printout or aesthetic (see Chapter 2). 

Di?fini? 
M.a1·k.;.t.in9 Pl.an 

~ ......................... m ....................... ,f.t 
j Di?firri? M.:irki?tinq Phn ~ 
~ --------NOTE:::----- -- ~ 

~ ........................ '.11 ......................... a 
The task boxes of MacProject's Schedule Chart can be 
repositioned and enlarged or reduced using the mouse 
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Artistic Touches 

Presentations 

If you decide to enhance your charts by copying 
them into MacDraw, there are some simple rules to 
remember: 

• Be consistent. For example, if you are going to 
drop-shadow one pie chart, you ought to drop-shadow 
all your pie charts and probably your bar charts and 
project schedule charts as well. Use the same s ize 
lettering for all charts of equal importance and for all 
elements of equal importance within the charts. 

~\Gi 
1984Sales 

Review {Jt:j 
~EJ§l§I~ \J5 

~\Gi 
1985 Openings 
and Projections 

M1llrons ~\~I Net Sales 
400 j 

:~~i§§l.~. 111.11111 . lil. 
1981 1982 1983 1984 1985 

Four types of exhibits treated for "consistency": 

• Be simple. Don't go wild using every type style 
available. A busy, complicated drawing will distract your 
audience and weaken you r impact. Graphic artists tend 
to stick wi th on ly one typ eface and no more than three 
sizes throughout a ch art. Use the same one or two type 
styles throughout the entire presentation . 

• Use upper- and lower-case lettering. It is easier to 
read than all caps; use boldface or size for emphasis 
rather than typing anything in all caps. 
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MacJ'<o I 

~ 
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Mac!)"" 

Charis created with Chart and MacProject can be enhanced 
through MacDraw 

Overhead Transparencies 

II 

9 l/Z 

Ovorhead Transpa.rtncy Proportions 

"' 
N 

If your presentation will be shown using an 
overhead projector, here are some restrictions to bear in 
mind when you create your graphics : 

• Overhead transparencies are usually 81/2 X 11 
inches, but the image itself should measure no larger 
than 71/2 X 9 1/z inch es. Some transparencies come with 
opaque borders which frame the image at exactly 71/z X 
9 1/z, in which case the image itself should be sligh tly 
smaller. 

• The original for an overhead transparency should 
be easy to read from ten feet away (ie. , slightly further 
away than the distance yielded by the formula for 
slides, below). For most audiences, this means that 
important wo rds should be no smaller than 36- or 
24-point size. 

81/2 

For overhead transparencies, 0 
an 8.SXll in ch image should be easy to r ead 

1-

- ----f-ro-m ten feet av_a_y·------4 11 

10 Feet 

Overhead Transparency Proportions 
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Presentations 

• When it comes time to set up your transparency 
projector in the board room, there's a simple formula fo r 
determining how far away the farthest chair should be 
placed from the screen for viewing: Multiply the width 
of the projected image by six. For instance, if the 
projected chart is three feet wide, no one should be 
seated farther away than eighteen feet. 

If the projected image is three feet vide, 3 Feet 
no one should sit further than 

eighteen feet avay. 

t--------18 Feet-----t 

Formula for positioning p ro;ector 

Overlays 

If you are using overhead transparencies, you can 
make overlays for some of the charts. In other words, 
one transparency might begin by showing only part of 
the information . During the presentation, a second 
transparency will be laid over the first to show 
additional information. It's easy to make overlays with 
the MacPaint or MacDraw. 

Create the full image as it would appear with all 
ove rlays down. Save the file th is way! Then, use the 
Edit menu to Select All and Copy the entire image into 
the Clipboard. Next, use the Layout menu to Reduce to 
Fit and Paste duplicates of the full image onto the new 
pages - as many pages as there will be transparencies 
in the set (the first transparency plus each overlay). You 
can use the Layout menu to adjust Drawing Size (i.e., 
add more pages to the drawing file, one fo r each 
transparency). 

In the first copied version, delete the parts of the 
image which do not appear on on the first overhead. In 
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Slides 

i-

Slide Propor tions 

Handouts 

N 

' 

Presentati ons 

the second copied fi le, delete every thing except that 
which is to appear on the fi rst overlay, and so on with 
other overlay files. 

For large audiences, or a presentation that has to 
travel a Jot, you may want to use slides rather than 
overhead tra nsparencies. If so, here are some useful 
pointers: 

• 35mm slide frames usually have a 35mm X 
24mm clear window. Projections of this image will 
always be in this proportion . It's a good idea to design 
your graphics to take advantage of this 3:2 proportion. 

• For s lides, if the original image can be read 
easily from a distance of eight times its height, then it 
will probably project well. An 8.5 X 11 inch image 
should be easy to read from seven feet away. For most 
audiences this means that important words should be 
no smaller than 18- or 24-point. 

8 l/2 

For slides, 0 
an 8.5Xll inch image should be-e-as-y-to-r-ea- d--1 11 from seven feet away. 

1---- - --- 7 Feet 

Slide Image Proportions 

Depending on your audience and the purpose of 
your presentation, you may want to distribute copies of 
your exhibits to the audience. They can make notes on 
these papers as you give your presentation, and review 
the h andouts later to study or remember what you sa id . 
You can, of course, simply make photocopies of your 
overheads or slide images and d istribute the set as 
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handouts . Alternatively, you can create a text file w ith 
additio nal notes about your presentation, or create a 
detailed report, and merge the graphic images w ith the 
text w here appropriate . 

~ 
MS0...1 

-~\/ 
't T • ' ~< 

----- ------ --- ------- -- ----
' \.\/,- ·- -~ 

,_ __ ____, - - - - Mac:W11t1> 

- -~--~- MS Word 

Charts created w ith Chart , M acProject, MacDraw and MacPaint 
can be copied into M acWrite and Word text files 
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Chapter 
10 Annual Reports 

"For just as it is discreditable 
to put dow11 what is 11ot 
ow11ed, so it is dishonest 11ot 
to put down what you do 
owe. For his accounts are just 
as 111uc/1 condem11ed who 
omits to make a11 entry of t/Je 
tnlf/1, as his who puts dow11 
what is false." 
- Marcus Tullius Cicero, 

Famous Ro111a11 Nobleman 

Any business with more than one or two 
stockholders and past the start-up stage needs to report 
its business status regularly to its owners. The 
traditional vehicle for this communication is the 
quarterly or annual report. The annual report is usually 
a glossy PR-type brochure. It's often typ eset and printed 
in color on good quality paper, and includes some 
narrative explaining the company's view of itself within 
its industry. 

We have already seen, in the chapters in Part I of 
this book, how to create the basic elements of any 
report: tables, text, charts and diagrams. Here we pull 
all these elements together into one document. Though 
we focus on only two reports in this chapter - an 
informal quarterly report and a more formal Annual 
Report - you can use the tips in this chapter to produce 
any business report. 

The Report in this chapter was created using 
MacWrite, MacDraw, Microsoft Mu/tip/an , and Microsoft 
Chart on the Macintosh. We review the procedures for 
printing the Annual Report out through a LaserWriter 
and for typesetting the entire Annual Report from disk 
files using MacTerminal to telecommunicate the text to 
our typesetter through the modem (See Chapter 8). 
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A Simple Quarterly Report 

The backbone of quarterly and an nual fi nancial 
reports is the Balance Sheet - a breakdown of the 
company's asset value matched against its liabilities and 
stockholder's equity - and related notes about the 
company's current status. 

Balance Sheel as of December 31, 1985 

ASSEI'S 

Ca<;li 
Short-term Investments 
Receivables 
Securities 
Long-term Investments 
Real Estate 
Equipment 
Other Assets 

TOTAL ASSETS 

Nou:s 

5,701,00> 
2 34,080,000 
3 6,163,00> 
4 131,000 
5 250,000 

2,6 25,079,000 
2,6 1,097,000 

16,787,000 

s 89,288,00> 

LI ABILITIES & STOCKHOLDERS' EQUITY 

PayabletoBanks 
Accounts Payable 
&Accrued Expenses 
Accrued Employee Salary 
& Benefits 
Long-te.rm Debt 

TOT AL LIABILITIES 

Stockholders' Equity: 
Common Stock 
Retained Earnings 

STOCKHOLDERS' EQUITY 

TOTAL LlABILITIES 
&EQUITY 

6 

7 

8 

$ 

18,599,000 

8,251,000 

4, 131,000 
1,375,000 

32,356,000 

405,00> 
24,171 ,000 

24,576,000 

s 89,288,00> 

Balance Sheel, or Statement of Financial Condition 

The categories shown on a Balance Sheet are 
explained in detail in Chapter 4. All you need to add to 
the Balance Sheet created in that chapter to make it 
complete fo r a quarterly report is the text which goes 
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with the note numbers shown in the second colum n. To 
do this, use MacWrite or Microsoft Word. Work w ith a 
simple single-spaced , left-aligned paragraph format to 
create the notes shown here. 

Notes to 
Financial 
Statement 

NOTE I. Summary of Significant Accounting Policies: The financial 
s1a1cmen1s include the accountS of TAG Corporation and 
Moore & Moore. Inc .. which was merged in10 1he TAG 
Corporation upon acquisi1ion in Marth 1985. 

NOTE 2. Shon·term investments and propocrty and equipment 
purchases are made with the advice of Hannah P. Marks & 
Company. a financial manaccmcnt firm. 

NOTE 3. Receivables as slated here do not include internal cost 
accounting rela1ed 10 TAG purch a.~es of inventory from the 
Moore & Moore Division. 

NOTE 4. Sccuri1ies include inves1men1s carried over from Moon: & Mcne. 

N otes to Statement of Financial Condition 

Use Microsoft Chart to illustrate some of the points 
in the notes, as appropriate. 

Basic Revenues 

Acquisitions Help 
Stability 

50 
0 -1-~-f<-~-+~__,1--~+-~-+-~--i 

! st 2nd 3rd 4th I st 2nd 3rd 
Qtr Qtr Qtr Qtr Qtr Qtr Qtr 

19 83 -19 84 
Revenues from New Acquisitions 

Chart enhanced through MacDraw 
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As Chairman of the Board, you ought to add a 
cover letter with more remarks about the company's 
current position and future goals. In a simple quarterly 
report, the notes and message from the chairman may 
be the only text which goes with the Balance Sheet. In 
an annual report, the message from the chairman 
introduces the longer text in the body of the report . 

Millions Net Sales 

1981 1982 1983 1984 1985 

Dccembe r21, 1985 

To Our Shan:holders: 

Fiscal 1985 was the tenth year of operation for TAG 
Corporal.ion. It was a year of transition, in which 
TAG acquired Moore & Moore, a toy manufacturing 
finn. This merger has enabled us todevclop ToyTech 
Shops in twelve shopping mzlls this year, launching 
TAG 's e ntry into the re tail toy marl<.cL 

Net Sales increased from S275 million in 19R4 to 
S378 million in 1985, due in large pan to the 
introduction of the QP Doll robot series, which 
yielded over S50 million in this fim year of sales. 

We appreciate your confidence , and look forward to 
seeing you at the annual meeting . 

.-------.......,~------.,, for the Board of Directors 

(Million$) 

J.B. Morless 
Chairman 

Tag Corp. Sales History 
3500,--------------~ 

3000,-----------~~ 
2500 ~ 

2ooq;q !!!!!!~!!!!e!!i!!!!!~•::· a:~.-=~:=:~~'.:==== I 506' 
100~1--------------

soo---------------
O,'-~-~-~~-~~-~-~~ 

1976 1977 1978 1979 1980 1981 1982 1983 1984 1985 

A Message from the Chairman (printed on a LaserWriter) 

The pages in this quarterly report are printed 
individually us ing the tools which created them: 
Multiplan, Chart, and MacWrite. The next sections of this 
chapter show how several fil es can be combined into 
one document fil e for continuous output through a 
LaserWriter, or (alternatively) how text can be 
telecommunicated to an outside service for typesetting. 
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An Expanded Annual Report 

Earnings per Share Nel Proft1 

\ / 

Cover 

There are two significant differences between a 
quarte rly report and and annual report : 

• The Annual Re port usu ally includes some 
s tatem ents about the company's his tory and future 
direction as intended by the Board o f Directors and 
m anagement, w hereas the quarte rly report merely sta tes 
and annota tes the financia l s tatus o f the organization. 

• The Annua l Report is often a g lossy, typ eset, 
printed document, w hereas th e qu arte rly report may be 
a brief p rinted brochure or a photocopied document. 

With the M acintosh and the right accessories, it is 
possible to produce a complete Annual Report w ith 
graphics and typeset text. H ere we d emonstrate two 
ways of achieving this : us ing MacWrite and a LaserWriter 
printer, or u sing MacTerminal a nd your local typesetting 
sh op . 

In all, e igh t ind ivid u al files a re ingredients to this 
Annual Report. 

L, 

-- ___ ........._ ------

Annual Reper t Text 

...,.-<111~---ln-co-me_S_ta-tem_c_nl ______ &_l~-c-·e-S•m_•_· ___ ~ 
C~1nges 1n Pos111on 

Files comprising the Annual Report 

As w ith the quarte rly report, you can p rint out 
each e leme nt of the Ann ua l Re po rt using the p rogram 
which created it : MacWritc (or Word), Mu ltiplan, Chart, 
and MacDraw. As an alternative, you can paste all the 
elem ents of the report into o ne file a nd work with 
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special formats such as two-column text. Which option 
you select depends in part on the method you will use 
to produce the final "camera-ready" version (i.e., the 
version you would take to the local printer for mass 
production). 

• If you are using MacWrite and MacDraw, you can 
print the final copy on a LaserWriter printer, which 
prints at higher resolution than the dot-matrix printer. If 
you use the Times and Helvetica typestyles available 
through the LaserWriter, your report will look as good 
as any typeset report to the average reader. 

• If you do not have access to a LaserWriter, or if 
you want to use type styles other than Times and 
Helvetica, you can transmit the file to a typesetter, using 
MacTerminal and a modem. Under this option, you will 
need to print the ch arts and graphs out separately and 
paste them into the typ eset text by hand (i.e ., by 
traditional graphic production methods) where 
appropriate. 

• You can print the final copy at high resolution 
on the dot-matrix printer. This option is avai lable 
whether you use MacWrite or Word . Both these programs 
let you paste charts and drawings into the text itself, so 
you can print out the entire report as one document on 
the ImageWriter. Remember that the output quality of 
the ImageWriter (or any other dot matrix printer) is not 
appropriate for most annual reports. This may be 
adequate for owners of small businesses and their 
bankers or backers. 

LaserWriter Typesetting 

If you are using MacWrite, MacDraw, and a 
LaserWriter printer, you can paste your text and 
graphics together into one file and print the whole 
Annual Report out as one document which has the 
appearance of being typeset - i.e. , the text and 
graphics will be less "jagged" when viewed at close 
range, and the spacing between letters will be finer than 
with an ImageWriter printout. You will not need to use 
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scissors and glue to paste the ch arts into the stream of 
text, as required by the procedure described in the next 
section (Electronic Typesetting). 

Laser Writer 

Annual Reporl cover printed on a LaserWriter 

In order to print your report out through a single 
file, you can either paste your text and graphics into a 
single MacDraw fi le, or you can paste your charts and 
graphs into a single text file. Let's look at the differences 
between these two options. 

If you want MacWrite to lay out your pages fo r you, 
including running headers and footers, you can paste all 
your charts and graphs into the text file. In this case, 
you must decide what size each chart will be before 
copying the chart into the text file. (In fact, you can 
change the s ize of drawings after they have been pasted 
into MacWrite, bu t in practice it is best to size the 
drawings w hile th ey are still in MacDraw where you can 
make fine ad justments to type s ize and styles.) With 
Microsoft Chart you adjust the size of the chart d irectly 
on the screen (see Chapter 1). Charts can also be sized 
through MacDraw. 

Merge the MacDraw, Mu/tip/an and Chart files into 
the MacWrite fi le to create one fu ll document fil e. You 
can move the graphic to the right or the left w ithin the 
text fil e by adjusting the margin setting for the graphic 
"paragraph ." 
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Mac Write 

Paste text 
from MacWrite 
into columns 

MacDra" 

Annua l Reports 

Using this approach, you can go back and make 
major changes to the text easily - MacWrite will 
automatically re-paginate all the pages for you . 
However, you cannot edit the charts and graphs once 
they have been pasted into the text file, and you cannot 
print two-column text directly through MacWrite. 

To paste text into each column, Copy the text from 
the MacWrite file into the Clipboard, then open the 
MacDraw file, select the rectangle which frames the 
column into which you are pasting, and Paste the text 
from the clipboard into the column. If the text is too 
long to fit on the page, you can Cut the overflow to the 
clipboard and Paste it into the rectangle in the next 
column. 

If your Annual Report text is very long, this 
paste-up process may take a considerable amount of 
time and thought - its a good idea to have the text 
finalized before you go these steps, since major changes 
will require another major paste-up session. However, 
by pasting the text into a MacDraw file, you will h ave 
greater flexibility in editing and re-sizing your charts 
and graphs at the last minute. 

If you expect to do very much formal document 
production as required by the Annual Report, you may 
find it more efficient to work with the help of programs 
written specifically to help you lay out pages for the 
LaserWriter, such as PageMaker by Aldus Corporation. 

Using MacWrite and MacDraw, you can print your 
report out directly to a LaserWriter, including all the 
graphics exactly as you pasted them up on the screen. 
All of the type styles and graphics look crisp with the 
LaserWriter's 300-dots-per-inch resolution (compared to 
the ImageWriter's 120-dots-per-inch). What's more, the 
LaserWriter offers true Times and Helvetica type 
styles - if yo u use these two type styles exclus ively, 
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Electronic Typesetting 

Annual Reports 

your entire document will have the appearance of a 
typeset document for most readers. (I've known some 
professional typesetters, graphic artists, and printers 
who were unable to detect the diffe rence!) 

Whether you use MacWrite or Word to create your 
text files, if you don't have a LaserWriter you can 
transmit your text to any typesetting shop wh ich accepts 
text files over the phone lines. You'll discover that by 
telecommunicating the text, you save the typ esetter's 
time (and therefore some of your money) because they 
don't have to type the words for you - all they need to 
do is type the codes for type styles and formats. (If you 
plan to typeset your files regularly, you can learn to 
type these extra codes yourself before you send the file 
to them .) You also save some time in proofreading and 
correcting errors. The words will be typeset exactly as 
you typed them - if they were error-free when you sent 
them, they should be error-free when you get them 
back from the typesetter on glossy, phototypesetting 
paper. 

Most typesetters will not be able to reproduce your 
Macintosh type styles exactly, so you will need to select 
other type styles from the typesetter's catalogue. For 
formal reports, as most Annual Reports are, typesetting 
through an outside service is a must (unless you have a 
LaserWriter). Unfortunately, most typesetters cannot 
handle computer graphics directly, so you may need to 
resort to scissors and glue to paste up the final report . 

You can give graphics which are printed on an 
ImageWriter a crisper look by printing them out large r 
than the desired final size, and getting photostats of 
them at the reduced size. Photostats are made by 
lithographers who can photograph your original 
printout and develop the images - in any size you 
wish - on glossy, photo-sensitive paper. 
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Ch apter 8 offers some examples of attaching your 
Mac to the phone lines (through a modern) a nd using 
MacTerminal to send a fil e to another computer. 

Finally, w hatever method yo u use to produce the 
first full original of you r report, you will probably be 
taking it to a printer to be reproduced. You choice of 
paper stock a nd ink colors w ill be the final "dressing" in 
the production . 

Annual Report Cover 
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Chapter 
11 Business Proposals 

"The primary problem in 
writing a busi11ess plan is 
making it comprehensive and 
shaping it for the reader for 
whom it is intended - the 
prospective investor with five 
minutes to read it." 
- Joseph R. Mancuso 

From the beginning of time, men have been cutting 
deals. For thousands of years, careful investors have 
insisted on being shown that the deal had been well 
thought out and was likely to succeed before putting up 
the money to capitalize the project. Badly designed 
pyramids or inadequately-planned palaces would not get 
the money needed for such vast projects. Today the 
sponsors of great ideas are kind uncles, venture 
capitalists and banks. 

You occasionally hear stories of an all-star 
management team with a proprietary product and a 
ready market writing a winning plan on the back of a 
damp cocktail napkin . Told correctly, the stories would 
go on to say that the "stars" still had to go back and 
write a formal plan before they got their cash. 

Most companies prepare a business plan so that 
everyone involved can have a common view of the 
business goals. The process of writing a business plan 
requires a lot of careful thinking about your business. 
Unfortunately, many small businesses never bother with 
a formal (i.e., written and neatly summarized) business 
plan until they need money for expansion or transition. 

O ne of the features that distinguish the Business 
Proposal from other reports is that the Business 
Proposal is the beginning of something, rather than a 
summary of what has already occurred. After 
completing a Business Proposal, you still have a sense 
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"It's a fact of life that most 
sma// companies with sales 
under $25 million just plain 
don't have written business 
plans .... Many businesses fly 
blind. Some businesses in 
manufacturing don't even 
know what their costs arc 
going to be." 
- Howard Mi//er 

Peat Manuick 

The Summary 

"The first 30 seconds (of 
reading a proposal) are about 
as important as those first 
few seconds of eye contact 
when people are romancing." 
- Bi// Lanphear 

Early Stages Company 

Busi ness Proposals 

of urgency about it ("If only they will read it. .. ") rather 
than the sense of relief that follows writing a status 
report, for example. The specifiC purpose of the 
business proposal is to help you win an interview with 
the reader. 

For this reason, it is especially important to 
consider your audience in writing a Business Plan. If, as 
Mancuso suggests, you are writing for the five-minute 
reader, then the graphic capabilities of your Mac will 
help you make your point. You need to show clearly 
and concisely what your product is, what the current 
market for that product is like, income/expense 
projections, your team's skills, and how much money 
you need. 

The Business Proposal format presented in this 
chapter can be carried over easily to many different 
kinds of financial reports for clear, effective presentation. 

In this chapter we start with the proposal summary 
as an example of text, and then look at examples of the 
ingredients to the proposal which can be prepared using 
the graphics capabilities of the Macintosh. 

The summary is the single most critical section of 
the entire Business Proposal. It is the first section which 
anyone reads. An investor's or loan officer's decision 
about w hether to read the rest of the document is often 
made within the first five minutes. 

The summary should include highlights from each 
section of the proposal: the characteristics of the 
business and the industry, the terms of the deal, the 
financial condition and caliber of the people 
participating, and the unique features of this deal. 
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General De1crlption 

Business Proposals 

ToyTech shops wiJJ be located in 
urban shopping districts and suburban 
shopping malls offering a unique selection of 
high-tech toys and games. TAG 
Corporation's research experience has shown 
that sales will run approximately 24 percent 
computer games. 17 percent robotics. 7 
percent sports-related games. and 6 percent 
board games, with the other 47 percent in 
modelling sets and educational toys and 
games. 

Due to their location in busy 
commercial/ areas, ToyTech Shops will 
derive most of its business from affluent 
urban professionals. During the holdiay 
seasons, contests and sale ·· specials" will be 
offered to create business volume. 

ToyTech Shops will be moderate in 
size: approximately one thousand square 
feet. The store design would utilize state
of-the-art display finures. and walls and 
counters will be painted with designs by 
Mik.ayo of Japan. 

The first ToyTech Shop will open in 
Pleasant Valley Mall, Burbank, California. 
Store hours will be Monday through 
Saturday from 11 :30 A.M. until 9 :00 P.M. 
daily. 

Summary Page of Business Proposal 

Use MacWrite or Word to produce the summary 
shown here. There are two important things to note 
about this format, which carry throughout the text of 
the proposal: 

• Don't use every type style available - pick only 
one or two and stick with them throughout the text. For 
example, if you select two s izes of New York type for 
the text - 12 and 14 point - and use these two fonts 
throughout the proposal, using Geneva type only for 
figure text and titles. 
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• Don't try to pack as many words as might fit on 
one page just to save paper - use wide side margins, let 
some pages end short. "White space" on a page gives 
the eye relief and makes the text seem less formidable. 

Current and Future Business 

Include a section of narrative text which describes 
your current business and how your business will 
change during the proposed expansion or transition . 
Use bulleted lists to show your range of products and 
your major clients or market segments. You can illustrate 
the major events in your history and plans using 
MacProject. (See Chapter 2 for details on using this 
program .) 

+ mRr ToyTech Shop Deuelopment Plan 
~fine Concepl 

~l/Rn11rch Proposed Inventory 

~fine Accounlfn9 System A.1Q ulr1m1nts 

I oer1~· l•111 Morketln9 Pion 

~ftne Olsptly and Stor191 Spice Needs 

I ReQues t PropoJ~l' tr<J. PR Firms 

I Develop P ilot Accounltn9 Syst~m 

I RequeH PropoJ11s from Sp1c1 Des igner s 

I Resurch/Flndl soau to lease In Pluunt V1l11y 

~ fi rst J -yur bud91t projtclion 

+ Alloc1 le Fut'lds 

J Implement Adverth ln9 &. Sl9n19e Pl1n 

I Orde r lnvenlork 

I Hi r e Floor s11fr 
I Implement Space Oesl9n Contrafl I 

Page of Business Proposa l, from Project program 

• GRANO OPENING 

Note that the time scale on the Task Chart is in 
months here, making the chart more concise and 
therefore suited to the five-minute reader. The same 
chart may be printed with a finer scale - weeks, for 
exam ple, for the project manager and for proposal 
readers who ask for more detail. 
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Marketing & Financing 

"If a detailed descriptio11 of 
the co111petitio11 is11't i11 there, 
!'111 willing to turn it down 
on the spot." 
- Roger Borovoy 

Sevin Rosen Bayless & 
Borovoy 

Management 

Business Proposals 

The Marketing and Financing sections in particular 
will benefit from the inclusion of charts which 
summarize the narrative and highlight the important 
points. 

The Marketing Plan section should show your 
"intelligence" about the competition and the overall 
market, as well as a description of your own strategy. 
The important numbers shown in each graphic 
illustration are mentioned in the narrative which 
references the chart. 

47~ 

Major Toy Retailers· 
Shares of the Market 

1984 
6X • Big Kids 

1111 PlayShops 

17" mil Fun & Function 

121 Computer 
Playhouse 

D other 

Pie Chart of market shares 

Some readers will jump ahead to the Management 
Team section immediately after reading the summary
before going through the (usually longer) sections 
describing the business itself and the marketing strategy. 
For the five-minute reader, this section can include 
graphic illustrations which show the organization chart. 
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In the section describing your management team, 
highlight some of the experiences detailed in the 
resumes at the end of the proposal, but focus on each 
team member's actual role in the future of this venture. 

Ron Turnell 
VP Ma1koM9 & Salos 

Bud Stark 
Eastern Region 

~lary Questor 
Eastern Admin 

Organization Chart 

J.ll. Morless 
Presidonl & CEO 

Elana Driggs 
VP Adminsiltation 

Helen Dale 
Personnel 

Carol Adler 
Ciofical Group 

Mike Murra}' 
Shipping 

Murla Urundonls 
Complrollor 

Robert I rons 
VP Produclion 

Allen Sharp 
Main Plan! 

Jon Lillie 
Aspen Planl 

In the organization chart and in expense 
projections, include planned hires - but don't bother 
describing future draft ch oices in the narrative - real 
people whose identities cannot be divulged. You may be 
convinced that the right people will be ready when you 
need them, but professional lenders and investors have 
already seen too many such promises fa ll through. They 
want to know who is actually working with you now. 

Financial Statements and Projections 

Don't try to impress the reader with pages of 
computer-generated projections and financial statements 
with long-term forecasts down to the penny. Generally, 
readers expect to see projections of major categories for 
Sales and Cash Flow, quarterly for five years and 
monthly for the first year or so. 
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Resumes 

Business Proposals 

The resumes at the end of the proposal may take 
any form : biographica l narrative, chronological by 
categories (education, job history, publications and 
awards, etc.), or skills-oriented . 

Resume 

JB.Morless 

Delailed Resume Formal 

Some proposals which involve many different 
parties - some limited partnership proposals, for 
example - may reduce every participant's biography into 
a condensed-format paragraph, in the style of Who's 
Who and other d ictionaries. 

Resumes 

JB.Morless 

Marla Brandonis 

Ron Turnell 

Summary Resume Formal 
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Proposal Cover 

Business Proposa ls 

Proposal covers produced with MacPaint or 
MacDraw can include your company logo and other 
"special effects". Will yours look so good that the loan 
officer asks how much time and money it took to 
produce? He'll be amazed at how quickly and efficiently 
you can work with a Macintosh. 
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Business Graphics 

Appendix 

The following listing represents a partial directory 
of business products available for the Macintosh. This is 
not intended to be a comprehensive survey, as the 
number of new products available for the Mac is 
increasing at a staggering rate, and an exhaustive survey 
would be a book in itself. It should, however, offer 
some useful information for the new Mac owner 
embarking on the journey of purchasing software. We 
have included a brief description of each product and 
the manufacturer's suggested list price where 
appropriate. Before you make your final purchase 
decis ion, the information here should be supplemented 
with your dealer's advice or by product reviews which 
you can find in magazines. 

Animation Toolkit 
Ann Arbor Softworks, Inc. 
308 1/z S. State St. 
Ann Arbor, Ml 48103 
(313)996-3838 
Suggested List Price: $49.95 
Lets you construct animation sequences from images which are 
created in an environment similar to MacPaint's Fat Bits. 

MacDraw 
Apple Computer, Inc. 
20525 Maria ni Ave. 
Cupertino, CA 95014 
(800)538-9696 
Suggested List Price: $125 
Object-oriented drawing program. Creates flow-charts, d iagrams, 
illustrations, etc. 
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Database 

Maccessories Professional Type Fonts 
Kensington Microware, Ltd. 
251 Park Avenue So. 
New York, NY 10010 
(212)475-5200 

Append ix 

Suggested List Price: $99 . . . 
Conta ins licensed fonts (such as Helvetica, Optima) for Imagewnter 
in sizes 12 to 72. 

Microsoft Chart 
Microsoft Corp. 
10700 Northup Way 
Bellevue, WA 98004 
(206 )828-8080 
Suggested List Price: $195 
Creates different chart types: pie, bar, area, column, line, scalter, 
combination. Charts can be customized. 
Slide Show 
Maghum Software 
2115 Devonshire St. -337 
Chatsworth , CA 91311 
(818)700-0510 
Suggested List Price: $59.95 
Creates a continuo us running "slide show" of Mac screens w ith 16 
special effects. 

SoftForms 
Artsci 
5547 Satsuma Avenue 
North Hollywood, CA 91601 
(818)985-2922 
Suggested List Price: $39.95 
Helps produce a variety of business forms using MacPaint 
Tekalike 
Mesa Graphics 
P.O. Box 506 
Los Almos, NM 87544 
(505)672-1998 
Suggested List Price: $250 
Allows viewing of graphics generated by mainframes. Compatible 
with Te llagraph , Precision Visuals. 

DB Master 
Stoneware Incorporated 
50 Belvedere St. 
San Rafael, CA 94901 
( 415)454-6500 
Suggested List Price: $195 
Max . n umber of records pe r file is limited o nly by disk capacity. 
Max . number of fields pe r record-100. Up to 10 fields can be sorted 
o n simultaneously. 
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Desk Organizer 
Warner Software, Inc. 
666 Fifth Avenue 
New York, NY 10103 
(212)484-3070 
Suggested List Price: $250 

Appendix 

This filing cabinet and appointment calendar runs along with other 
applications and can be called up a t any time. 
Factfinder 
Forethought, 1 nc. 
1973 Landings Drive 
Mountain View, CA 94043 
(415)961-4720 
Suggested List Price: $150 
Creates a factsheet which stores data in a common bank. 
Keyword queries. 

Filevision 
Telos Software Products 
3420 Ocean Park Blvd. 
Santa Monica, CA 90405 
(213)450-2424 
Suggested List Price: $195 
Allows you to d raw a picture and lin k data to it. Max number fields 
per record-30. 

Helix 
Odesta 
3186 Doolittle Dr. 
Northbrook, IL 60062 
(800)323-5423 
Suggested List Price: $395 
Includes word processing, mailmerge, and spreadsheet. Data is 
stored in a common bank, accessed accord ing to user criteria. Record 
and field size limited by disk . 
Main Street Filer 
Main Street Software 
One Harbor Drive, Suite 304 
Sausalito, CA 94965 
(415)332-1274 
Suggested List Price: $249 
Includes mailmerge. Max. number of records per fi le-approx. 1000. 
Max. number fields per record-36. Sorts on up to 8 fields 
simultaneously. 

MegaFiler 
Megahaus Corporation 
5703 Oberlin Dr. 
San Diego, CA 92121 
(619)450-1230 
Suggested List Price: $195 
Creates files thats use the MegaMerge program to create mailmerge. 
Up to three different fi les can be open at once. 
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Finance 

Microsoft File 
Microsoft Corp. 
10700 Northup Way 
Bellevue, WA 98004 
(206 )828-8080 
Suggested List Price : $195 

Appendix 

Creates files that use the Word program to create mailmerge. Data 
transfer to Multiplan and Chart. Max. number of fields per 
record-1.024. 

Omnis 2 
O rganizational Software Corporation 
2655 Campus Dr. -150 
San Mateo, CA 94403 
(415)571-0222 
Suggested List Price: $195 
Includes mailmerge, report generator. Max. number fields per 
record-120. Sorts on up to 9 field s sim ultaneously. 
OverVUE 
ProVUE Development 
222 22nd St. 
Huntington Beach , CA 92648 
(714 )738-0746 
Suggested List Price: 5295 
Spreadsheet-type format. Max. number characters per field is 62. 
Max. number fields per record-64. 
PFS File 
Software Publishing 
1901 Landings Dr. 
Mou ntain View, CA 94043 
( 415)962-8910 
Suggested List Price: $125 
Max. number fields per record-3200. Uses cut and paste wi th other 
Mac appl ications. 
lstBASE 
DeskTop Software Corporation 
228 Alexander St. 
Princeton , NJ 08540 
(609)924-7111 
Suggested List Price: $195 
Relational database. Includes mailmerge, calculations. Max. number 
fields per record-100. 

Back to Basics Accounting System 
Peachtree Software 
3445 Peachtree Rd. , NE 
Atlanta, GA 30326 
(800)554-8900 
Suggested List Price: 5195 
Comprehensive general accounti ng system. Includes general ledger, 
several reports and journals. Generates checks, balance sheet . 

214 



MAC AT WORK 

CheckMinder 
Haba Systems 
15154 Stagg Street 
Van Nuys, CA 91405 
(818)989-5822 
Suggested List Price: $69.95 

Appendix 

Prints checks a nd sorts checks. Records payments and d eposits. 
Multiple checking accou nts allowed . 

Electric Checkbook 
State of the Art, Inc. 
3183-A Airway Avenue 
Costa Mesa, CA 92626 
(714 )850-0111 
Suggested List Price: S79.95 
Generates list of tax deductible expe nses, allows entry of income, 
expe nses. 

Home Accountant 
Contine ntal Software 
11223 S. Hindry Ave. 
Los Angeles, CA 90045 
(213)410-3977 
Suggested List Price: $99.95 
Allows 50 mon thly transations. Prints checks and includes loan 
amortization. 

Ledger 
Cha ng Labs 
5300 Stevens Creek Blvd. 
San Jose, CA 95129 
( 408)246-8020 
Suggested List Price : S99.95 
Displays a small company's income, expenses, assets, liabilities, 
estimated profits, and menu-prompted entries of payments. 

MaclnTax 
Software 
400 Mobile Avenue, Bldg. D., Suite C 
C 1marillo, CA 93010 
(805)388-2626 
Suggested Lis t Price: S70 
Allows prepa rat ion of Form 1040 and 8 additional forms 
a nd schedules. 

Tax Wizard 
Gamma Productions 
817 10th Sh·eet, Suite A102 
Santa Monica , CA 90403 
(800)851-9009 
Suggested Lis t Price: $65 
Allows prepa ration of Form "I040 and 20 add itional forms 
a nd schedu les. 
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Information Services 

Integrated 

Market Manager PLUS 
Dow Jones Software 
P.O. Box 300 
Princeton, NJ 8540 
(800)257-5114 
Suggested List Price: $199 

Appendix 

Maintians u p to 26 stock portfolios. Automatially assigns prices to 
your protfolios from the Dow Jones Current Quotes data base. 

Personal Financial Planning 
Apropos Software, Inc. 
64 Hillview Dr. 
Los Altos, CA 94022 
( 415)948-7227 
Suggested List Price: S29.95 
6 Modules @ $29.95, plus Real Estate Prop. Planner $49.94, Life Ins. 
Planner 39.95. 

CompuServe 
CompuServe Information Service 
5000 Arlington Center Blvd. 
Columbus, OH 43220 
(800)848-8199 
General information service including electronic mail, on-line news, 
weather, s tock quotes, and a large variety of Special Interest Groups. 

Dow Jones News/Retrieval 
Dow Jones Company 
P.O. Box 300 
Princeton, NJ 08540 
(800)257-5114 
Financial information service. Includes stock quotes, text search of 
Wnll Strecl ]011rnnl , investment services. 

The Networkers 3500 Market St., # 103 
San Francisco, CA 94131 
(415)550-1710 
Online consultants answer Mac questions. Mac online newsletter 
includes extensive product reviews. 

The Source 
The Source Company 1616 Anderson Rd. 
Reston, VA (800)336-3366 

Jazz 
Lotus Development Corporation 
161 First St. 
Cambridge, MA 02142 
( 617)492-7171 
Suggested List Price: $595 
Combines word processing, database, communications, spreadsheet, 
and graphics. 
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Printer Drivers 

Sales 

Hanzon Unive~sal Card 
Hanzon Data, Inc. 
18732 142nd Ave. NE 
Woodinville, WA 98072 
(206)487-1717 
Suggested List Price: $129.50 
Connects Mac to Epson printers. 

Mac Epson Connection 
Assimilation Process 
20833 Stevens Creek Blvd. 
Cupertino, CA 95014 
( 408)446-0797 
Suggested List Price: $89 
Connects Mac to Epson printers. 

Mac Daisywheel Connection 
Assimilation Process 
20833 Stevens Creek Blvd. 
Cu pertino, CA 95014 
( 408)446-0797 

Appendix 

Suggested List Price: $99 
Allows the Macintosh to print w ith any popular daisy wheel (letter 
quali ty) printer. Includes disk and cable. 

Communication Edge 
Human Edge Software Corporation 
2445 Faber Place 
Palo Alto, CA 94303 
( 415 )493-1593 
Suggested List Price: $195 
Helps improve your written and spoken communications. 
Mind Prober 
Human Edge Software Corp. 
2445 Faber Place 
Palo Alto, CA 94303 
( 415)493-1593 
Suggested List Price: $49.95 
Helps you understand and predict the behavior of others. 
Sales Edge 
Human Edge Software Corp. 
2445 Faber Place 
Palo Alto, CA 94303 
( 415)493-1593 
Suggested List Price: $250 
Helps improve your approach with indidual customers. 
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Scheduling 

Spreadsheet 

Appendi x 

The Negotiation Edge 
Human Edge Software 
2445 Faber Pl. 
Palo Alto, CA 94303 
( 415)493-1593 
Suggested List Price: $195 
Prepares you to work through and successfully complete 
negot iations. 

Desktop Calendar 
Videx Inc. 
1105 N.E. C ircle Blvd . 
Corva lis, O R 97330 
(503)758-0521 
Suggested List Price: $89 
Calendar and appointment book. Sounds alarm through 
Mac's speaker. 
Habadex 
Haba Systems, Inc. 
15154 Stagg St. 
Van Nuys, CA 91405 
(818)989-5822 
Suggested List Price: $199.95 
Provides monthly overviews and day-at-a-glance scheduling. "Th ings 
To Do" List. 

MacProject 
Apple Computer 
20525 Mariani Ave. 
Cu pertino, CA 95014 
(408)996-1010 
Suggested List Price: $US 
Project planning including critical path, resource allocation, 
Gantt charting. 

Multi plan 
Microsoft Corp. 
10700 Northup Way 
Bellevue, WA 98004 
(206 )828-8089 
Suggested List Price: $195 
Well-known spreadsheet which works with Micorsoft's Chart. 
TK! Solver 
Software Arts, Inc. 
27 Mica Lane 
Wellesley, MA 2181 
(617)237-4000 
Suggested List Price: $299 
Sophisticated spreadsheet system adapted for the Mac. 
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Telecommunications 

Word Processisng 

Habadex Plus Com for Macintosh 
Haba Systems 
15154 Stagg Street 
Van Nuys, CA 94105 
(818)989-5822 
Suggested List Price: $139.95 

Append ix 

Habadex schedul ing program combined wi th te lecommunicatio ns. 
Data Talker/Mac-3270 
Winterhalter, Inc. 
3853 Research Park Drive 
Ann Arbor, Ml 48106 
(313)662-2002 
Suggested List Price: $1095 
Allows the Mac to emulate the IBM 327/3277, 3274/3278, 3275, and 
3276/3278 interactive terminal systems. 

Straight Talk 
Dow Jones Software 
P.O. Box 300 
Princeton, NJ 8540 
(800)257-5114 
Suggested List Price: 579 
Used w ith Dow Jones News/Retrieval and other information 
networks. 

MacWrite 
Apple Computer 
20525 Mariani Ave. 
Cupertino, CA 95014 
(800)538-9696 
Apple's word processing progrn m uses fonts, cut and paste 
capabilities. 

Microsoft Word 
Microsoft Corp. 
10700 orthup Way 
Bellevue, WA 98004 
(206)828-8080 
Suggested List Price: $195 
Pop-down menus s implify this version of a sophisticated text 
processing program designed for IBM PCs and other DOS-based 
systems. Includes merge capabilities. 
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Miscellaneous 
AgDisk Agricultural Programs 
Harris Technical Systems 
624 Peach St. 
Lincoln, NE 68501 
(402)476-2811 
Suggested List Price: $95 

Appendix 

Multiplan templates designed for management of feed and finances 
for crops, cows and swine. 

Construction Estimator 
Reston Publishing Company 
11480 Sunset Hills Rd . 
Reston, VA 22090 
(703)437-8900 
Suggested List Price : $69.95 
Used with Multiplan to calculate construction costs. 
Electronic Pad 
Rune Enterprises, Rune Software 
80 Eureka, Suite 214 
Pacifica, CA 94044 
( 415)355-4848 
Suggested List Price: $395 
Integrated Computer Aided Design and engineering package. 
Expert Ease 
Human Edge Software Corporation 
2445 Faber Place 
Palo Alto, CA 94303 
(800)624-5227 
Suggested List Price: $295 
Builds decision trees based on your experience and knowledge. 
Machinery Management 
Harris Technical Systems 
624 Peach St. 
Lincoln, NE 68501 
(402)476-2811 
Suggested List Price: $170 
Multiplan templates calculate costs of farm machinery per year, per 
acre, and per ho ur. 

Mac Link 
DataViz, Inc. 
P.O. Box 1319 
Norwalk, CT 6856 
(203)866-4944 
Suggested List Price: $95 
Links Mac to PC files. 
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Microsoft Basic 
Microsoft Corp. 
10700 Northup Way 
Bellevue, WA 98004 
(206 )828-8080 
Suggested List Price: 5150 

Appendix 

An adaptation of BASIC-68000. Compatible with all standard 
versions of Microsoft BASIC, allowing for easy migratio n of 
applications. 
Omni-Reader 
Moulth rop Sales, Inc. 
7080 Commerce Drive 
Pleasanton, CA 94566 
( 415)463-0450 
Suggested List Price: $ 
Optical scanner which "reads" typewritten pages into the Mac. 

Page Maker 
Aldus Corporation 
616 First Avenue, Suite 400 
Seattle, CA 98104 
(206 )467-8165 
Page composition for the LaserWri te r. 

Swine Management 
Harris Technical Systems 
624 Peach St. 
Lincoln, NE 68501 
(402)476-2811 
Suggested List Price: $170 
Multiplan templates for pork producers. 

Think Tank 
Living Videotext, Inc. 
2432 Charleston Road 
Mountain View, CA 94043 
( 415)964-6300 
Suggested List Price: $145 
Outline format he lps you build proposals, marketing plans, legal 
briefs, case reports, research notes, to-do lis ts, e tc. based on 
your input. 
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A 

accou nt statement form, 133 
ad dress list, 105-108, 145-150 
annual reports, 189-200 
area graphs, 25 
assets, see balance sheet 

B 

back-orde rs, 130 
balance sheet, 91-93, 194 
bar charts 

horizontal, 22 
vertical, 23 

baud rate, 163 
business proposals, 201-2·10 

c 
calculation 

automatic, 83 
see formula 

cash flow 
projection, 88-91 
statement, 86-88 
table, MncProject , 49 

changes in working capital, 87 
chart labels, 29 
chart size, 30 
Chari, Microsoft, 7, 17-34, 182, 193 
charting from M11//ipln11 files, 94 
charts & diagrams, 53-69 
charts, financial, 17-34 
Clipboard, 11 
column widths, M11ltipln11 , 78 
combination graphs, 27 
CompuServe, 172 
costs, project, 47 
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CPM chart, 37 
credit memo form, 131 
critical path, 45 
Critical Path Method, 37 
critical tasks, project, 44 
customer list, 145-150 
cut and paste, 11 
cut and paste, see also merge 

D 

data layout, fi le, 149 
data series, chart, 28 
d ata type, chart, 29 
data type, file, 147 
databases, 137-155 
d ates, project, 43 
d evelopment plan, 207 
diagrams, 53-69 
Dow Jones News Retrieval, 172 
duration, project, 42 

E 

edit, 11 
e lectronic mail , 174 
envelopes, 102, 134 
equity, 93 
exhibits, presentations, 173-187 

F 

FatBits, 56 
field width, 148 
file layout, 149 
file transfer 

Mac to IBM PC, 168 
Mac-to-Mac, 166 

file, invoice, 136 
File, Microsoft, 8, 137-155 
files, 136, 137-155 
files vs. forms, 136 
financial reports, 189-200 
financia l statements, 71-97, 208 
financing, 207 
floor plans, 65-68 
flow charts, 59-63 
footers, text, 111 
form letters, 105 

see mailing lists 
format, text, 97-115 
forms, 117-136 
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forms vs. files, 136 
forms, filling out, 127-129 
formulas, in fi les, 155 
for mulas, Multiplnn, 78-82 

G 

Gantt chart, 37, 43, 46, 208 
graphics, 53-69 
graph ics in text, see merge 
graphics, in files, 154 
graphs, 17-34 

H 

head ers, text, 111 

I 

IBM mainframe, 172 
IBM PC, 170 
lmageWriter, 7 

see printing 
information services, 172 
inventory list, 154 
invoice file, 136 
invoice form, 129 

L 

labels, charts, 29 
L.aserWriter, 7, 115, 196 
letter from the chairman, 194 
letterhead, 103 
letters, 100 

with envelopes, 102 
form letters, 105-108 
see mailing lists 

liabilities, see balance sheet 
line graphs, 24 
linking spread sheets to ch arts, 33 
lists, fi les, 137-155 
lists, see mailing lists 
logos, 103-104, 120, 126 

M 

MncDmw, 8, 117-136, 183 
MncDrnw vs. MncPni11t, 56 
MncPni11I, 8 
MncProjecl, 7, 37-52, 182 
MncTermi11nl, 8, 157-175 
MncWrite, 8, 97-115 
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mail merge, 105-108 
mai l, electronic, 174 
mailing labels, 105-108, 150 
mailing lis t, 105-108, 145-150 
management team, 207 
maps, 68 
marketing, 207 
memos, 100 
menu option, grey, 9, 40-50 
menus, 9 
Merging fi les Chart to MacDraw, 31, 182 

Chart to MacPai11t, 31 
Chari to text, 187, 195 
IBM to Mac, 168-171 
Mac to IBM, 168-171 
MacDraw to file, 154 
MacDraw to text, 69, 104, 187, 195 
MacPai11t to file, 154 
MacPai11t to text, 104, 187 
MacProject to MacDraw, 182 
MacProject to text, 187 
M11/tipla11 to Chart, 32 
M11/tipla11 to File, 95 
M11/tipln11 to text, 94, 195 
text to MacDraw, 196 

merging text, 105-108 
messages, e lectronic, 174 
milestone, project, 45 
modem, 161 
mouse, 8 
M11/tipla11 , 8, 71-97, 181, 192 

N 

naming cells, M11 /t ipln11, 83 
net worth, 93 
networks, 166 

0 

organ ization charts, 63-65, 208 
overhead transparencies, 184 
overlay charts, 27 
overlays, trans parencies, 185 

p 

PngeMaker, 198 
paste, 11 

see also merging files 
PERT chart, 37, 40 
phone hook-up, 164 
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pie charts, 21 
plans, 206 
pop-down menus, 9 
presentation handouts, 186 
presentation materials, 173-187 
printing 

form letters, 105-108 
mailing labels, 150 
reports, text, 151 
reports, see files 
text, 101, 103, 114-115 

Profit & Loss Projection, 85 
project 

control, 50 
costs, 47 
planning, 35-52 
schedule, 40 
summary, 50 
project table, 50 

projecting overheads, 184 
projections 

business, 206 
financial, 208 

proportions 
overhe;ids, 184 
slides, 186 

proposal cover, 210 
proposals, 201-210 
purchase order form, 135 

Q 
quarterly reports, 189-200 

R 

RAM (memory), 6 
ratio analysis, 86 
report cover, 200, 210 
report formats, text, 108-113 
reports 

financial, 189-200 
from files, 142, 151 

Resource Costs, project, 48 
Resource Ttmeline, project, 46 
resources, project, 46 
resumes, 113, 209 
ruler line, text, 100-102, 110 
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MAC AT WORK 

s 
sales order form, 129 
sales projections, 75-82 
scatter diagrams, 26 
Schedule Chart, MacProjecl, 40 
siz ing 

drawings, 196 
charts & diagrams, 181 
forms, 120 

slides, 186 
sorting files, 152 
Source, The, 172 
spreadsheets, 71-97 
street maps, 68 
SYLK files, 96, 169 

T 

tables, financial, 71-97 
tabs, 110-111 
Task Cost Entry, project, 49 
Task Timeline, MacProject, 46 
tasks, critical, 44 
tasks, MacProject, 40-45 
Tekalike, 33 
telecommunications, 157-175 
terminal, 3278, 171 
text, 97-115, 193 

charts, 29 
format, 204 
proposal, 204 
telecommunication, 169 

The Source, 172 
timeline, project, 46, 206 
transparencies, 184 
typesetting, 199 

diagrams, 69 
see also LaserWriter 
see also telecommunications 

w 
"what-if" calculations, 74,82 
w idth 

column, 78 
data field, 148 

Word, 8, 97-115 
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Make your printouts more effective with 
MncART FOR BUSINESS software. 

The attractive art files on disk include stationery (borders and 
monograms), business-related greeting cards, and ideas for the preparation 
of promotional material, memorandums, and fimmciBl reports. This card 
contains several samples of the many pieces of art available on the disk. 
Transfer the MacPAINT images on this disk to MacWRITE (or other word 
processing software) following the instructions contained in the 
~panying instruction booklet. 

Tate advantage of your Macintosh graphics capabilities by 
enhancing your printed materials. Add "punch" to your 
presentations, end make sure that your printed materials get 
the attention they deserve. 

Order Mar.ART FOR BUSINESS software for only $23.00 TODAY! 

\t ti 
Mar.ART FOR BUSINESS SOFTWARE 

Yes , I want to make sure that my printouts get the attention that they 
deserve. Please send me cop1es of the Mar.ART FOR BUSINESS 
disk at $23.00 each. ISBN 0-471-82736-3. 

D Check or money order enclosed (including state sales tax). 
0 Purchase Order• attached 
D Charge to my credit card: D Visa D Mester Cerd 

Card Number ________________ __ 

Expiration mte Signature---------

Name rm ________ _ 
Companv------------------~ Ack!ress __________________ __ 

City State Zip CcxE ____ _ 
Stgnature __________________ _ 
(Order invalid unless signed.) 
Prices and terms subject lo change without notice. 
We normally ship within ten days. If shipment cannot be made within 90 days. 
payment will be refunded. 



NOW AVAILABLE 
MacArt for Business software is now available for the 
Macintosh computer. 

Buy the 3 112 inch disk at your favorite computer store, or 
order from Wiley: 

In the United States: John Wiley & Sons 
1 Wiley Drive 
Somerset, f\l.J 08873 

In the United Kingdom John Wiley & Sons, Ltd. 
and Europe: Baffins Lane, Chichester 

Sussex PO 19 IUD UNITED KINGDOM 
In Canada: John Wiley & Sons Canada, Ltd. 

22 Worcester Road 
Rexdale, Ontario M9W 1L1 CANADA 

In Australia: Jacaranda Wiley, Ltd. 
GPO Box 859 
Brisbane, Queensland AUSTRALIA 

Frank - MacART FOR BUSINESS Disk 1-82736-3 

·-- ---- ---- ------------------- ·--~~.__~----

111111 

BUSINESS REPLY CARD 
FIRST CL.ASS PERMIT NO. 2277, NEW YORK, N.Y. 

POSTAaE WILL BE PAID BY ADDRESSEE 

JOHN WILEY & SONS, Inc. 
1 Wiley Drive 
Somerset, N.J . 08873 

NO POSTAGE 
NECESSARY 
IF MAILED 

IN THE 
UNITED STATES 



Computers $17.95 

Get down to business with your mouse. 

Macintosh™ Windows on Business .,, . 
................................ 1111!1, .. ~i--. .......................... __ 

S. Venit and Diane Burns 
A mouse can make you more productive. 

If this sounds like a fairytale, read Mac at 
Work. This practical, down-to-earth guide 
shows how to use the ma9ic of windows and 
mouse technology to create over 50 busi
ness .documents-eyetyrhing from balance 
sheets, invoices, and organization charts to 
business plans, proposals, and corporate re
ports. 

Mac at Work gets right down to the practical 
work at hand. You'll learn how to use win
dows to combine text, spreadsheets, and 
graphics into a single document- without 
having to wade through unnecessary techni
cal detail. Using plenty of helpful screen illus
trations and examples, Mac at Work lets you 
calculate, chart, schedule, communicate, 
record, and sort on the Macintosh. Then it 
explains how to integrate these functions to 

Wiley Press guides have taught more than 
three million people to use, program, and 
enjoy microcomputers. Look for them all at 
your favorite bookshop or computer store. 
M,acintosh- is a trademark licensed to Apple Computer. Inc. 
TRS·80" is a registered trademark of Tandy Corp. 

create complete and sophisticated docu
ments that can be tailored to any business. 

In addition, Mac at Work helps you choose 
the right productivity software for your 
needs, with a comparative survey of popular 
packages currently available, including Multi
Plan", Microsoft" Chart, MacDraw and Mac
Paint, and Microsoft Word. Also included are 
examples of presentation-quality output 
from Apple's LaserWriter Printer. 

S. Venit and Diane Burns are computer 
consultants who also design and write tech
nical and training materials for corporations 
and small businesses in the San Francisco 
Bay area. Among their many other books are 
The SuperCalc" Primer and Practical Finance 
for the TRS-80" Model 100. 

WILEY PRESS 
a division of JOHN WILEY & SONS, Inc. 
605 Third Avenue, New York, NY. 10158 
New York • Chichester • Brisbane • Toronto • Singapore 

Multiplan• and Microsoft" are registered trademarks of Microsoft Corp. 
SuperCalc" is a registered trademark of Sorci m. Inc. 

ISBN 0 471-82050-4 


